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ЛАБОРАТОРНАЯ РАБОТА №1 

ПИКСЕЛЬНЫЕ И ВЕКТОРНЫЕ ИЗОБРАЖЕНИЯ. 
ИНТЕРФЕЙС ПРОГРАММЫ «COREL DRAW» 

Цель лабораторной работы: ознакомиться с особенностями пиксельных и векторных 
изображений, с рабочей средой и интерфейсом пользователя программы «Corel Draw»; 
научиться выполнять простейшие операции по созданию нового документа, открытию и 
закрытию документа, сохранению документа, изменению параметров страницы и единиц 
измерения. 

1.1. Пиксельные и векторные изображения 
Все изображения, с которыми работают программы машинной графики, разделяются на 

два класса: пиксельные и векторные.  
В терминологии машинной графики (отрасли практической информатики, 

занимающейся автоматизацией построения изображений и их обработки с помощью 
компьютеров) пиксельным  изображением принято называть массив пикселей – одинаковых по 
размеру и форме плоских геометрических фигур (чаще всего – квадратов или кругов), 
расположенных в узлах регулярной (то есть состоящей из ячеек одинаковой формы и размера) 
сетки. Для каждого пикселя тем или иным способом задается цвет (обычно цвета кодируются 
числами фиксированной раз рядности). Представление пиксельного изображения в памяти 
компьютера – это массив сведений о цвете всех пикселей, упорядоченный тем или иным 
образом (например, по строкам, как в телевизионном изображении). Наиболее близким 
аналогом такого явления виртуального мира, как пиксельное изображение, в реальном мире 
является мозаика. При соблюдении определенных условий (главные и них – небольшие 
размеры фрагментов смальты и достаточно большое удалении зрителя от поверхности 
изображения) отдельные кусочки смальты, составляющие мозаичное изображение, не видны – 
глаз зрителя воспринимает изображение как единое целое. Это явление называется визуальным 
смыканием. 

Другой пример пиксельных изображений – получившие в последнее время широкое 
распространение, так называемые «японские кроссворды». Изображение на экране любого 
монитора – пиксельное, и это хорошо видно через увеличительное стекло. Большинство 
принтеров воспроизводят на бумаге именно пиксельные изображения. 

Векторным изображением в компьютерной графике принято называть совокупность 
более сложных и разнообразных геометрических объектов. Номенклатура таких объектов 
может быть более или менее широкой, но, как правило, в нее включаются простейшие 
геометрические фигуры (круги, эллипсы, прямоугольники, многоугольники, отрезки прямых и 
дуги кривых линий). Важнейшая особенность векторной графики состоит в том, что для 
каждого объекта (или, как мы будем более точно говорить далее, класса геометрических 
объектов) определяются управляющие параметры, конкретизирующие его внешний вид. 
Например, для окружности такими управляющими параметрами являются диаметр, цвет, тип и 
толщина линии, а также цвет внутренней области. 

Представление векторного изображения в памяти компьютера сложнее, чем пиксельного 
(хотя, как правило, при этом оно намного компактнее). Несколько упрощая, можно считать, что 
оно представляет собой перечень всех объектов, из которых составлено изображение, причем 
для каждого объекта указано, к какому классу объектов он принадлежит, и приведены значения 
всех управляющих параметров.  

Процесс вывода пиксельного изображения на экран или бумагу достаточно прост – на 
экране пикселе соответствует группа из трех частиц люминофора, светящихся различными 
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цветами, принтер изображает пиксели капельками чернил или пятнами тонера (красящего 
порошка). К устройствам, непосредственно фиксирующим векторные изображения, относятся 
графопостроители. Почти всегда векторное изображение перед выводом (или непосредственно 
в процессе вывода) преобразуется в точечное – в компьютерной графике этот процесс 
называется рендерингом.  

Основной недостаток пиксельного изображения состоит в фиксированном размере 
пикселей. Из-за этого при увеличении или уменьшении возникают крайне нежелательные 
эффекты. При увеличении изображения между плотно «прижатыми» друг к другу пикселями 
появляется свободное место. Заполнить его, строго говоря, нечем, разве что, размещая на 
свободных местах копии находящихся рядом пикселей. Это эквивалентно увеличению размера 
пикселя при увеличении изображения. Однако сильно увеличивать размер пикселя нельзя – 
слишком крупные пиксели перестанут сливаться в глазу зрителя в однородное изображение, 
видимость смыкания разрушится. Таким образом, сильно увеличенное точечное изображение 
приобретает отчетливо видимую зернистую структуру. В машинной графике это явление 
называется искажениями растрирования. При этом под растрированием понимается процесс 
преобразования векторного изображения в пиксельное (или одного пиксельного изображения в 
другое со сменой характеристик пикселей). 

При уменьшении пиксельного изображения с сохранением прежнего размера пикселей 
неизбежно приходится выбрасывать некоторые пиксели, что приводит к потере части 
содержащейся в изображении информации. Не спасает положения и уменьшение размеров 
пикселя, поскольку устройства отображения информации (дисплеи, полиграфические машины 
и принтеры) все равно не могут воспроизводить слишком маленькие пиксели – в результате 
детали изображения становятся плохо различимыми. 

Более того, оказывается, что размеры пиксельного изображения при сохранении 
исходного размера можно увеличивать лишь кратно – в два, три и т. д. раз. Если это условие не 
соблюдается, на изображении может возникать муар – волнообразные полосы, точки или 
клетки. Избавиться от муара, не искажая само изображение, не так-то просто. 

Второй, не менее существенный, недостаток пиксельных изображений состоит в 
отсутствии внутренней структуры, соответствующей структуре изображенных объектов. 
Попробуем разобраться в этом на примере. Если на точечном изображении мы видим мужчину 
в галстуке-бабочке и со значком на лацкане, это – результат работы нашего мозга, выделившего 
в изображении такие объекты, как значок и галстук. Чтобы идентифицировать 
соответствующие этим объектам пиксели при работе с программой редактирования пиксельной 
графики, придется немало потрудиться. Если при работе над изображением необходимо 
удалить значок, то после этого придется еще как-то заполнять образовавшуюся после удаления 
пикселей значка «дыру» в изображении – фактически, дорисовывать его. Еще больше мороки 
возникает при необходимости слегка поправить покосившийся галстук. 

Третий недостаток пиксельных изображений – большой объем памяти, требующейся для 
их хранения. При работе с точечными изображениями высокой четкости и сравнительно 
большого размера нередки случаи, когда размеры соответствующих им файлов составляют 
сотни мегабайтов. Работа с такими громоздкими объектами зачастую оказывается не под силу 
даже самым современным и мощным компьютерам. 

Векторное изображение существенно более гибко в работе. Чтобы увеличить или 
уменьшить его, требуется всего лишь изменить один управляющий параметр изображения в 
целом – масштаб. При этом размер файла с векторным изображением не увеличится ни на один 
байт. Внесенные изменения будут учтены при рендеринге, и четкость изображения не 
пострадает. На рис.1 представлены результаты увеличения точечного и векторного 
изображений. 
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В отличие от пиксельного изображения степень структуризации векторного изображения 
может быть произвольной. Она определяется создающим его художником. Как мы увидим в 
последующих уроках, составляя изображение перстня на пальце девушки из двух элементов 
круга, можно объединить эти объекты в группу и даже дать ей имя «Перстень», чтобы потом 
было легче найти эти объекты. Удаление этой группы приведет к исчезновению перстня, но не 
к возникновению «дыры» на пальце – ведь изображение пальцев составлено из других 
объектов, которые просто становятся видны в том месте, где раньше был перстень. Не 
составляет проблемы и «поправить платье» – достаточно изменить значение угла поворота 
группы объектов, из которых составлено его изображение. 

Размеры файлов с векторными изображениями в большинстве случаев намного меньше 
размеров файлов с изображениями пиксельными. 

В заключение сравнительного анализа классов изображений отметим, что 
преобразование векторного изображения в пиксельное (растрирование или рендеринг) 
представляет собой достаточно простой и абсолютно формальный процесс, выполняющийся 
большинством программ машинной графики без вмешательства пользователя. Преобразование 
же пиксельного изображения в векторное (векторизация или трассировка) в подавляющем 
большинстве случаев требует не просто вмешательства, а творческого участия пользователя. 

  

Рисунок 1 – Векторное изображение (слева) в отличие от пиксельного (справа) 
 можно масштабировать без потери четкости и деталей 

Напрашивается очевидный вывод: при разработке графического проекта, независимо от 
того, к какому классу должно принадлежать итоговое изображение, начинать целесообразнее с 
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векторного изображения, тем более что в CorelDRAW имеется мощный арсенал средств для 
работы с обоими классами изображений. 

1.2. Объектно-ориентированный подход 
CorelDRAW (полное название – CorelDRAW Graphics Suite) представляет собой 

интегрированный объектно-ориентированный пакет программ для работы с векторной 
графикой. Попробуем разобраться, что стоит за этими терминами. Слова «интегрированный 
пакет» означают, что CorelDRAW представляет co6oй не отдельную программу, 
ориентированную на решение какой-либо одной чётко поставленной задачи, а совокупность 
программ (пакет), ориентированных на решение множества различных задач, возникающих при 
работе пользователя в определенной прикладной области, а именно – в области 
иллюстративной графики. Интегрированностъ пакета следует понимать в том смысле, что 
входящие в него программы могут легко обмениваться данными или последовательно 
выполнять различные действия над одними и теми же данными. Так достигается 
многофункциональность пакета, возможности разных программ объединяются, интегрируются 
в единое целое, представляющее собой нечто большее, чем сумму свои составных частей. 
Термин «объектно-ориентированный» следует понимать в том смысле, что все операции, 
выполняющиеся в процессе создания и изменения изображений, пользователь проводит не с 
изображением в целом и не с его мельчайшими частицами (пикселями изображения), а с 
объектами – элементами изображения. Начав со стандартных объектов (кругов, 
прямоугольников, текстов и т. д.), пользователь может строить составные объекты и 
манипулировать ими как единым целым. Таким образом, изображение становится 
иерархической структурой, на самом верху которой находится векторное изображение в целом, 
а в самом низу – стандартные объекты. 

Вторая особенность объектной ориентации пакета состоит в том, что каждому 
стандартному классу объектов ставится в соответствие уникальная совокупность управляющих 
параметров, или атрибутов класса. Если мы говорим о прямоугольнике высотой 200 мм и 
шириной 300 мм, залитом синим цветом, обведенным желтой линией шириной 3 пункта, с 
центром, расположенным в 150 мм по вертикали и в 250 мм по горизонтали от левого нижнего 
угла страницы, с углом наклона длинной стороны к горизонтали составляющим 32°, мы имеем 
дело с экземпляром класса – объектом, для которого зафиксированы значения управляющих 
параметров. 

Третья особенность объектной ориентации пакета состоит в том, что для каждого 
стандартного класса объектов определен перечень стандартных операций. Например, 
описанный выше прямоугольник можно разворачивать, масштабировать, закруглять ему углы, 
преобразовывать его в объект другого класса – замкнутую кривую. 

До логического завершения концепцию объектной ориентированности пакета доводит 
введение в его состав объектно-ориентированного языка программирования VBA. 

Программные модули на этом языке позволяют автоматизировать выполнение часто 
повторяющихся действий и даже строить на основе CorelDRAW специализированные 
графические системы, определяя новые классы объектов и операции над ними. Более того, этот 
процесс автоматизирован. В программный модуль на языке VBA можно преобразовать 
последовательность действий, причем их запись ведется автоматически (для возможной отмены 
последних действий). 

Однажды построенные фрагменты изображений можно использовать в новых работах 
(начиная с версии 11, такие фрагменты можно сохранять в специальных библиотеках), а также 
менять характер работы, не меняя изображения. 
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1.3. Рабочая среда и интерфейс пользователя 
Запуск CorelDRAW выполняется стандартными для Windows способами: с помощью 

главного меню, с помощью ярлыка, расположенного на рабочем столе, или двойным щелчком 
мыши на значке файла, имеющего расширение, ассоциированное в процессе установки 
CorelDRAW с этой программой (как правило, это файлы с расширениями .CDR, .CMX, .WMF). 

После запуска программы на экране открывается представленное на рис.2 главное окно 
CorelDRAW с основными элементами пользовательского интерфейса. 

Под строкой заголовка окна располагается строка меню. В CorelDRAW меню очень 
сложное, с большим числом подменю и команд. Как и в любой другой программе, меню 
обеспечивает доступ к большинству функций CorelDRAW, но очень многие действия могут 
выполняться и без него.  

В левой части рабочего пространства расположен специфический для продуктов фирмы 
Corel элемент интерфейса – так называемый набор инструментов (toolbox), который 
предназначен для выбора рабочего режима. Выбор режима осуществляется щелчком мышью на 
одной из кнопок набора инструментов – это называется выбором инструмента. С выбора 
инструментов начинаются практически все действия пользователя над объектами изображения. 

 

 

Рисунок 2 – Рабочая среда пользователя CorelDRAW 

Элементы управления для перехода 
по страницам 

Строка состояния Экранная палитра цветов 

Печатная страница 

Набор инструментов 

Пристыковываемые окна 

Рабочий стол 

Строка меню Стандартная панель инструментов Панель атрибутов 
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Некоторые кнопки инструментов снабжены треугольником в нижнем правом углу. Это – 
указание, что на самом деле с кнопкой связан не один, а несколько инструментов. Чтобы 
увидеть их все, вместо быстрого щелчка кнопкой мыши ее следует нажать (отпустив только 
после паузы в одну-две секунды) – на экране раскроется панель конкретного инструмента. На 
рис.3 представлена панель, раскрывающаяся кнопкой инструмента Fill (Заливка). 

 

Рисунок 3 – Панель инструмента Fill в раскрытом состоянии 

Чтобы выбрать инструмент, достаточно щелкнуть на его кнопке. Как правило, каждому 
из инструментов соответствует своя форма указателя мыши. 

В расположенной под строкой меню стандартной панели инструментов (toolbar) 
расположены элементы управления, соответствующие наиболее часто выполняемым командам: 
открытию, сохранению и закрытию файлов иллюстраций, операциям с системным буфером 
обмена, режимам и масштабу просмотра иллюстраций. 

Ниже стандартной панели инструментов по умолчанию располагается панель атрибутов 
(property bar). Она представляет собой совокупность элементов управления, соответствующих 
управляющим параметрам выделенного объекта и стандартным операциям, которые можно 
выполнить над ним с помощью выбранного инструмента.  

Вдоль правой границы окна расположена экранная палитра цветов (color palette). Она 
применяется для задания цвета заливки и обводки объектов иллюстрации. 

У нижнего края окна CorelDRAW находится строка состояния (status bar). В ней в 
процессе работы выводятся сведения о выделенном объекте и много вспомогательной 
информации о режиме работы программы. Строку состояния можно переместить в любое 
другое место рабочего пространства.  

Основная часть рабочего пространства CorelDRAW отведена для размещения окон 
документов (drawing windows) CorelDRAW. После создания документа CorelDRAW в таком 
окне видно только изображение печатной страницы, на которой будет размещаться 
иллюстрация. Границы страницы показаны в виде рамки с тенью, однако они не являются 
элементом изображения. Объекты, из которых будет далее строиться иллюстрация, должны 
располагаться в пределах этих границ. Остальное пространство окна иллюстрации имеет свое 
название – рабочий стол – и используется обычно как временное хранилище объектов. Размер 
рабочего стола CorelDRAW значительно больше, чем его видимая на экране часть. Для 
просмотра невидимой части окна служат полосы прокрутки, расположенные по правому и 
нижнему краям окна документа. Слева от горизонтальной полосы прокрутки располагаются 
элементы управления, позволяющие переходить между отдельными страницами 
многостраничных документов – кнопки и ярлычки с названиями страниц, вместе образующие 
так называемый навигатор. На левом и верхнем краях окна документа расположены 
координатные линейки (rulers), служащие для измерения координат объектов и размещения 
направляющих. 

Огромную роль в интерфейсе CorelDRAW играют пристыковываемые окна (dockers), в 
свернутом виде представляющие собой ярлычки с названиями, расположенные слева от 
экранной палитры цветов. По своим функциям они напоминают диалоговые окна, но в отличие 
от большинства диалоговых окон могут постоянно присутствовать в рабочем пространстве. Мы 
будем знакомиться с пристыковываемыми окнами по мере освоения приемов работы с 
объектами CorelDRAW. Пока отметим, что пристыковываемые окна могут располагаться как в 
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середине рабочего стола, так у одного из его краев («пристыковываться» к краю). В свернутом 
виде от пристыковываемого окна виден только заголовок или, если окно пристыковано, – 
только ярлычок с названием. Это позволяет компактно располагать в рабочем пространстве 
большое число элементов управления.  

1.4. Создание нового документа 
По умолчанию после запуска программы CorelDRAW всегда открывается окно 

документа. Если программа запускалась не щелчком на значке файла, ассоциированного с 
CorelDRAW, это будет новый документ. Если в процессе работы потребуется создать еще один 
новый документ, выберите команду New (Новый документ) в меню File (Файл) или просто 
щелкните на кнопке New (Новый документ), расположенной на стандартной панели 
инструментов. В результате раскроется новое окно документа CorelDRAW с чистой печатной 
страницей.  

1.5. Открытие и закрытие документа 
Ранее созданные документы CorelDRAW открываются вполне стандартными для 

прикладных программ Windows способами: при запуске программы после щелчка на значке 
ассоциированного с CorelDRAW файла; командой Open (Открыть), расположенной на 
стандартной панели инструментов. В двух последних случаях на экране раскроется 
представленное на рис.4 диалоговое окно Open Drawing (Открыть документ). 

 

 

Рисунок 4 – Диалоговое окно Open Drawing 

В этом диалоговом окне присутствуют все стандартные элементы окна открытия 
документа любой прикладной программы Windows. Кроме того, справа от списка файлов 
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имеется область предварительного просмотра, в которой при установленном флажке Preview 
(Предварительный просмотр) отображается уменьшенное изображение, хранящееся в файле. 
Если при сохранении документов CorelDRAW задаются ключевые слова или замечания, они 
появляются в полях Keywords (Ключевые слова) и Notes (Замечания). 

Для закрытия текущего документа выберите соответствующую кнопку в верхнем правом 
углу этого окна. Если документ после последней записи на диск менялся, программа запросит 
подтверждение на его сохранение перед закрытием. 

Уменьшенные копии изображения могут не включаться в файл при его сохранении, и в 
таких случаях даже при установленном флажке Preview (Предварительный просмотр) в области 
предварительного просмотра ничего не отображается. 

1.6. Сохранение документа  
Сохранение документа CorelDRAW выполняется выбором команды Save (Сохранить) на 

стандартной панели инструментов. Если ранее этот документ не сохранялся, на экране 
раскроется диалоговое окно Save Drawing (Сохранить документ), представленное на рис.5.  

Для сохранения документа следует выбрать папку, в которой он должен быть сохранен, 
ввести имя файла в поле File name (Имя файла) и щелкнуть на кнопке Save (Сохранить). Перед 
последним действием можно ввести в соответствующие поля Ключевые слова и замечания. 
Обратите внимание на раскрывающийся список Version (Версия). Если необходимо сохранить 
файл в формате одной из ранних версий CorelDRAW, перед сохранением файла следует 
выбрать в этом раскрывающемся списке соответствующую альтернативу. 

Кнопка Options (Режимы) позволяет раскрыть или, наоборот, скрыть элементы 
управления второстепенными функциями и настройками режима сохранения файла. 

Если файл ранее уже сохранялся, при выборе команды сохранения повторная запись на 
диск выполняется без открытия диалогового окна Save Drawing (Сохранить документ). 

Если требуется создать копию файла, сохраните его в другой папке командой Save As… 
(Сохранить как…) в меню File 

 

Рисунок 5 – Диалоговое окно Save Drawing 
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1.7. Изменение параметров страницы и единиц измерения 
После создания нового документа иногда требуется изменить принятые по умолчанию 

размеры печатной страницы. Эта операция выполняется при помощи элементов панели 
атрибутов, внешний вид которой для ситуации, когда на рисунке не выделено ни одного 
объекта, представлен на рис.6.  

 

Рисунок 6 – Панель атрибутов при отсутствии выделенных объектов 

Размер печатных страниц документа выбирается в раскрывающемся списке Paper 
Type/Size (Тип/формат бумаги), расположенном в самой левой позиции панели атрибутов. 
Размер печатной страницы не обязательно должен соответствовать формату бумаги, на которой 
потом будет распечатана иллюстрация. Достаточно, чтобы он не превышал размеров листа. 
Если размер печатной страницы оказывается меньше размеров листа бумаги, то вокруг 
иллюстрации появляются чистые поля. 

Размер печатной страницы целесообразно задавать, исходя из размеров будущей 
иллюстрации, а не стандартных листов бумаги. В случае печати, например, открыток или 
визитных карточек такой подход позволит вывести на один лист бумаги несколько копий или 
страниц документа CorelDRAW.  

Чтобы задать нестандартные габариты печатной страницы, введите их значения в 
счетчики Paper Width and Height (Ширина и высота листа), расположенные справа от списка 
форматов бумаги. Для изменения ориентации печатной страницы щелкните на одной из 
расположенных еще правее кнопок Portrait (Книжная) и Landscape (Альбомная). На этих 
кнопках изображен прямоугольник страницы, расположенный соответственно вертикально или 
горизонтально. В многостраничных документах страницы одинаковых или разных размеров 
можно ориентировать одинаково или по-разному. Две кнопки переключения этих режимов 
позволяют задавать параметры только для текущей страницы (нижняя) или сразу для всех 
страниц документа (верхняя).  

Возможно, потребуется изменить и единицы измерения, которые CorelDRAW 
использует для определения координат и размеров. Чтобы сменить единицу измерения, 
выберите нужный вариант в раскрывающемся списке Drawing Units (Единицы измерения).  

 

1.8. Контрольные вопросы 
1. Что такое пиксельные изображения? 
2. Что такое векторные изображения? 
3. В чем основное отличие пиксельных изображений от векторных? 
4. В чем состоит объектно-ориентированный подход? 
5. Назовите основные элементы пользовательского интерфейса программы CorelDRAW. 
6. Назовите основные способы сохранения документа. 
7. Как происходит изменение параметров страницы в CorelDRAW? 

Формат бумаги 
Размеры листа

Ориентация листа

Единицы измерения 

Режим многостраничного 
документа
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ЛАБОРАТОРНАЯ РАБОТА №2 

ГЕОМЕТРИЧЕСКИЕ ФИГУРЫ В «COREL DRAW» 
Цель лабораторной работы: получить практические навыки построения и модификации 
простейших объектов – геометрических фигур. 

2.1. Прямоугольники 
Основой работы с изображением в CorelDRAW являются объекты. Все графические 

объекты, с которыми приходится иметь дело пользователю этой программы, можно разбить на 
две категории – линии и примитивы.  

Фигура прямоугольника относится к категории примитивов. Однако в класс 
прямоугольников включены не только фигуры из четырех попарно равных отрезков, 
соединяющихся в конечных точках под прямыми углами, но и производные от них фигуры, у 
которых один или несколько углов закруглены, то есть представляют собой дугу окружности 
величиной 90°. Более того, в мире CorelDRAW даже после некоторых преобразований, 
искажающих форму первоначально прямоугольных объектов, в рамках объектной модели 
CorelDRAW они по-прежнему считаются прямоугольниками. На рис. 7 представлены несколько 
экземпляров объектов, относящихся к классу прямоугольников.  

 

 
 

Рисунок 7 – Экземпляры класса прямоугольников 
 

Самый левый из представленных объектов – «классический» прямоугольник. Именно 
так выглядят прямоугольники сразу после создания. Второй объект после создания был 
повернут на 45°, отчего, конечно, прямоугольником быть не перестал. У третьего объекта после 
создания были закруглены три из четырех углов, а самый правый из объектов после 
закругления угла был подвергнут операции скоса. Как видите, по внешнему виду далеко не 
всегда легко отличить прямоугольник от других объектов. Однако существует надежный 
способ – выделить подозрительный объект щелчком мыши и посмотреть на строку состояния. 
Если там появится сообщение Rectangle on Layer 1 (Прямоугольник на слое 1), – можете быть 
уверены, что имеете дело именно с прямоугольником. 

2.2. Построение прямоугольников 
1. Создайте новый документ. Для этого упражнения можно выбрать лист бумаги с 

произвольной ориентацией любого размера.  
2. Щелкните на кнопке инструмента Rectangle (Прямоугольник) в наборе инструментов. 

После этого указатель мыши на экране примет форму перекрестья с прямоугольником (рис. 8) – 
это визуальное подтверждение того, что в настоящий момент активен инструмент построения 
прямоугольников. 

Сделать активным инструмент Rectangle (Прямоугольник) можно и другими способами, 
например, щелкнув правой кнопкой мыши на свободном месте страницы и выбрав в 
контекстном меню команду F6 . 

3. Чтобы построить прямоугольник, перетащите указатель инструмента Rectangle 
(Прямоугольник) по диагонали создаваемого объекта. Обратите внимание, что в процессе 
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перетаскивания указателя мыши в строке состояния выводятся текущие значения высоты и 
ширины прямоугольника, а на экране отображается его постоянно меняющийся абрис. В 
момент отпускания кнопки мыши при окончании перетаскивания на экране появляется 
прямоугольник в окружении маркеров рамки выделения и с маркером середины, а в строке 
состояния – сообщение о том, что выделен объект, относящийся к классу прямоугольников (см. 
рис. 8). 

 

 
 

Рисунок 8 – Выделенный прямоугольник, элементы рамки выделения 
и сообщение в строке состояния 

 
Рамкой выделения называется группа из восьми маркеров (небольших квадратов с 

черной заливкой), обозначающих на экране габариты выделенного объекта или нескольких 
объектов. В центре рамки выделения находится маркер середины в виде косого крестика.  

2.3. Применение клавиш-модификаторов 
 

1. Повторите прием построения прямоугольника, освоенный в предыдущем упражнении, 
но в процессе перетаскивания указателя мыши по диагонали будущего объекта удерживайте 
нажатой клавишу Ctrl . Обратите внимание на то, что при этом абрис строящегося объекта 
независимо от направления перемещения мыши остается строго квадратным.  

Клавиша Ctrl выполняет функции ограничителя не только в этой ситуации – в 
большинстве случаев при построении новых или преобразовании ранее построенных объектов 
удержание ее в нажатом состоянии приводит либо к жесткому связыванию значений отдельных 
атрибутов объекта, либо к замене непрерывного интервала рядом фиксированных значений. 
Например, если поворот объекта осуществляется при нажатой клавише Ctrl , то вместо 
плавного движения объект будет перемещаться «скачками» по 15°.  

2. Постройте еще один прямоугольник, но теперь при перетаскивании указателя мыши 
удерживайте нажатой клавишу Shift. Обратите внимание, что если все ранее построенные 
прямоугольники располагались так, что в точке начала перетаскивания указателя мыши 
оказывался угловой маркер, то теперь там оказался маркер середины. Этот прием очень удобен, 
когда заранее известно, где должен располагаться центр прямоугольника.  

Оба модификатора можно использовать совместно, то есть если при перетаскивании 
указателя инструмента Rectangle (Прямоугольник) одновременно удерживать нажатыми 
клавиши Ctrl и Shift , то будет построен квадрат «от середины».  

 
 

Маркер середины 
 объекта 

Маркеры рамки выделения 

Узлы объекта 

Указатель мыши для объекта 
Rectangle 
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2.4. Панель атрибутов прямоугольника 
На панели атрибутов представлены элементы управления, определяющие параметры 

модели объекта (в данном случае – прямоугольника), и кнопки, позволяющие выполнять 
стандартные действия над объектами этого класса.  

- Два поля Object(s) Position (Положение середины) содержат точные значения 
координат середины прямоугольника в текущей системе координат (обычно связанной с левым 
нижним углом страницы). Введя в эти поля новые значения, можно переместить 
прямоугольник.  

- Значения в полях Object(s) Size (Высота и ширина) управляют геометрическими 
размерами прямоугольника. Меняя их, можно увеличить или уменьшить прямоугольник. 

 

 
Рисунок 9 – Панель атрибутов при работе с прямоугольниками  

(панель перемещена в центр рабочего пространства и представлена в виде окна) 
 
- В двух полях Scale Factor (Коэффициенты масштабирования) содержатся 

коэффициенты линейного растяжения и сжатия объекта. Меняя их, можно выполнять 
соответствующее преобразование объекта. 

- Если нажата кнопка Nonproportional Scaling/Sizing Ratio (Блокировка раздельного 
масштабирования), растяжение и сжатие объекта вдоль одной из сторон будет приводить к 
пропорциональному растяжению и сжатию вдоль второй стороны. 

- В поле Angle of Rotation (Угол поворота) содержится значение управляющего 
параметра операции поворота объекта. 

- Значения в полях Rectangle Corner Roundness (Коэффициенты закругления углов) 
характеризуют относительные величины радиуса закругления каждого из углов 
прямоугольника. Значения выражены в процентах, за 100% принята половина длины короткой 
стороны прямоугольника. 

- Если нажата кнопка Round Corners Together (Блокировка раздельного закругления 
углов), изменение любого из четырех коэффициентов закругления приведет к автоматическому 
изменению остальных коэффициентов на ту же величину.  

Остальные элементы панели атрибутов используются в операциях размещения объекта и 
его преобразования. 
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2.5. Закругление углов прямоугольника 
1. Постройте прямоугольник произвольных размеров. 
2. Выберите в наборе инструментов инструмент Shape (Форма), наведите его указатель 

на любой из расположенных в углах прямоугольника узлов и перетащите вдоль любой из 
сторон прямоугольника. Обратите внимание, что по мере удаления указателя мыши от угла 
прямоугольника все четыре угла начинают закругляться, причем, чем дальше перетаскивается 
указатель, тем больше становится радиус закругления (рис. 10.).  

 

 
 

Рисунок 10. – Закругление углов прямоугольника инструментом Shape 
 

3. Постройте еще один прямоугольник рядом с первым. Теперь попробуем закруглить 
только один из его углов. Для этого наведите указатель инструмента Shape (Форма) на узел, 
расположенный в правом верхнем углу прямоугольника, и перед началом перетаскивания узла 
щелкните мышью. 

4. После щелчка сбрасывается выделение всех узлов, кроме того, на котором выполнен 
щелчок. Теперь перетаскивание узла приводит к закруглению только выделенного угла 
прямоугольника. 

5. Перетаскивайте узел вдоль короткой стороны прямоугольника «до упора». Обратите 
внимание, что один из пары узлов, образовавшейся из углового узла прямоугольника, 
перемещается мышью, а второй движется синхронно с ним вдоль смежной стороны. 
Перемещение прекращается, когда один из узлов (неважно который) достигнет середины 
стороны прямоугольника.  

Максимальный радиус закругления угла прямоугольника (100%) равен половине длинны 
его короткой стороны.  

6. Щелчком мыши отожмите на панели атрибутов кнопку блокировки раздельного 
закругления углов. Введите в левое нижнее поле из группы полей для задания коэффициентов 
закругления углов значение 50 и щелкните в любом другом поле той же панели. Обратите 
внимание, как закруглился левый нижний угол прямоугольника.  

2.6. Эллипсы 
Класс объектов «эллипс» включает в себя объекты, с геометрической точки зрения 

эллипсами не являющиеся, а именно секторы и дуги эллипсов, которые получаются из эллипса 
приемами, аналогичными закруглению углов прямоугольника. 

В геометрии размеры эллипса определяются размерами его полуосей, в CorelDRAW – 
размерами габаритного прямоугольника (совпадающего с рамкой выделения). Эллипс касается 
рамки выделения в тех местах, где у нее располагаются четыре средних маркера сторон (рис. 
11.). У только что построенного эллипса имеется всего один узел.  
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Рисунок 11 – Эллипс, рамка выделения, указатель инструмента Ellipse 
и сообщение в строке состояния  

 

2.7. Построение и модификация эллипсов, дуг и секторов 
Познакомимся с приемами построения и модификации эллипсов.  
1. Вставьте в документ CorelDRAW еще одну страницу.  
2. Выберите в наборе инструментов инструмент Ellipse (Эллипс) и перетащите указатель 

этого инструмента по диагонали габаритной рамки будущего эллипса. Обратите внимание на 
изменение сообщений в строке состояния и значений в панели атрибутов в процессе 
перетаскивания. После отпускания кнопки мыши на рисунке появляется эллипс в рамке 
выделения.  

Клавиши-модификаторы работают с инструментом Ellipse (Эллипс) точно так же, как с 
инструментом Rectangle (Прямоугольник). Удерживая нажатой клавишу Ctrl, можно построить 
не эллипс, а правильный круг, а клавиша Shift позволяет строить эллипс, растягивая его не от 
угла, а от середины габаритного прямоугольника. При удержании одновременно обеих клавиш-
модификаторов будет строиться круг от центра. Освобождать клавиши-модификаторы следует 
только после отпускания кнопки мыши.  

 

 
 
Рисунок 12 – Преобразование эллипса в сектор перетаскиванием узла внутри эллипса  
 
3. Выберите инструмент Shape (Форма). Найдите узел вновь построенного эллипса и 

наведите на него указатель мыши. Нажмите кнопку мыши и сместите узел по направлению к 
центру габаритного прямоугольника, а затем, не выходя за границу эллипса, – по часовой 

Указатель инструмента
Ellipse 

Узел эллипса 
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стрелке (рис. 12.). После отпускания кнопки мыши эллипс будет преобразован в сектор. При 
этом в строке состояния и в панели атрибутов отобразятся центральный угол сектора и 
направления ограничивающих его радиусов.  

4. Постройте еще один эллипс и повторите описанную на предыдущем шаге 
последовательность действий, только на этот раз перемещайте узел эллипса не внутри него, а 
снаружи. В результате будет построена дуга эллипса, а не сектор.  

Если в процессе перетаскивания узла эллипса удерживать нажатой клавишу Ctrl , то 
центральный угол дуги или сектора будет меняться не плавно, а скачками по 15°. Это бывает 
удобно при построении секторов и дуг заранее заданной величины. 

 

 
 

Рисунок 13 – Панель атрибутов для объектов класса «эллипс» 
 
- Кнопка Ellipse (Эллипс) оказывается нажатой, если выделен объект, являющийся 

эллипсом. Нажатие этой кнопки щелчком мыши при предварительном выделении сектора или 
дуги преобразует их в замкнутый эллипс.  

- Кнопка Pie (Сектор) оказывается нажатой, если выделен сектор. Ее нажатие щелчком 
мыши преобразует в секторы предварительно выделенные эллипсы и дуги.  

- Кнопка Arc (Дуга) оказывается нажатой, если выделена дуга. Ее нажатие щелчком 
мыши преобразует в дуги предварительно выделенные эллипсы и секторы.  

- В двух счетчиках Starting and Ending Angles (Начало и конец дуги) содержатся значения 
направляющих углов радиусов, соединяющих центр сектора или дуги соответственно с 
начальной и конечной точкой дуги. Направляющие углы задаются в системе координат, 
связанной с порождающим сектор или дугу эллипсом. Начало отсчета этой системы связано с 
центром эллипса, а начальный луч (0°) соединяет центр и ту точку эллипса, которая находилась 
правее всех остальных в момент его построения.  

- Кнопка Clockwise/Counterclockwise (Направление дуги) позволяет выбрать, которая из 
двух дуг, получившихся в результате разбиения эллипса на две части будет построена – идущая 
по часовой или против часовой стрелки от начального радиуса к конечному.  

2.8. Многоугольники и звезды 
Примеры многоугольников CorelDRAW приведены на рис. 14.  
 

 
 

Рисунок 14 – Объекты, принадлежащие к классу «многоугольники»  
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Для построения многоугольников, как и для примитивов ранее рассмотренных классов, в 

CorelDRAW предусмотрен инструмент Polygon (Многоугольник). Его кнопка располагается на 
панели инструментов месте с кнопками еще двух инструментов (рис. 15).  

 

 
 

Рисунок 15 – Кнопки панели инструмента Polygon  
 

Рисунок на кнопке набора инструментов, раскрывающей эту панель, определяется тем из 
трех инструментов, который использовался последним. Поэтому кнопка со значком 
инструмента Polygon (Многоугольник) может отсутствовать в наборе инструментов. Чтобы 
выбрать инструмент, достаточно раскрыть панель инструмента, какой бы значок из трех, 
приведенных на рис. 15, ни был изображен на кнопке, а уже затем щелкнуть на нужной кнопке.  

 

 
 

Рисунок 16 – Звездчатый многоугольник и соответствующий ему вид панели атрибутов  
 

- Значение счетчика Number of Points of Polygon (Количество узлов базового 
многоугольника) определяет, сколько узлов будет равномерно размещено вдоль границы 
эллипса, на базе которого строится многоугольник. Таким образом, определяется число сторон 
многоугольника, которые попарно соединят эти точки.  

Максимальное значение этого счетчика равно 500, минимальное – 3.  
- Кнопки Star/Polygon (Звезда/Многоугольник) включают и выключают режим 

построения звездчатого многоугольника. Вид строящегося многоугольника определяется видом 
значка на кнопке.  

Режим построения звезды можно включить только для многоугольника с количеством 
сторон не менее 5.  

- Комбинированный элемент управления (поле, совмещенное с ползунком) Sharpness of 
Polygon (Заострение углов многоугольника) доступен только при работе со звездчатыми 
многоугольниками с числом сторон не менее 7. Чем больше значение этого параметра, тем 
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острее лучи звезды. Геометрически оно означает количество узлов базового многоугольника, 
расположенных между парой узлов, соединенных его стороной.  

Изменение значений элементов на панели атрибутов приводит к установке новых 
параметров примитива «многоугольник», заданных по умолчанию, но диалоговое окно с 
предупреждением об этом не выводится.  

После построения многоугольника кроме узлов базового многоугольника, 
расположенных в его вершинах, на нем отображаются дополнительные узлы, находящиеся в 
середине каждой из сторон многоугольника. Модификация формы многоугольника с помощью 
инструмента Polygon (Многоугольник) сводится к перетаскиванию этих узлов.  

2.9. Построение и модификация многоугольников 
Выполняя это упражнение, мы освоим приемы построения многоугольников и их 

модификации с помощью инструмента Polygon (Многоугольник).  
1. Вставьте в открытый документ CorelDRAW новую страницу с помощью команды 

контекстного меню Insert Page After (Вставить страницу после). Переименуйте страницу, 
используя команду контекстного меню Rename Page (Переименовать страницу), и дайте ей имя 
Многоугольники.  

2. Выберите инструмент Polygon (Многоугольник), щелкнув в наборе инструментов на 
соответствующей кнопке. На панели атрибутов установите число узлов базового 
многоугольника равным 10. Теперь по умолчанию будут строиться десятиугольники.  

3. Постройте многоугольник, перетащив по диагонали его габаритного прямоугольника 
указатель инструмента Polygon (Многоугольник). Рядом постройте еще один многоугольник, но 
в ходе перетаскивания указателя инструмента удерживайте нажатой клавишу Ctrl . Второй 
многоугольник должен получиться равносторонним. 

4. Обратите внимание на узлы построенного многоугольника. Выберите инструмент 
Shape (Форма) и наведите его указатель на любой из узлов, расположенных в серединах сторон 
многоугольника. Удерживая нажатой клавишу Ctrl , перетащите этот узел по радиусу примерно 
на половину расстояния до центра. Вместе с «захваченным» узлом будут перемещаться и все 
остальные дополнительные узлы, размещенные в серединах сторон многоугольника. В 
результате получится фигура, похожая на метательное оружие ниндзя – сюрикен (рис. 17, в 
середине). 

Нажатие клавиши Ctrl при перетаскивании узлов многоугольника ограничивает свободу 
их перемещения движением по радиусам базового эллипса.  

 

 
 

Рисунок 17 – Исходный многоугольник и его модификации, 
полученные перетаскиванием узлов инструментом Polygon 

 
5. Теперь наведите указатель инструмента на основной узел, расположенный в одной из 

вершин многоугольника, и перетащите его, но уже не по радиусу, а по часовой стрелке вокруг 
центра. На рис. 17, справа видны указатель инструмента Shape (Форма) и узлы многоугольника 
в процессе перетаскивания. В результате лучи сюрикена заострятся еще больше, и фигура 
утратит осевую симметрию, сохранив симметрию центральную. 
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6. Постройте еще один многоугольник, на этот раз, стараясь, чтобы он был вписан не в 

круг, а в горизонтально вытянутый эллипс (рис. 18, слева). Наведите указатель инструмента 
Polygon (Многоугольник) на маркер середины рамки выделения (после чего он должен 
превратиться в четырехглавую стрелку) и перетащите многоугольник вправо. Перед тем как 
отпустить левую кнопку мыши, щелкните ее правой кнопкой (рядом с четырехглавой стрелкой 
должен появиться значок «плюс»). В результате на странице появится смещенная копия ранее 
построенного многоугольника. Повторите эту операцию еще два раза, чтобы получился ряд из 
четырех одинаковых «сплюснутых» десятиугольников.  

 

 
 

Рисунок 18 – Исходный многоугольник и результаты его преобразования в звезду  
 

7. Выделите первую копию, щелкнув на ней указателем инструмента Polygon 
(Многоугольник), и щелкните на кнопке переключения режимов многоугольника и звезды. 
Выпуклый многоугольник превратится в звезду, а в поле заострения углов многоугольника 
появится значение 1.  

8. Повторите предыдущий шаг со второй копией, но после преобразования в звезду 
переместите ползунок поля заострения на одно деление вправо. В результате узлы базового 
многоугольника будут соединены через два, и лучи звезды станут острее.  

9. Для третьей копии переместите ползунок заострения в крайнее правое положение. 
Значение заострения будет равно трем, и увеличить его не удастся, поскольку соединение узлов 
базового многоугольника через четыре приведет к его распаду на пять отрезков. 

10. В завершение упражнения попробуйте использовать описанные выше приемы 
модификации путем перетаскивания узлов многоугольника инструментом Polygon 
(Многоугольник) при нажатой и при не нажатой клавише Ctrl . 

2.10. Спирали 
Сами по себе спирали достаточно редко используются как составные части 

изображений, но их применение в качестве направляющих и траекторий позволяет добиваться 
очень интересных графических эффектов.  

В CorelDRAW представлены два вида спиралей: симметричные (которые в математике 
называются архимедовыми) и логарифмические. Для первых характерно то, что расстояние 
между двумя смежными витками спирали, измеренное вдоль радиуса, проведенного из ее 
центра, одинаково для всей спирали. В логарифмической спирали это расстояние равномерно 
увеличивается пропорционально некоторой константе – коэффициенту расширения спирали.  

Коэффициент расширения спирали измеряется в процентах. Значение этого 
коэффициента, равное 33, означает, что расстояние между последующей парой смежных витков 
примерно на одну треть больше, чем в предшествующей паре витков.  

На рис. 19 представлены три спирали. 
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Слева – симметричная спираль, 
справа – логарифмические, с коэффициентом расширения соответственно 0,5 и 1,0  

Рисунок 19 – Шестивитковые спирали 
 

Строго говоря, спирали не являются примитивами CorelDRAW, и в CorelDRAW нет 
класса объектов «спираль». Они представляют собой подмножество класса кривых. При 
построении спирали все значения ее параметров должны быть заданы с помощью панели 
атрибутов до построения самой кривой.  

 

 
 

Рисунок 20 – Панель атрибутов после выбора инструмента Spiral и построенная им спираль  
 
Спирали строятся с помощью инструмента Spiral (Спираль), кнопка которого (см. 

рис. 15) расположена на панели инструмента Polygon (Многоугольник). Панель атрибутов 
после выбора этого инструме нта представлена на рис. 20.  

Обратите внимание на то, что надпись в строке состояния – Curve on Layer 1 (Кривая на 
слое 1) – говорит о том, что выделен объект класса «кривая». Именно поэтому никакие 
дальнейшие модификации построенной спирали с помощью инструмента Spiral (Спираль) 
невозможны, а редактирование формы спирали выполняется инструментом Shape (Форма) 
приемами редактирования кривых. 

Вставьте в документ CorelDRAW еще одну страницу и постройте на ней спирали, 
приведенные на рис. 19. 

2.11. Сетки 
Сетки, так же как и спирали, не образуют отдельного класса объектов CorelDRAW. 

Строящиеся с помощью инструмента Graph Paper (Диаграммная сетка) фрагменты изображений 
представляют собой группы упорядоченных одинаковых прямоугольников.  

Число витков 

Логарифмическая спираль 

Коэффициент 
расширения 

Симметричная 
спираль 

Указатель 
инструмента 
Spiral 
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Рисунок 21 – Панель атрибутов после выбора инструмента Graph Paper и построенная им сетка  
 

Кнопка этого инструмента (см. рис. 15) расположена на панели инструмента Polygon 
(Многоугольник). Панель атрибутов после выбора этого инструмента представлена на рис. 21, 
вид которой практически тот же, что для инструмента Spiral (Спираль), но теперь в панели 
доступны другие элементы управления.  

Сетка строится в следующей последовательности: в наборе инструментов выбирается 
инструмент Graph Paper (Диаграммная сетка), далее на панели атрибутов задаются количества 
строк и столбцов будущей сетки, а затем указатель инструмента перетаскивается по диагонали 
прямоугольной области, которую должна занять сетка. Сетка всегда строится со столбцами 
равной ширины и строками одинаковой высоты.  

Постройте сетку, не меняя принятых по умолчанию значений управляющих параметров, 
и обратите внимание на сообщение в строке состояния: Group of 12 Objects on Layer 1 (Группа 
из 12 объектов на слое 1). Построенная сетка утрачивает связь с инструментом Graph Paper 
(Диаграммная сетка), и воспользоваться им для ее модификации не удастся. 

 
Упражнение 2. Создание плаката с образцами 

 

 
 

Рисунок 22 – Плакат с образцами 
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В качестве упражнения вставьте в документ еще одну страницу альбомной ориентации, 
назовите ее «Плакат» и постройте плакат в виде таблицы, строки которой соответствуют 
освоенным нами инструментам, а в ячейках располагаются образцы объектов, которые можно с 
их помощью построить (рис. 22).  

Сетку для самой таблицы постройте с помощью инструмента Graph Paper (Диаграммная 
сетка) во всю ширину страницы, оставив некоторое место наверху под заголовок. По окончании 
работы сохраните документ CorelDRAW, создаваемый на протяжении этого урока, на диске, в 
файле с именем, например, LESS0N2.CDR.  

2.12. Стандартные фигуры 
Примитивы класса стандартных фигур (perfect shapes) предназначены для ускоренного 

построения часто встречающихся в практической работе графических фрагментов. Класс 
разделен на пять подклассов: базовые фигуры (basic shapes), стрелки (arrow shapes), элементы 
блок-схем (flowchart shapes), звезды (star shapes), выноски (callout shapes). На рис. 23 
представлена панель инструмента Perfect Shapes (Стандартные фигуры) и палитры, 
соответствующие каждому из пяти перечисленных выше подклассов стандартных фигур. 
Палитры открываются одноименной инструменту кнопкой панели атрибутов.  

 

 
 

Рисунок 23 – Панель инструмента Perfect Shapes и палитры подклассов стандартных фигур  
 

Построение стандартных фигур распадается на две операции: собственно построение и 
настройка формы. Чтобы построить стандартную фигуру, следует выполнить описанную ниже 
процедуру.  

1. Щелкните на кнопке инструмента Perfect Shapes (Стандартные фигуры).  
Как при работе с инструментами, входящими в панель инструмента Polygon 

(Многоугольник), на месте инструмента Perfect Shapes (Стандартные фигуры) появляется 
кнопка со значком одного из подклассов стандартных фигур – того, который был использован 
последним. При необходимости построить стандартную фигуру другого подкласса следует 
выбрать соответствующий ему инструмент.  

2. Перетащите указатель мыши по диагонали будущей стандартной фигуры.  
На странице появится выбранная стандартная фигура, окруженная маркерами 

выделения. У большинства стандартных фигур при выделении появляются также 
дополнительные цветные маркеры в форме маленького ромбика – маркеры-модификаторы (рис. 
24., справа). Маркеров-модификаторов может быть от одного до трех. Перетаскивая маркеры-
модификаторы мышью, можно менять внешний вид стандартной фигуры в достаточно широких 
пределах (рис. 24., слева и в середине).  
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Рисунок 24 – Стандартная фигура из подкласса элементов блок-схем 
и результаты изменения ее формы с помощью маркера-модификатора 

 
Построенную стандартную фигуру можно впоследствии перенастраивать с помощью 

маркера-модификатора и менять ее габариты и ориентацию с помощью элементов управления 
панели атрибутов. Возможность настройки формы стандартной фигуры с помощью маркеров-
модификаторов (которых может быть от одного до трех) сохраняется в продолжение всей 
работы над изображением и утрачивается только после преобразования стандартной фигуры в 
кривую линию. 

 
 

2.13. Контрольные вопросы 
 

1. На какие категории разделяются графические объекты в CorelDRAW? 
2. Опишите последовательность действий по созданию прямоугольника. 
3. Для чего нужны клавиши-модификаторы? 
4. Назовите основные элементы панели атрибутов прямоугольников. 
5. Опишите последовательность действий по созданию эллипсов, дуг и секторов 
6. Назовите основные элементы панели атрибутов Polygon (Многоугольник). 
7. Какие атрибуты управляют построением спиралей? 
8. Для чего предназначены примитивы класса стандартных фигур (perfect shapes). 
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ЛАБОРАТОРНАЯ РАБОТА №3 

ЛИНИИ В «COREL DRAW» 
Цель лабораторной работы: ознакомиться с особенностями построения кривых и линий. 
Получить практические навыки работы с суперлиниями в различных режимах. Изучить 
особенности построения размерных и других линий при работе с чертежами и подобными им 
иллюстрациями. 

3.1. Модель кривой 
В основе принятой в CorelDRAW модели линий лежат два понятия: узел и сегмент. 
Под термином «линия» следует понимать объект, относящийся к классу кривых (curve).  
Узлом называется точка на плоскости изображения, фиксирующая положение одного из 

концов сегмента кривой. Сегментом называется часть кривой, соединяющая два смежных узла. 
Узлы и сегменты неразрывно связаны друг с другом: в замкнутой линии узлов столько же, 
сколько сегментов, в незамкнутой – на один узел больше. 

По характеру предшествующих сегментов выделяют три типа узлов: начальный узел 
незамкнутой кривой, а также прямолинейный (line) и криволинейный (curve) узлы. На рис. 25 
промежуточный узел 1 и конечный узел – прямолинейные, а промежуточный узел 2 – 
криволинейный. 

 

 
 

Рисунок 25 – Сегменты и узлы линии 
 

Для узлов, смежных хотя бы с одним криволинейным сегментом, имеется еще од 
классификация типов: они подразделяются на точки излома (cusp) и сглаженные узлы (smooth). 
Частным случаем сглаженного узла является узел симметричный (symmetrical), но таким может 
быть только узел, расположенный между двумя криволинейными сегментами. Все компоненты 
узла, представленные на рис. 26, отображаются на экране, только если этот узел 
предварительно выделен с помощью инструмента Shape (Форма) и при этом на той же кривой 
не выделено более ни одного узла. 

 

 
 

Рисунок 26 – «Устройство» узла линии 
 

Криволинейные 
сегменты линии

Прямолинейный 
сегмент линии 

Начальный узел

Конечный 
узел

Промежуточный 
узел 1

Промежуточный 
узел 2

Выделенный узел 

Направляющие точки 
выделенного узла 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 29

При выделении узла, разделяющего два криволинейных сегмента, на экране 
отображаются четыре направляющих точки – с обоих концов каждого сегмента. 

Тип узла (он отображается в строке состояния) определяет возможное взаимное 
расположение его направляющих точек. 

Точки излома. Узел называется точкой излома в том случае, когда касательные, 
проведенные в узле к двум прилегающим к нему сегментам, не лежат на одной прямой, образуя 
угол, отличный от развернутого. Примеры точек излома приведены на рис. 27. 

 

 
Рисунок 27 – Точки излома: на стыке прямолинейных сегментов, прямолинейного и 

криволинейного сегментов, двух криволинейных сегментов 
 

Сглаженные узлы. Узел называется сглаженным, если касательные, проведенные к 
двум прилегающим к нему сегментам, лежат на одной прямой. Примеры сглаженных узлов 
приведены на рис. 28. 

 

Рисунок 28 – Сглаженные узлы: на стыке прямолинейного и криволинейного сегментов, 
 на стыке двух криволинейных сегментов 

 
Узел, лежащий на стыке двух прямолинейных сегментов, не может быть сглаженным, 

даже если оба сегмента лежат на одной прямой. Это объясняется тем, что узлы должны 
сохранять свой тип при перемещении, а перемещение такого узла в направлении, 
перпендикулярном примыкающим сегментам, нарушило бы условие сглаженности, поскольку 
прямолинейные сегменты не могут деформироваться. 

 
Симметричные узлы. Симметричным называется сглаженный узел, направляющие 

точки которого равноудалены от него. В отличие от точек излома и сглаженных узлов 
симметричные узлы используются достаточно редко. Пример симметричного узла приведен на 
рис. 29. 

 
 

Рисунок 29 – Симметричный узел 
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3.2. Линии и инструмент Freehand 
Инструмент Freehand (Произвольная кривая) преобразует траекторию перемещения 

мыши в кривую. При этом узлы и сегменты линии формируются автоматически в соответствии 
с заданными параметрами инструмента Freehand (Произвольная кривая), поэтому  построенные 
линии требуют последующей корректировки 

 

 
 

Рисунок 30 – Панель инструментов Curve Flyout 
 

Упражнение 1. Построение линий от руки 
 

Постройте двумя различными приемами замкнутую кривую, напоминающую 
прямоугольник, короткие стороны которого замещены полуокружностями. 

1. Создайте новый документ CorelDRAW и переименуйте его первую страницы во 
Freehand. 

2. Выберите на панели инструмента Curve (Кривая) инструмент Freehand (Произвольная 
кривая). Указатель мыши примет форму, соответствующую выбранному инструменту (рис. 31, 
слева). Нажмите кнопку мыши и, перетаскивая указатель, постарайтесь построить желаемую 
замкнутую кривую, начиная с закругления. В момент приближения указателя мыши к точке, в 
которой начиналось построение кривой, указатель инструмента изменит свою форму (рис. 31, 
справа). Если отпустить кнопку мыши в этот момент, то будет построена замкнутая кривая, 
если раньше – то незамкнутая. 

 

 
 

Рисунок 31 – Формы указателя инструмента Freehand в процессе построения 
 линии и в момент ее замыкания 

 
Если в процессе построения кривой линия «поехала не туда», не отпуская кнопку мыши, 

нажмите и удерживайте клавишу Shift. Теперь, перетаскивая указатель вдоль уже нарисованной 
линии в обратном направлении, можно «стереть» неудавшийся участок. После отпускания 
клавиши Shift рисование можно продолжить от последнего нестертого узла. 

3. Скорее всего, вы оцените полученный результат как неудовлетворительный. Тем не 
менее его следует исследовать. Вначале обратите внимание на строку состояния – там 
появилось сообщение о том, что выделен объект, относящийся к классу кривых, и указано, 

Суперлиния

Кривая Безье
Кривая

Перо
Полилиния

Кривая по трем точкам
Соединительная линия

Размерная линия
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сколько в нем получилось узлов. На построенной кривой эти узлы видны, причем роль 
начального узла играет тот, на котором кривая замкнулась. Выберите в наборе инструментов 
инструмент Shape (Форма) и щелкните им на любом из узлов, а затем прочтите сообщение в 
строке состояния. Далее, последовательно нажимая клавишу Tab, переводите выделение на 
следующие узлы кривой, выясняя их тип по сообщениям строки состояния. В результате 
исследования можно сделать следующие выводы: 

• узлы и сегменты кривой при работе с инструментом Freehand (Произвольная кривая) 
создаются автоматически; 

• большинство создаваемых узлов представляют собой точки излома; 
• большинство создаваемых сегментов – криволинейные. 
Частота расположения узлов на строящейся кривой зависит от скорости перемещения 

указателя мыши. Чем быстрее перемещается указатель, тем дальше отстоят вновь создаваемые 
узлы друг от друга, и, наоборот, при медленном перемещении мыши построенная кривая может 
оказаться сплошь усеянной узлами. Последнее нежелательно, поскольку избыточное 
количество узлов не только снижает плавность кривой, но и без необходимости усложняет 
изображение. 

4. Отступив вниз, повторите построение замкнутой кривой, начиная с закругления, но 
теперь перед построением прямолинейного сегмента и по его завершении нажимайте клавишу 
Tab. На этот раз прямолинейные сегменты получились замечательно, но закругления и их 
соединения с прямолинейными сегментами оставляют желать лучшего. 

5. В завершение этого упражнения проделаем то, с чем инструмент Freehand 
(Произвольная кривая) справляется хорошо – построим ломаную линию, то есть линию, 
состоящую только из прямолинейных сегментов. В этом случае инструментом работают 
несколько по-другому. Указатель инструмента перемещается в точку, в которой окажется 
первый узел, и выполняется щелчок мышью. Последующие щелчки выполняются в местах 
расположения узлов ломаной, и эти щелчки должны быть двойными. После последнего щелчка 
(одиночного) на начальном узле ломаная линия становится замкнутой. Пользуясь этим 
приемом, постройте произвольный треугольник и незамкнутую зубчатую линию. 

Если при работе инструментом Freehand (Произвольная кривая) требуется ограничивать 
наклон прямолинейных сегментов ломаной линии, пользуйтесь клавишей-модификатором Ctrl. 
Если удерживать эту клавишу нажатой, то следующий прямолинейный сегмент будет наклонен 
к горизонтали под углом, кратным 15°. 

В версии 11 программы в дополнение к инструменту Freehand (Произвольная кривая) 
был введен инструмент Polyline (Полилиния). Им удобнее рисовать от руки кривые, состоящие 
из нескольких сегментов. После создания начального сегмента кривой выполняется щелчок 
мышью, но этот щелчок не заканчивает построение кривой, как при работе с инструментом 
Freehand (Произвольная кривая). Перетаскивание указателя при нажатой кнопке мыши создает 
криволинейный сегмент кривой, перемещение указателя при отпущенной кнопке мыши создает 
сегмент прямолинейный. Для завершения построения незамкнутой кривой следует нажать 
клавишу пробела. 

3.3. Линии и инструмент Bezier 
Построение кривой инструментом Bezier (Кривая Безье) представляет собой 

последовательность циклов работы с каждым из узлов кривой. Цикл начинается с установки 
указателя инструмента в точку расположения будущего узла. Затем нажимается кнопка мыши, 
и, удерживая ее, пользователь уточняет положение направляющих точек, перетаскивая одну из 
них мышью (вначале – в направлении от узла, а потом – вокруг него). По умолчанию создаются 
симметричные узлы, но если пользователь в момент отпускания кнопки мыши воспользуется 
клавишей-модификатором узла (см. примечание), будет создан сглаженный узел или точка 
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излома. В момент отпускания кнопки мыши фиксируются тип узла и положение направляющих 
точек, после чего начинается цикл определения следующего узла. Для выхода из цикла следует 
нажать клавишу пробела. 

В процессе создания точки излома следует удерживать нажатой клавишу C (начальный 
символ английского термина «cusp», обозначающего этот тип узлов). Клавиатура при этом 
должна работать в режиме ввода латиницы. После нажатия клавиши-модификатора 
направляющие точки начинают вести себя в соответствии с выбранным типом узла, и 
дальнейшее перетаскивание мышью будет влиять только на одну из них. Для создания 
сглаженного узла используется клавиша-модификатор S (от английского «smooth»). 

 
Упражнение 2. Построение линий инструментом Bezier 

1. Добавьте новую страницу в открытый документ CorelDRAW и переименуйте ее в 
Bezier. Выберите в наборе инструментов инструмент Bezier (Кривая Безье). 

2. Начнем построение линии с узла, предшествующего линейному сегменту. Установите 
указатель в нужную точку и нажмите кнопку мыши. Не отпуская кнопку, переместите указатель 
на некоторое расстояние вправо так, чтобы стали видны «вытащенные» из узла направляющие 
точки. Чтобы касательная к следующему сегменту была строго горизонтальна, нажмите и 
удерживайте клавишу-модификатор Ctrl. Отпустите кнопку мыши, а затем и клавишу Ctrl – 
первый узел кривой построен (рис. 32). Поскольку пока он является единственным (и, 
следовательно, крайним) узлом линии, после завершения работы с ним он автоматически 
становится точкой излома. После того как линия будет замкнута в этом узле, его тип сменится. 

 
Рисунок 32 – Построение первого узла линии 

 
3. Переходим к построению второго узла. Поскольку он должен располагаться на одной 

горизонтали с первым, перед перемещением указателя инструмента снова нажмите и 
удерживайте клавишу Ctrl. Второй узел строится точно так же, как первый, но после 
отпускания кнопки мыши он станет симметричным (перед ним на линии уже имеется узел, и 
поскольку процесс построения не закончен, появится узел и за ним – следовательно, он не 
крайний). Поскольку симметричные узлы вполне соответствуют виду строящейся кривой, нет 
необходимости явно указывать тип этого узла клавишей-модификатором (рис. 33). 

 

 
 

Рисунок 33 – Изображение перед отпусканием кнопки мыши после построения второго узла 
 

4. Третий узел должен располагаться строго под вторым, поэтому по окончании работы 
со вторым узлом клавишу Ctrl можно даже не отпускать. На этот раз «вытаскивать» 
направляющую точку из узла следует не вправо, а влево, не отпуская клавишу Ctrl. Чтобы 
закругление получилось симметричным, расстояние от направляющей точки до узла должно 
быть примерно таким же, как у второго узла (рис. 34). 

5. Четвертый узел строится точно так же, как третий (рис. 35, слева). Теперь кривую 
следует замкнуть. Для этого указатель мыши перемещается на начальную точку (до появления 
в качестве указателя мыши «стрелочки» вместо символического изображения узла) и 
нажимается левая кнопка мыши. 
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Рисунок 34 – Изображение перед отпусканием кнопки мыши после построения третьего узла 
 

Остается только перетащить направляющую точку вправо при нажатой клавише Ctrl 
(чтобы левое закругление стало симметричным), и замкнутая кривая будет построена (рис. 35, 
справа). 

 

Рисунок 35 – Завершение построения замкнутой кривой 
 

6. Исследуйте построенную кривую способом, описанным в предыдущем упражнении, 
просматривая типы построенных узлов. Впрочем, достоинства только что построенной кривой 
по сравнению с результатом предыдущего упражнения очевидны: гораздо меньшее число 
узлов, прямолинейность тех сегментов, которые должны быть прямыми, симметричность 
закруглений, отсутствие случайных отклонений. Хотя, возможно, закругления и не 
представляют собой идеальных полуокружностей, полученный результат очень близок к 
поставленной цели. 

7. В завершение упражнения попробуйте самостоятельно построить с помощью 
инструмента Bezier (Кривая Безье) замкнутую кривую, представляющую собой равносторонний 
треугольник с закругленными вершинами и «пилу» из предыдущего упражнения, но с 
закругленными зубцами. При работе с последним заданием, поскольку кривая получится 
незамкнутая, не забудьте после определения последнего узла нажать клавишу пробела. 

Не забывайте, что клавиша-модификатор Ctrl позволяет ограничивать перемещение 
указателя не только вертикалями и горизонталями, но и линиями с наклоном, кратным 15°. 

Появившийся в предпоследней версии программы инструмент Реn (Перо) позволяет 
строить кривые теми же приемами, что и инструмент Bezier (Кривая Безье). Отличие состоит в 
том, что в процессе перемещения указателя мыши в точку расположения очередного узла 
кривой на экране отображается внешний вид следующего, еще не построенного сегмента 
кривой. Чтобы почувствовать отличие, попробуйте выполнить предыдущее упражнение с 
помощью инструмента Реn (Перо). 

3.4. Линии переменной ширины и инструмент Artistic Media 
С помощью инструмента Artistic Media (Суперлиния) строятся составные объекты класса 

«суперлинии». Каждый из этих объектов состоит из двух частей – линии, играющей роль 
управляющего объекта и определяющей основные параметры формы составного объекта в 
целом, и подчиненного объекта, определяющего детали этой формы. В роли подчиненного 
объекта может выступать замкнутая кривая или даже произвольный объект CorelDRAW, 
причем и управляющая линия, и подчиненный объект могут строиться как заранее, до 
построения суперлинии, так и создаваться в ходе него. Для реализации такого широкого 
спектра возможностей инструмент Artistic Media (Суперлиния) может работать в нескольких 
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режимах, отличающихся друг от друга только способами построения, а не конечной структурой 
составного объекта – суперлинии. Каким бы режимом мы ни воспользовались, результаты 
будут относиться к одному классу, что позволяет их редактировать одинаковыми приемами. 

Выбор режимов работы инструмента Artistic Media (Суперлиния) выполняется с 
помощью панели атрибутов, которая после его выбора в наборе инструментов принимает вид, 
приведенный на рис. 36. 

Поле с ползунком Freehand Smoothing (Сглаживание) позволяет регулировать частоту 
создания узлов и, следовательно, степень гладкости управляющей линии соединенного объекта 
при ее построении от руки. 

Счетчик Artistic Media Tool Width (Ширина линии) содержит значение, определяющее 
максимальную ширину подчиненного объекта при построении суперлинии. 

Раскрывающийся список Preset (Заготовка) позволяет выбрать схему подчиненного 
объекта при работе в режиме заготовки. 

 

 
 

Рисунок 36 – Панель атрибутов инструмента Artistic Media 
 

 
Режим каллиграфии. Режим каллиграфии – наиболее простой и понятный режим 

работы инструмента Artistic Media (Суперлиния), поскольку действия пользователя в этом 
режиме не отличаются от его работы с инструментом Freehand (Произвольная кривая). При 
перетаскивании указателя инструмента по определенной траектории траектория фиксируется в 
качестве управляющей линии составного объекта, при этом учитывается значение 
управляющего параметра сглаживания. Однако по окончании перетаскивания (после 
отпускания кнопки мыши) автоматически строится еще один объект – замкнутая кривая. Ее 
форма определяется формой управляющей линии и характеристиками каллиграфического пера 
– шириной, задающейся значением счетчика ширины линии, и наклоном, который задается 
значением счетчика Calligraphic Angle (Угол наклона), заменяющего в режиме каллиграфии 
схему заготовки в панели атрибутов (рис. 37). 

Каллиграфическое перо заданной ширины устанавливается средней точкой на 
начальный узел управляющей линии с заданным наклоном к горизонту, а затем перемещается 
вдоль нее с сохранением наклона. Подчиненный объект представляет собой замкнутую кривую, 
составленную из начального и конечного положений пера и траекторий, по которым 
перемещались его края. 

На рисунке три раза представлен один составной объект, построенный в режиме 
каллиграфии. Слева он выделен с помощью инструмента Shape (Форма) щелчком на оси 
объекта, посередине – с помощью инструмента Pick (Выбор) щелчком на краю объекта. Справа 
показан вид объекта после смены значения наклона каллиграфического пера с 0 на 60°. 

 
 

Кисть 

Каллиграфия 

С нажимом Ширина линии 

Схема заготовки 

Заготовка Распылитель Сглаживание 
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Рисунок 37 – Режим каллиграфии 
 

К сожалению, в этом режиме управляющую кривую нельзя построить заранее, из-за чего 
на практике он применяется сравнительно редко. 

 
Режим заготовки. В отличие от режима каллиграфии режим заготовки инструмента 

Artistic Media (Суперлиния) позволяет строить управляющую кривую двумя способами: в 
процессе построения составного объекта суперлинии или заранее, как обычную линию, с 
последующим ее преобразованием в управляющий объект. 

В первом варианте пользователь действует так же, как в режиме каллиграфии, только 
вместо наклона каллиграфического пера выбирается заранее подготовленная схема 
подчиненного объекта – раскрывающийся список с этими схемами появляется на панели 
атрибутов. В этом случае в процессе перетаскивания инструмента по траектории создаваемой 
управляющей линии указатель инструмента выглядит как окружность темного цвета с 
диаметром, равным установленной ширине суперлинии. После отпускания кнопки мыши 
строится и отображается подчиненный объект (рис. 38). 

 

 
 
Рисунок 38 – Линии, построенные инструментом Artistic Media в режиме заготовки 

 
Слева выделена управляющая кривая, в центре и справа – подчиненные объекты, 

построенные на базе этой кривой по двум различным заготовкам 
Во втором варианте пользователь сначала строит линию инструментом Freehand 

(Произвольная кривая) или Bezier (Кривая Безье), затем выбирается инструмент Artistic Media 
(Суперлиния), включается режим заготовки и выбирается одна из заготовок, приведенных в 
раскрывающемся списке на панели атрибутов. Выделенная кривая преобразуется в 
управляющую кривую, и по ней строится подчиненный объект суперлинии. 

Если в качестве управляющего объекта используется соединенная линия, то заготовка 
суперлинии применяется к каждой из ее ветвей отдельно. Если перед выбором заготовки был 
выделен объект, уже являющийся суперлинией, то его подчиненный объект удаляется, а по 

Указатель инструмента Угол наклона 
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сохраненной управляющей линии строится новый подчиненный объект в соответствии с новой 
заготовкой. 

 
Режим кисти. В режиме кисти инструмента Artistic Media (Суперлиния) подчиненный 

объект не строится по управляющей линии, а только деформируется в соответствии с ее 
формой и заданной шириной суперлинии. Исходным материалом для деформации служат мазки 
– изображения, сохраненные в специальном формате СМХ в папке \CustomMediaStrokes, 
вложенной в папку, в которую была установлена программа CorelDRAW. Суть деформации 
состоит в том, что изображение-мазок растягивается или сжимается таким образом, чтобы его 
длина равнялась длине управляющей линии соединенного объекта, а высота – заданной ширине 
суперлинии, а затем искривляется в соответствии с формой управляющей линии. 

В комплект поставки CorelDRAW входит определенное количество стандартных мазков, 
и их коллекцию можно расширять, внося в нее любые изображения (не только векторные, но и 
пиксельные). После внесения файла нового мазка в папку \CustomMediaStrokes его упрощенное 
изображение появляется в качестве новой альтернативы в раскрывающемся списке мазков на 
панели атрибутов для режима кисти (рис. 39). 

 
 

Рисунок 39 – Элементы панели атрибутов инструмента Artistic Media, 
характерные для режима кисти 

 
Приемы построения суперлинии в режиме кисти точно такие же, как в режиме заготовки. 
Чтобы сохранить изображение в качестве мазка, его следует выделить с помощью 

инструмента Pick (Выбор), затем выбрать инструмент Artistic Media (Суперлиния), включить 
режим кисти и щелкнуть на кнопке сохранения изображения в качестве мазка на панели 
атрибутов. После задания (в раскрывшемся диалоговом окне) имени файла, в котором будет 
сохранен мазок, новым мазком можно пользоваться для создания суперлиний. 

Кнопка удаления мазка позволяет удалить из списка мазков ставший ненужным элемент. 
Физическое удаление мазка происходит не при щелчке на соответствующей кнопке 

панели атрибутов, а при завершении сеанса работы с CorelDRAW. Поэтому в течение сеанса с 
удаленным мазком еще можно работать. 

 
Упражнение 3. Построение суперлинии 

Выполняя это упражнение, мы повторим приемы построения линий и освоим приемы 
работы с суперлиниями на примере режима кисти. 

1. Вставьте в открытый документ CorelDRAW новую страницу и, пользуясь приемами 
построения линий, постройте в ее верхней части стилизованное изображение змеи (рис. 40, 
сверху). Вначале постройте замкнутую кривую, соответствующую абрису головы и тела змеи. 
В качестве глаз и ноздрей постройте небольшие эллипсы, а зигзагом на спине послужит 
ломаная линия, состоящая из прямолинейных сегментов. Если абрис получится кривоватым – 
не беда, в последующих уроках мы ознакомимся с приемами, позволяющими не только с 
идеальной точностью строить подобные изображения, но и корректировать их, а для этого 
упражнения высокая точность не нужна. 

Список мазков 

Удалить мазок 

Сохранить как мазок 
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2. Теперь необходимо выделить все составные части изображения змеи. Проще всего это 

сделать инструментом Pick (Выбор): выберите его и щелкните на свободном месте страницы, 
отменив таким образом выделение. Затем перетащите указатель инструмента по диагонали 
воображаемого прямоугольника, охватывающего изображение змеи целиком. После отпускания 
кнопки мыши выделенными окажутся все элементы изображения, оказавшиеся внутри 
прямоугольника. 

 

Рисунок 40 – Определение нового мазка и его применение для построения суперлиний 
 

3. Выберите в наборе инструментов инструмент Artistic Media (Суперлиния) и включите 
режим кисти, щелкнув на соответствующей кнопке панели атрибутов. Затем щелкните там же 
на кнопке с изображением дискеты и задайте имя файла для сохранения мазка, например 
zmejuka.cmx. После щелчка на кнопке ОК новый мазок готов к использованию. 

4. Отмените выделение изображения змеи, нажав клавишу Esc. Перетащите указатель 
инструмента Artistic Media (Суперлиния) слева направо по волнообразной траектории. После 
отпускания кнопки мыши наша змея... зазмеится! 

5. Чтобы свернуть змею в клубок, постройте с помощью инструмента Spiral (Спираль) 
логарифмическую спираль на 2-3 витка. Выберите инструмент Artistic Media (Суперлиния) и, 
раскрыв список мазков, щелкните на образце с упрощенным изображением змеи. Если клубок 
окажется слишком плотным, попробуйте, изменив ширину суперлинии или удалив объект, 
повторить этот шаг, увеличив коэффициент расширения спирали. 

6. Чтобы свернуть змею в кольцо, используйте в качестве управляющей линии эллипс, 
построенный соответствующим инструментом. 

7. Чтобы «изготовить» оригинальную прямоугольную рамку, постройте прямоугольник, 
а затем закруглите три его угла – кроме верхнего левого. Это поможет избавиться от резких 
изломов суперлинии, в которой построенный прямоугольник будет играть роль управляющей 
линии. 

 
Режим распылителя. Режим распылителя инструмента Artistic Media (Суперлиния) 

формирует не один подчиненный объект, а целую группу, размещая копии заранее 
определенного изображения или его отдельных частей (шаблон распылителя) вдоль 
управляющей линии. Два примера получающихся в результате соединенных объектов 
представлены на рис. 41. В обоих случаях управляющая кривая одна и та же, а шаблоны 
распылителя – разные. 
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Рисунок 41 – Суперлинии, построенные в режиме распылителя 
 

 

3.5. Пристыковываемое окно Artistic Media 
Для построения и изменения суперлиний можно пользоваться не только панелью 

атрибутов инструмента Artistic Media (Суперлиния), но и одноименным пристыковываемым 
окном (рис. 42). Чтобы отобразить его на экране, выберите команду Window → Dockers → 
Artistic Media (Окно → Пристыковываемые окна → Суперлиния). 

 

 
 

Рисунок 42 – Пристыковываемое окно Artistic Media и его элементы 
 
В пристыковываемом окне приведены два списка с изображениями заготовок 

суперлиний, мазков и шаблонов распылителя. В нижнем списке представлен полный набор 
схем, соответствующий текущему содержимому папки \CustomMediaStrokes, в верхнем – те из 
схем, которые были недавно использованы для построения суперлиний. Содержимым списка 
можно управлять при помощи меню отображаемых объектов, раскрываемого кнопкой с 
изображением направленного вправо треугольника. Три приведенных в меню режима 
позволяют включать и выключать отображение заготовок, мазков и шаблонов распылителя 
(сверху вниз). Кнопка блокировки управляет режимом применения схемы к выбранной на 
изображении линии. Если кнопка нажата, то сразу после выбора схемы в одном из списков 
(щелчком мыши на соответствующей альтернативе) эта схема применяется для построения 
суперлинии. Если кнопка блокировки отжата, для применения схемы необходимо 

Использованные
шаблоны, мазки 
и схемы 

Применить

Блокировка 

Сохранить

Удалить

Отображаемые 
объекты
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дополнительно щелкнуть на кнопке Apply (Применить). Использование элементов этого 
пристыковываемого окна позволяет существенно упростить работу с тремя режимами 
построения суперлиний (заготовки, кисти и распылителя). 

В частности, чтобы преобразовать кривую в управляющую кривую суперлинии, 
достаточно выбрать в одном из двух списков пристыковываемого окна нужное изображение 
заготовки, мазка или шаблона распылителя и перетащить его мышью на эту кривую. 

Чтобы запомнить изображение как мазок или шаблон распылителя, достаточно выделить 
его и перетащить мышью в нижний список. После отпускания кнопки мыши открывается 
диалоговое окно, в котором указывается, сохраняется ли изображение как мазок или как 
шаблон распылителя, а затем задается имя файла. 

Того же эффекта можно добиться с помощью кнопки Save (Сохранить) 
пристыковываемого окна. 

3.6. Элементы чертежей и схем 
Если при подготовке иллюстрированного каталога на изображение требуется нанести 

габаритные размеры изделия (рис. 43) или указать выносками его отдельные части можно 
воспользоваться панелью инструментов Curve (Кривая).  

 

Рисунок 43 – Примеры простановки размеров 
 

Размерные линии. Выбор на панели инструмента Curve (Кривая) инструмента 
Dimension (Размерные линии) дает возможность воспользоваться целой группой инструментов 
для нанесения на изображение различных размерных схем (состоящих из выносных линий, 
собственно размерной линии и размерной надписи) и выносных линий. Размерные схемы и 
выносные линии представляют собой составные объекты следующих классов: 

линейный размер (linear dimension);  
угловой размер (angled dimension);  
выноска (callout). 
Панель атрибутов размерной линии (рис. 44.). 
• Auto Dimension Tool (Авторазмер). Тип размерной схемы (вертикальный или 

горизонтальный размер) определяется автоматически по движению мыши в процессе 
построения схемы. 
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Рисунок 44 – Панель атрибутов при выборе инструмента Dimension 
 

• Vertical Dimension Tool (Вертикальный размер). Выбор схемы простановки размера, 
предполагающей вертикальное направление размерной линии. 

• Horizontal Dimension Tool (Горизонтальный размер). Выбор схемы простановки 
размера, предполагающей горизонтальное направление размерной линии. 

• Slanted Dimension Tool (Наклонный размер). Выбор схемы простановки размера, 
предполагающей наклонное направление размерной линии. 

• Callout (Выносная линия). Выбор специфического составного объекта, связывающего 
надпись с точкой присоединения на объекте. Точкой присоединения объекта называется точка, 
с которой могут быть связаны элементы размерной схемы, соединительные линии или начало 
выноски. 

• Angular Dimension Tool (Угловой размер). Выбор схемы простановки углового размера, 
в которой размерная линия имеет форму дуги окружности с центром в центре 
«образмериваемого» угла. 

Раскрывающийся список Dimension Style (Тип измерения) управляет форматом 
отображения значения размера. В список включены следующие альтернативы: 

• Decimal (Десятичный) – значение размера отображается в виде десятичной дроби, 
количество дробных разрядов в которой определяется выбором альтернативы в списке 
точности измерения; 

• Fractional (Дробный) – значение размера отображается в виде смешанной натуральной 
дроби, знаменатель дробной части которой определяется выбором альтернативы в списке 
точности измерения; 

• US Engineering (Инженерный) и US Architecture (Архитектурный) – содержание и 
форма отображения размерной надписи определяются в соответствии со стандартами США на 
выполнение инженерных и строительных чертежей. 

Альтернативы списка Dimension Precision (Точность измерений) управляют точностью 
отображения значения размера в размерной надписи. Состав альтернатив зависит от 
выбранного типа измерения. 

Раскрывающийся список Dimension Units (Единицы измерений) позволяет выбрать в 
качестве единицы измерения для размера любую из единиц, примеряемых в CorelDRAW, и 
указать, каким образом она будет обозначаться (например, дюймы могут обозначаться как 
словом, так и двойным апострофом). 

Кнопки раскрывающейся панели Text Position (Положение текста) определяют 
расположение размерной надписи по отношению к размерной линии (рис. 45). 
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Рисунок 45 – Кнопки размещения размерной надписи по отношению к размерной линии 
 

Кнопка Dynamic Dimensioning (Динамическая привязка) управляет режимом 
формирования размерной надписи. Если она нажата, то размерная надпись формируется заново 
при каждом изменении размера объекта, с которым связана размерная схема. В противном 
случае размерная надпись формируется однократно в момент построения размерной схемы. 

Поле Suffix for Dimension (Суффикс размера) содержит текст, добавляемый к размерной 
надписи после размерного числа. 

Поле Prefix for Dimension (Префикс размера) содержит текст, добавляемый к размерной 
надписи перед размерным числом. 

Кнопка Show Units for Dimension (Показывать единицы измерения) позволяет включить 
обозначения единиц измерения в состав размерной надписи. 

 
Упражнение 4. Простановка размеров 

Выполните это упражнение: 
1. Вставьте в открытый документ CorelDRAW новую страницу, переименуйте ее в 

Dimensions и постройте посредине правильный выпуклый шестиугольник произвольного 
размера. Воспользовавшись панелью атрибутов, установите его размер по вертикали равным 50 
мм. Поскольку по умолчанию включен режим синхронного изменения размера объекта по 
вертикали и горизонтали, шестиугольник останется правильным. 

2. Выберите в наборе инструментов инструмент Dimension (Размерные линии) и на 
панели атрибутов щелкните на кнопке горизонтального размера. Начнем построение 
горизонтальной размерной схемы с задания управляющих параметров на панели атрибутов. 
Установите тип измерения Decimal (Десятичный), в качестве единиц измерения выберите 
миллиметры и запретите включение обозначения единиц в размерную надпись. Точность 
отображения выберите равной двум разрядам после запятой. Наведите указатель инструмента 
на левый нижний угол шестиугольника и, добившись, чтобы точка присоединения 
обозначилась цветными маркером и надписью node (рис. 46, а), щелкните кнопкой мыши. 

 

Рисунок 46 – Построение линейной размерной схемы 
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3. Переместите указатель инструмента на правый нижний угол шестиугольника и точно 
таким же образом зафиксируйте точку присоединения второй выносной линии размерной 
схемы (рис. 46, б). 

4. Сместите указатель инструмента вниз и пронаблюдайте, как вместе с ним опускается 
размерная линия и вытягиваются вниз выносные линии. Сместите указатель инструмента влево 
таким образом, чтобы прямоугольник, показывающий будущее положение размерной надписи, 
оказался в середине размерной линии, и снова щелкните мышью, фиксируя его положение. 
Размерная схема будет построена, и в строке состояния появится сообщение Linear Dimension 
on Layer 1 (Линейный размер на слое 1). 

5. Выберите инструмент Pick (Выбор) и щелкните им на шестиугольнике, выделяя его. 
Сообщение в строке состояния будет уже другим – Control Polygon with 6 sides on Layer 1 
(Управляющий многоугольник с 6 сторонами на слое 1). После присоединения размерной 
схемы объект становится управляющим, то есть его изменение автоматически приведет к 
изменению присоединенных к нему объектов. Щелкните на размерной надписи и обратите 
внимание на то, что рамка выделения охватывает не всю вновь построенную размерную схему, 
а только текст (рис. 46, в). В строке состояния появляется сообщение Control Text... 
(Управляющий текст...). Таким образом, шестиугольник является управляющим объектом для 
всех присоединенных к нему размерных схем, а текст размерной надписи является 
управляющим объектом для одной размерной схемы – той, в состав которой он входит. 

6. Перетащите инструментом Pick (Выбор) текст размерной надписи влево и вниз, следя 
за тем, как перемещение управляющего объекта изменяет форму составного объекта. 
Возвратите размерную надпись в исходное положение (рис. 46, г). 

7. Теперь построим размерную схему для наклонного размера. Она строится точно так 
же, как для горизонтального, только перед началом построения на панели атрибутов следует 
щелкнуть на кнопке наклонного размера. Определяя местоположение размерной надписи, 
оставьте ее справа от правой выносной линии. 

8. Построим размерную схему для углового размера. До определения первой точки 
задайте суффикс размерной надписи – знак градуса. Для этого установите курсор в 
соответствующее поле панели атрибутов, переведите вспомогательную клавиатуру в режим 
ввода цифр клавишей Num Lock и при нажатой клавише Alt введите с нее код символа градуса 
0176. Затем установите точность отображения значения размера без дробных разрядов. 
Размерная схема строится аналогично двум предыдущим с одним дополнением: сначала 
необходимо щелчком зафиксировать центр углового размера – точку, в которой выносные 
линии пересекаются (рис. 47, а), а затем определять точки присоединения выносных линий 
(рис. 47, б и в). Если требуется, чтобы размерная схема была полностью привязана к объекту и 
отслеживала его перемещения и изменения размеров, эта точка должна быть точкой 
присоединения (в момент фиксации кроме маркера точки присоединения должна появиться 
также цветная надпись center). При определении местоположения размерной надписи 
(рис. 47, г), возможно, ее не удастся сразу переместить на середину размерной линии. В этом 
случае сначала переместите указатель инструмента вправо, увеличивая радиус размерной 
линии, затем переместите размерную надпись на ее середину, а потом снова уменьшите радиус, 
перемещая указатель инструмента влево. Результат простановки размеров представлен на 
рис. 48. 

Размерную схему можно построить и без привязки выносных линий к точкам 
присоединения какого-либо объекта, выполняя щелчки мышью не на точках присоединения. 
Такие неприсоединенные схемы, конечно, не меняются при внесении изменений в изображение 
и не удаляются при удалении его объектов. 
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Рисунок 47 – Построение угловой размерной схемы 
 

Если в процессе построения размерной схемы обнаружится, что одна из точек 
определена неправильно, доведите построение схемы до конца, а после определения 
местоположения размерной надписи удалите размерную схему, выделив ее с помощью 
инструмента Pick (Выбор) и нажав клавишу Del. При этом безразлично, на каком объекте схемы 
выполнить щелчок инструментом Pick (Выбор), – даже если будет выделена только размерная 
надпись, после нажатия клавиши Del исчезнет вся схема, поскольку удаление управляющего 
объекта приводит к удалению всего составного объекта. В силу этой особенности при удалении 
объекта, к которому присоединены размерные схемы, все эти схемы будут также удалены. 

 

Рисунок 48 – Результат простановки размеров на шестиугольном объекте 
 

9. В завершение упражнения внесите изменения в построенные размерные схемы. Все 
изменения выполняются не инструментами для простановки размеров, а инструментом Pick 
(Выбор). Вначале выделите шестиугольник и увеличьте его размер вдвое, введя в одно из полей 
габаритных размеров новое значение. Проследите за изменением размерных схем. Затем 
выделите размерную надпись наклонного размера и переместите ее в середину размерной 
линии. Измените ее размещение, поместив текст в разрыв размерной линии. 

 
Выносные линии. Выносные линии представляют собой составные объекты, 

составляющие отдельный класс. Так же как размерные линии, они могут присоединяться к 
основным объектам, но не двумя, а одной линией. Эта линия состоит из двух сегментов, причем 
конец второго сегмента присоединен к надписи выноски. Надпись является управляющим 
объектом составного объекта класса выносок. Перемещение надписи влияет на длину и 
расположение второго сегмента выноски, первый сегмент при этом остается неподвижным. 
Изменение длины надписи не оказывает влияния на сегменты выноски. При перемещении 
объекта, к которому присоединена выноска, она перемещается одновременно с объектом. 
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Процедура построения выноски состоит из четырех действий, выполняющихся после 

выбора инструмента Dimension (Размерные линии) и щелчка на кнопке выноски панели 
атрибутов этого инструмента. 

1. Первый щелчок мышью фиксирует начало первого сегмента. Если он выполняется на 
точке присоединения основного объекта, выноска будет присоединена к нему, в противном 
случае выноска не связывается с объектом. 

2. Второй щелчок мышью фиксирует конец первого и начало второго сегмента выноски. 
Если второй сегмент не нужен, для него задается нулевая длина – в этом случае второй щелчок 
делается двойным. 

3. Третий щелчок фиксирует конец второго сегмента и точку начала надписи выноски. 
При определении направления сегментов выноски удобно пользоваться клавишей-

модификатором Ctrl, ограничивающей возможные наклоны сегментов выноски к горизонтали 
углами, кратными 15°. 

4. После третьего (или второго двойного) щелчка включается режим ввода надписи 
выноски. 

5. Для завершения ввода текста выноски достаточно выбрать в наборе инструментов 
инструмент Pick (Выбор). 

Примеры выносок представлены на рис. 49. Попробуйте в качестве упражнения 
воспроизвести это изображение.  

 

SIDE A

SIDE B
 

 
Рисунок 49 – Примеры выносок  

 
Соединительные линии. Соединительные линии представляют собой особый класс 

линейных объектов, очень удобных для построения всевозможных схематических 
изображений, в особенности – блок-схем. В сочетании со стандартными фигурами инструмент 
Interactive Connector Tool (Соединительная линия) предоставляет пользователю 
дополнительные возможности. 

Оба конца соединительной линии должны присоединяться к объекту в специальных 
точках (точках присоединения). После построения соединительная линия связывает эти точки. 
Вариантов соединения может быть два: ломаной линией, состоящей из строго горизонтальных 
и строго вертикальных прямолинейных сегментов вне зависимости от взаимного положения 
соединенных объектов (ломаная соединительная линия) и отрезком прямой (прямая 
соединительная линия). Выбирается вариант с помощью кнопок Angled connector (Ломаная 
соединительная линия) и Straight connector (Прямая соединительная линия), расположенных на 
панели атрибутов инструмента Interactive Connector Tool (Соединительная линия). Пример 
ломаной соединительной линии представлен на рис. 50. 
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Рисунок 50 – Заключительный этап построения соединительной линии 
 

Процедура построения соединительной линии состоит из двух действий, 
выполняющихся при выбранном инструменте Interactive Connector Line (Соединительная 
линия). 

1. Зафиксируйте точку присоединения соединительной линии к первому из двух 
объектов. Для этого указатель инструмента подводится к точке присоединения, пока она не 
будет выделена цветным кружком, после чего выполняется щелчок мышью. 

2. Зафиксируйте точку присоединения соединительной линии ко второму объекту точно 
так же, как к первому. 

После построения соединительной линии можно перемещать ее отдельные сегменты, 
перетаскивая их инструментом Interactive Connector Line (Соединительная линия). Оба объекта, 
к которым присоединяется соединительная линия, становятся для нее управляющими. 

 
Упражнение 5. Построение соединительных линий 
 

Постройте прямоугольник и эллипс, а затем соедините их парой соединительных линий, 
связав ими две разных пары точек присоединения. Перед созданием второй соединительной 
линии измените тип соединительной линии. Затем при помощи инструмента Pick (Выбор) 
выделите один из управляющих объектов и перемещайте его вокруг второго, следя за 
поведением соединительных линий. 

 

3.7. Контрольные вопросы 
1. Назовите основные понятия для модели линии. 
2. Назовите основные типы узлов линий. Чем они характеризуются? 
3. Назовите последовательность этапов построения кривой инструментом Bezier (Кривая 

Безье). 
4. Для чего используют инструмент Artistic Media (Суперлиния)? Назовите основные 

режимы работы инструмента Artistic Media. 
5. Для чего нужны и как работают пристыковываемые окна (Dockers)? 
6. Назовите типы составных объектов предназначенные для построения размерных схем и 

выносных линий. 
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ЛАБОРАТОРНАЯ РАБОТА №4 

ЦВЕТА, ПАЛИТРЫ, ЗАЛИВКИ, ADOBE POSTSCRIPT 
Цель лабораторной работы: ознакомиться с палитрами и моделями цвета, видами заливки. 

 

4.1. Цветовые палитры и модели цвета 
Различают восемь типов заливок (рис. 51): 
- однородные, или сплошные, заливки; 
- градиентные заливки; 
- заливки двухцветным узором; 
- заливки цветным узором; 
- заливки точечным узором; 
- текстурные заливки; 
- заливки растром PostScript; 
- сетчатые заливки. 
Палитра – совокупность цветов, точность воспроизведения каждого из которых 

гарантируется технологией воспроизведения цвета, соответствующей этой палитре. 
Фиксированной палитрой называется не подлежащая изменениям совокупность 

стандартных цветов, предусмотренных системой цветосовмещения, то есть конкретной 
реализацией технологии воспроизведения цвета, соответствующей этой палитре. Моделью 
цвета называется механизм, с помощью которого можно воспроизвести любой из цветов в 
пределах цветового охвата модели (совокупности всех предусмотренных ею цветов). 

 

Рисунок 51 – Примеры различных заливок одного объекта: а – однородная заливка, б – 
радиальная градиентная заливка, в – заливка двухцветным узором, г – текстурная заливка 

 
Цветовые охваты различных моделей не совпадают друг с другом, поэтому, строго 

говоря, точное преобразование цвета из одной модели в другую возможно не всегда. 
Для выбора подходящей палитры выполните команду: Window > Dockers > Color Palette 

Browser (Окно > Пристыковываемые окна > Просмотр палитр цветов) раскройте 
пристыковываемое окно Color Palette Browser (Просмотр палитр цветов), представленное на 
рис. 52, и выберите соответствующую альтернативу в иерархическом списке. Имеется 
возможность одновременного вывода на экран сразу нескольких палитр. 

4.2. Однородные заливки 
Однородной заливкой называется заполнение ограниченного замкнутой кривой объекта 

цветом, который не меняется в пределах объекта. Цвет однородной заливки выбирается в 
палитре или подбирается с помощью цветовых моделей. 

 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 47

Изменение заливки по умолчанию. Чтобы изменить текущее значение заливки по 
умолчанию, сделайте следующее. 

1. Отмените выделение объектов на рисунке. Проще всего это сделать, нажав клавишу 
Esc. Нажмите и удерживайте кнопку мыши на кнопке инструмента Fill (Заливка) до тех пор, 
пока не появится панель этого инструмента. Щелкните в ней на кнопке отмены заливки (она 
перечеркнута косым крестом). 

 

Рисунок 52 – Рабочее пространство с пристыковываемым окном Coior Palette Browser  
(справа видны три выбранных в окне палитры: PA/VTONF. Solid Colors, Christmas, стандартная 

палитра цветовой модели RGB) 
 

2. На экране раскроется диалоговое окно установки значений, принятых по умолчанию 
(рис. 53). Его заголовок Uniform Fill (Однородная заливка) говорит о том, что CorelDRAW 
собирается менять принятые по умолчанию значения параметров заливки вновь создаваемых 
объектов рисунка. Поскольку мы собираемся задать режим заливки только для графических 
объектов, установите флажок Graphic (Графика) и сбросьте два других флажка. Щелкните на 
кнопке ОК – режим заливки новых графических объектов по умолчанию установлен. 

 

Рисунок 53 – Диалоговое окно настройки принятых по умолчанию параметров однородной заливки 
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Теперь выполним ту же операцию для текстовых объектов. Мы воспользуемся в 

качестве цвета такой заливки черный (хотя можно взять и любой другой цвет) и моделью цвета 
CMYK. 

1. Повторите описанные выше действия вплоть до появления на экране панели 
инструмента Fill (Заливка), но на этот раз щелкните на кнопке Fill Color Dialog (Однородная 
заливка) – левой крайней на панели инструмента. В диалоговом окне установки параметров по 
умолчанию (см. рис. 53) сбросьте флажок Graphic (Графика) и установите флажки Artistic Text 
(Фигурный текст) и Paragraph Text (Простой текст). После щелчка на кнопке ОК раскроется 
диалоговое окно Uniform Fill (Однородная заливка), представленное на рис. 54. 

2. Раскройте на вкладке Models (Модели) список Model (Модель) и ознакомьтесь с 
перечнем моделей цвета, с которыми работает CorelDRAW. Выберите альтернативу CMYK и 
установите в счетчиках, расположенных в правой части вкладки, следующие значения: С – 0, М 
– 0, Y – 0, К – 100. Это означает, что хроматические составляющие (базовые цвета модели – 
голубой, пурпурный и желтый) сведены к нулю, а ахроматическая (черная) составляющая 
выведена на максимум. В результате получился чисто черный цвет. Щелкните на кнопке ОК. 

В результате проделанных действий мы восстановили стандартные режимы заливки 
вновь создаваемых объектов: для графических объектов заливка отсутствует, а новые тексты 
заливаются черным цветом по модели CMYK. 

 

Рисунок 54 – Диалоговое окно Uniform Fill, раскрытое на вкладке Models 
 
Выбор цвета заливки с помощью экранной палитры. Экранной палитрой называется 

специальное окно, которое может отображаться на экране либо в свободном состоянии (в виде 
окна), либо пристыкованным к правому краю экрана.  

Пристыкованные экранные палитры видны в правой части рис. 52, а на рис. 55 показаны 
экранные палитры Default RGB (Палитра по умолчанию) в свернутом виде и Christmas 
(Рождество) в развернутом.  

Выбор палитр цветов, отображаемых в рабочем пространстве, осуществляется с 
помощью пристыковываемого окна Color Palette Browser (Просмотр палитр цветов). Если это 
окно отсутствует на экране, его можно сделать доступным, выбрав команду Window > Dockers 
> Color Palette Browser (Окно > Пристыковываемые окна > Просмотр палитр цветов). То же 
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самое можно сделать, выбрав нужную палитру в подменю Color Palettes (Палитры цветов) меню 
Window (Окно). Кроме того, палитры доступны и из диалоговых окон заливки, 
рассматриваемых далее. 

 

 
 

Рисунок 55 – Экранные палитры в виде окон в рабочем пространстве 
 

Чтобы назначить выделенному объекту или нескольким объектам однородную заливку с 
помощью палитры, достаточно щелкнуть на образце нужного цвета мышью. Если выделено 
несколько объектов или группа объектов, назначение однородной заливки распространится на 
все объекты. Иногда это может оказаться неудобным, особенно если следует назначить 
однородную заливку только одному объекту, входящему в группу (возможно, состоящую из 
вложенных групп).  

 

 
 

а – при назначении однородной заливки, б – при обводке однородным цветом 
Рисунок 56 – Заключительная стадия перетаскивания цвета на объект из образца экранной 

палитры (слева) и получившиеся результаты (справа) 
 
В этом случае можно воспользоваться приемом перетаскивания мышью нужного цвета из образца палитры 

в любую точку в пределах объекта. При этом следует следить за формой указателя мыши – он 
меняется в зависимости от того, что под ним находится (абрис или внутренняя точка объекта). 
При отпускании кнопки мыши по окончании перетаскивания будет выполнена однородная 
заливка или обводка контура только одного объекта, даже если перед перетаскиванием было 
выделено несколько объектов или группа (рис. 56).  

В заключение обсуждения экранных палитр еще раз отметим: палитры очень удобны, 
когда требуется точное воспроизведение цветов или их унификация в пределах изображения. 
Для составления уникальных цветов требуется работать с моделями цвета (см. ниже), но 
определенные возможности в этом плане имеются и у экранных палитр. Если нажать кнопку 

Прокрутка назад Прокрутка вперед 

Развернуть палитру Выделенный цвет 
Образец «Без заливки» 

а 

б 
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мыши на образце цвета экранной палитры и удерживать ее несколько секунд, на экране 
появится вторичная палитра оттенков (рис. 57). 

 

 

Рисунок 57 – Вторичная палитра оттенков выделенного и в экранной палитре цвета 
 

Теперь можно выбрать желаемый оттенок и отпустить кнопку мыши. Правда, при этом 
следует помнить, что для палитр шишечных цветов полученные таким образом оттенки будут 
представлены не плашечными цветами, а цветами модели RGB. 

 
Выбор цвета заливки в диалоговом окне Uniform Fill. Если вы решили 

воспользоваться для создания однородной заливки цветом, отсутствующим в палитрах, создав 
его с помощью той или иной модели цвета, вам поможет диалоговое окно Uniform Fill 
(Однородная заливка). Оно представлено на рис. 54. С его помощью можно как создавать 
новую, так и редактировать назначенную ранее однородную заливку. Вначале выделите объект 
или несколько объектов, для которых необходимо задать или отредактировать заливку, а затем 
раскройте диалоговое окно щелкнув мышью на крайней левой кнопке панели инструмента Fill 
(Заливка), представленной на рис. 58. 

Вкладки диалогового окна Uniform Fill (Однородная заливка) позволяют выбрать для 
однородной заливки любой цвет, обеспечивая доступ ко всем моделям цвета и палитрам. 
Рассмотрим работу с каждой из вкладок отдельно 

 

 
 

Рисунок 58 – Панель инструмента Fill и кнопки выбора категорий заливок 
 

Назначение цвета однородной заливки с помощью модели цвета. По умолчанию 
после открытия диалогового окна Uniform Fill (Однородная заливка) открывается вкладка 
Models (Модели), на которой представлены элементы управления, позволяющие задавать 
управляющие параметры модели цвета. Сама модель цвета выбирается с помощью 
раскрывающегося списка Model (Модель). На рис. 54 представлен вид диалогового окна, 
соответствующий модели CMYK. Сравните его с рис. 59, на котором выбрана модель RGB, и 
вы убедитесь, что все отличия заключаются только в наборе счетчиков, расположенных в 
правой части вкладки. Чтобы назначить новый цвет заливки выделенным объектам, следует 
выполнить описанную ниже процедуру. 
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1. С помощью раскрывающегося списка Model (Модель) выберите желаемую модель 

цвета. 
2. Путем перетаскивания мышью указателя цвета, расположенного на находящейся в 

центре вкладки полосе (на ней цвета представлены в спектральном порядке), выберите цвет, 
близкий к желаемому. Ориентируйтесь по положению указателя и по нижнему образцу в зоне 
Reference (Пример). 

3. Установите более точные значения управляющих параметров модели цвета путем 
перетаскивания мышью указателя в области точного выбора цвета или с помощью счетчиков 
группы Components (Базовые цвета). 

4. Щелкните на кнопке ОК. 
 

Назначение цвета однородной заливки с помощью палитр. Если цвет однородной 
заливки нужно выбрать из палитры цветов, не представленной в рабочем пространстве в виде 
палитры, это можно сделать при помощи вкладки Palettes (Палитры) диалогового окна Uniform 
Fill (Однородная заливка), показанной на рис. 60. 

 

 
 

Рисунок 59 – Элементы управления цветом на вкладке Models 
 
В левой части вкладки расположены раскрывающийся список Palette (Палитра), 

предназначенный для выбора требуемой палитры, и выбранная палитра, в которой приведены 
образцы и названия цветов. В правой части вкладки имеются образцы старого и вновь 
выбранного цвета заливки, а под ними – значения управляющих параметров двух моделей 
цвета. Выбрать конкретные модели можно в подменю Valuel и Value2, входящих меню, 
раскрывающееся после щелчка на кнопке Options (Режимы). С помощью счетчика Tint 
(Оттенок) можно указать, что вместо цвета из палитры для заливки следует применить его 
оттенок – значение счетчика определяет интенсивность оттенка. 

Возможность воспользоваться оттенками предусмотрена не во всех палитрах, входящих 
в состав CorelDRAW. 
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Рисунок 60 – Вкладка Palettes 
 

 
Назначение цвета однородной заливки с помощью смесителей. Вкладка Mixers 

(Смесители) включена в инструментарий для выбора цвета в помощь пользователям, не 
слишком уверенным в своих колористических способностях. С помощью расположенных на 
ней элементов управления (рис. 61), можно выбирать цвета в динамически формируемых 
палитрах, находящихся друг с другом в определенных цветовых отношениях. 

 

 
 

Рисунок 61 – Элементы управления вкладки Mixers 
 

На этой вкладке предлагаются следующие варианты построения динамических палитр: 
Primary (Первичный цвет), Compliment (Дополнительные цвета), Trianglel (Треугольник 1), 
Triangle2 (Треугольник 2), Rectangle (По прямоугольнику), Pentagon (По пятиугольнику). 
Каждому из вариантов соответствует свое количество базовых цветов, начиная от которых 
будут построены динамические палитры. Базовому цвету соответствует кружок селектора цвета 
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на цветовом круге. Количество и взаимное расположение селекторов цвета определяется 
перечисленными выше вариантами, построения палитр. 

- Для варианта Primary (Первичный цвет) строится только одна динамическая палитра. 
Если перед открытием диалогового окна заливки был выделен объект, уже имеющий 
однородную заливку, ее цвет используется в качестве базового. Впрочем, его можно изменить, 
перетаскивая селектор цвета по цветовому кругу мышью или задавая новые значения 
управляющих параметров выбранной модели цвета в счетчиках, расположенных в правой части 
вкладки. 

- Для варианта Complement (Дополнительные цвета) строятся две динамические 
палитры, базовые цвета которых выбираются так, чтобы соответствующие им селекторы цвета 
располагались на противоположных концах диаметра цветового круга. При перетаскивании 
любого из селекторов по кругу второй будет перемещаться синхронно в ту же сторону. 

- Для варианта Triangle 1 (Треугольник 1) строятся три динамические палитры. На 
цветовом круге появляются три селектора базовых цветов: черный, соответствующий 
первичному цвету; серый, соответствующий цвету, дополнительному к первичному (см. 
предыдущий вариант); и белый, свободный. При перетаскивании черного или серого селектора 
по кругу остальные селекторы перемещаются синхронно в ту же сторону, сохраняя свое 
расположение по отношению друг к другу. При перемещении свободного селектора меняется 
только его положение относительно черного и серого селекторов. 

- Для варианта Triangle 2 (Треугольник 2) также строятся три динамические палитры. Но 
в этом варианте на цветовом круге появляются черный и два свободных белых селектора. При 
перетаскивании черного селектора по кругу белые смещаются синхронно с ним в ту же 
сторону. При перетаскивании любого из белых селекторов второй белый селектор синхронно 
смещается по цветовому кругу в противоположную сторону на такой же угол. 

- Для варианта Rectangle (По прямоугольнику) строятся четыре динамические палитры. 
На цветовом круге им соответствуют две пары селекторов: черный с серым (базовая пара 
дополнительных цветов) и два белых (вторая пара дополнительных цветов). Перетаскивание 
селектора из первой пары синхронно меняет расположение всех селекторов, перетаскивание 
селектора из второй пары – только белых селекторов. 

- Для варианта Pentagon (По пятиугольнику) строится наибольшее число динамических 
палитр – пять. На цветовом круге их базовым цветам соответствуют черный и две пары белых 
селекторов. Перетаскивание черного селектора, как всегда, синхронно меняет расположение 
всех селекторов, перемещение селектора из ближней к нему пары меняет положение только 
этой пары селекторов, перетаскивание белого селектора из дальней от него пары согласованно 
перемещает все четыре белых селектора. 

Динамические палитры, количество образцов цвета, в которых задается счетчиком Size 
(Размер), строятся на основе базовых цветов, выбранных на цветовом круге с помощью 
селекторов. Вариант изменения цвета в пределах динамических палитр выбирается в 
раскрывающемся списке Variation (Вариация): Cooler (С переходом к прохладным тонам), 
Warmer (С переходом к теплым тонам), Darker (С переходом к темным тонам), Lighter (С 
переходом к светлым тонам), Less Saturation (С убыванием насыщенности тона). 

После того как динамические палитры построены, для задания нового цвета заливки 
достаточно щелкнуть мышью на любом из образцов цвета в них, а затем – на кнопке ОК. 

 
Выбор цвета заливки в пристыковываемом окне Color. Альтернативой диалоговому 

окну Uniform Fill (Однородная заливка) является пристыковываемое окно Color (Цвет). В этом 
окне расположены все элементы управления, необходимые для работы с моделями цвета (рис. 
62). 
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Если при работе над изображением приходится часто пользоваться моделями цвета, то 
использование пристыковываемого окна предпочтительнее – оно, в отличие от диалогового 
окна, может постоянно находиться в рабочем пространстве. 

 

 
 

Рисунок 62 – Пристыковываемое окно Color 
 

Выбор цвета осуществляется так же, как в диалоговом окне. Отличие состоит в том, что 
после щелчка на кнопке Fill (Заливка) выбранный цвет назначается заливке выделенных 
объектов, а после щелчка на кнопке Outline (Обводка) – их обводке. 

Пристыковываемым окном Color (Цвет) удобно пользоваться также при переносе цвет 
заливки ранее созданного объекта на заливку нового объекта с небольшой корректировкой 
управляющих параметров модели цвета. 

 
Применение инструментов Eyedropper и Paintbucket. Для анализа представленного на 

изображении цвета служит инструмент Eyedropper (Пипетка). На панели этого инструмента, как 
показано на рис. 63 (а), расположена кнопка еще одного инструмента – Paintbucket (Банка с 
краской). С помощью этих инструментов можно легко переносить ранее назначенные обводки и 
заливки на другие объекты. Панель атрибутов этих инструментов в режиме взятия образца 
цвета показана на рис. 63 (б), в режиме копирования свойств объекта – на рис. 63 (в). 

 

Рисунок 63 – Кнопки инструментов Eyedropper и Paintbucket 
и их панель атрибутов в разных режимах 

 
Чтобы перенести ранее построенную заливку на другой объект, следует выполнить 

описанную ниже процедуру. 
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1.  Выберите инструмент Eyedropper (Пипетка). В левом раскрывающемся списке 
панели атрибутов выберите альтернативу Sample Color (Образец цвета). 

2.  Щелкните мышью на выбранном образце заливки. Если при этом открыто 
пристыковываемое окно Color (Цвет), то расположенные в нем элементы управления 
(селекторы цвета и счетчики управляющих параметров модели цвета) установятся в 
соответствии с выбранным пипеткой цветом. 

Расположенная на панели атрибутов раскрывающаяся палитра Sample Size (Размеры 
образца) позволяет указать размеры области, которая будет служить источником цвета 
однородной заливки (возможны варианты 1x1, 2x2 и 5x5 пикселов). Если размер образца 
отличен от одного пиксела, цвет будет усреднен в пределах площади образца. С помощью 
кнопки Select from Desktop (Выбрать с рабочего стола) включается режим работы инструмента, 
при котором в качестве образца цвета можно использовать не только объекты активного 
графического документа программы CorelDRAW, но и любую точку рабочего стола (например, 
элементы системного интерфейса или изображения в окнах других приложений). 

3.  Выберите инструмент Paintbucket (Банка с краской). Если перед этим был выбран 
инструмент Eyedropper (Пипетка), то можно временно переключиться на инструмент 
Paintbucket (Банка с краской), нажав и удерживая клавишу Shift. 

4.  Щелкните мышью на объекте, на который требуется перенести заливку (рис. 64). 
 

 
 

Рисунок 64 – Работа инструментом Paintbucket 
 

Применение панели атрибутов для назначения и изменения однородной заливки. 
Чтобы управляющие параметры заливки появились на панели атрибутов, следует выделить 
объект или несколько объектов с одинаковой заливкой, а затем выбрать в наборе инструментов 
инструмент Interactive Fill (Интерактивная заливка). После этого панель атрибутов будет 
выглядеть примерно так, как показано на рис. 65. 

Кроме изменения параметров однородной заливки с помощью панели атрибутов удобно 
копировать ранее созданную заливку на выделенный объект. Для этого следует щелкнуть на 
кнопке копирования атрибутов заливки (см. рис. 65), а затем щелкнуть острием появившейся на 
экране толстой горизонтальной стрелки на любой внутренней точке объекта с копируемой 
заливкой. Этот прием копирования заливки годится не только для однородных, но и для 
специальных заливок. 

 

Рисунок 65 – Панель атрибутов 
в режиме отображения параметров однородной заливки по модели RGB 
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Упражнение 1. Построение пейзажа 

Условные пейзажи, подобные представленному в этом упражнении, часто выступают в 
качестве фона для самых разных работ, и от них не требуется ни особая точность, ни 
реалистичность изображения. 

1. Постройте инструментом Rectangle (Прямоугольник) прямоугольную границу 
будущего пейзажа. Скопируйте построенный прямоугольник с помощью кнопок стандартной 
панели инструментов и перетащите средний маркер верхней границы рамки выделения копии 
далеко вниз, за нижнюю границу исходного прямоугольника. Копия перевернется, и в 
результате получатся два прямоугольника с совмещенными сторонами – в них мы будем 
изображать части пейзажа, «небо» и «землю». 

2.  С помощью инструмента Freehand (Произвольная кривая) постройте гряду 
перекрывающих друг друга холмов. Каждая группа холмов строится как замкнутая кривая, 
нижняя часть которой расположена ниже линии горизонта. Замкнув кривую, выделите нижний 
прямоугольник («землю»), а затем – вновь построенную кривую (именно в такой 
последовательности!), и щелкните на кнопке Trim (Исключение) панели атрибутов. Это 
совместит нижний край холмов с линией горизонта. 

Начните с самых высоких холмов, а меньшие постройте поверх них – если строить 
объекты от заднего плана к переднему, отпадает необходимость упорядочивать их в стопке 
отдельными операциями. 

3. С помощью инструмента Ellipse (Эллипс) при нажатой клавише Ctrl постройте круг, 
который будет изображать солнце (рис. 66.) 

4.  С помощью экранной палитры раскрасьте пейзаж. Для этого назначьте каждому из 
его объектов заливку, перетаскивая на них образцы соответствующих цветов: для земли – 
коричневого, для неба – голубого, для дальней гряды холмов – светло-серого, для средней 
гряды – темно-серого, для ближней – черного. Солнце сделайте желтым. 

5.  Чтобы солнце садилось за холмы, а не перед ними, выделите его, а затем выберите 
команду Arrange > Order > Behind (Монтаж > Порядок > Позади объекта). Появившуюся 
горизонтальную стрелку наведите на любую точку дальней гряды холмов и щелкните мышью. 
Теперь все в порядке! Сохраните файл под именем Sunset. 

 

Рисунок 66 – Контуры объектов, составляющих условный пейзаж 
 

4.3. Специальные заливки 
К специальным заливкам в полной мере применимы основные принципы и приемы 

работы с однородными заливками, освоенные нами в предыдущих разделах. Назначение 
объектам специальных заливок выполняется с помощью тех же элементов интерфейса: кнопок 
панели инструмента Fill (Заливка), панели атрибутов, инструмента Interactive Fill 
(Интерактивная заливка), однако их применение при этом сильно отличается от описанного 
ранее. Мы познакомимся с ними, рассматривая отдельные категории специальных заливок. 
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Градиентные и сетчатые заливки. В категорию градиентных и сетчатых заливок 

сведены два класса заливок, обладающих общим признаком: в пределах заливаемого объекта 
выделяются некие «опорные пункты», для которых фиксируется цвет заливки, а в промежутках 
между ними цвет «перетекает», плавно меняясь (рис. 67). В полиграфии такие заливки 
называют цветовыми растяжками. В градиентных заливках в роли «опорных пунктов» 
выступают точки, прямые, квадраты и окружности, расположенные четко определенным 
образом (зависящим от типа градиентной заливки); в сетчатых заливках эту роль играют точки, 
расположенные в узлах сетки (что и определило название класса заливки). 

 

Рисунок 67 – Пример градиентной (слева) и сетчатой (справа) заливок одинаковых объектов 
 

4.4. Градиентные заливки 
На градиентных заливках основано множество приемов, позволяющих добиться 

различных графических эффектов (например, имитировать светотеневую картину или блики на 
блестящих предметах, рис. 68). 

 

а – линейная, б – радиальная, в – коническая, г – квадратная 
Рисунок 68 – Типы градиентных заливок 

 
Для создания градиентной заливки чаще всего пользуются либо инструментом Interactive 

Fill (Интерактивная заливка) вместе с панелью атрибутов, либо диалоговым окном Fountain Fill 
(Градиентная заливка). Первый вариант более нагляден, второй дает возможность строить 
схему градиентной заливки с большей точностью.  

 
Упражнение 2. Растушевка цилиндра 
 

В этом упражнении необходимо построить изображение цилиндра и придать ему объем с 
помощью накладывания теней и бликов. 

1. Создайте новый документ CorelDRAW и установите пять направляющих: две 
вертикальные с координатами 50 и 100 мм и три горизонтальные с координатами 250, 240 и 200 
мм. Вначале перетащите первую направляющую мышью с вертикальной координатной 
линейки, а затем откорректируйте ее положение с помощью соответствующего счетчика панели 
атрибутов. Точно так же поступите со второй вертикальной и тремя горизонтальными 
направляющими (последние перетащите с горизонтальной координатной линейки). Включите 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 58

режим Snap To Guidelines (Привязать к направляющим), щелкнув на третьей справа кнопке 
панели атрибутов (рис. 69). Выберите инструмент Zoom (Масштаб) и растяните им 
прямоугольник вокруг зоны пересечения направляющих. 

 

Рисунок 69 – Панель атрибутов направляющей 
 

2.  Нарисуйте внутри верхнего из прямоугольников, образованных пересечением 
направляющих, сильно растянутый в горизонтальном направлении эллипс, воспользовавшись 
для этого инструментом Ellipse (Эллипс). Начните с левого верхнего угла прямоугольника и 
перетащите указатель мыши в его правый нижний угол. Режим привязки к направляющим 
сделает свое дело, и габариты построенного эллипса будут в точности равны 50 и 10 мм. 
Выберите инструмент Pick (Выбор), выделите им построенный эллипс и при нажатой клавише 
Ctrl перетащите его вниз так, чтобы он касался снизу нижней горизонтальной направляющей (в 
момент касания часть направляющей будет выделена цветом). Перед тем как освободить левую 
кнопку мыши, нажмите ее правую кнопку, тогда эллипс будет не перемещен, а скопирован 
одновременно с перемещением копии. Инструментом Rectangle (Прямоугольник) постройте 
прямоугольник, касающийся направляющих всеми своими сторонами, так чтобы он охватывал 
верхний эллипс и касался нижнего. Установите в счетчике Y панели атрибутов значение 220 и 
нажмите клавишу Enter – горизонтальные стороны прямоугольника должны совместиться с 
большими осями эллипсов, а вертикальные с касательными – к эллипсам (рис. 70, а). 

 

Рисунок 70 – Имитация растушевки цилиндра градиентными заливками 
 

3.  Выделите верхний эллипс и переместите его на передний план щелчком на кнопке 
панели атрибутов То Front (На передний план). Верхняя грань цилиндра готова. Займемся 
боковой стороной и нижним основанием. Выделите прямоугольник, а затем, удерживая 
нажатой клавишу Shift, нижний эллипс. Щелкните на кнопке Quick Weld (Объединение) панели 
атрибутов. Затем тем же приемом выделите одновременно верхний эллипс и получившуюся 
боковую сторону (именно в таком порядке!) и щелкните на кнопке Quick Trim (Исключение). 
Цилиндр готов (рис. 70, б). Однако изображению явно не хватает объемности.  

4. Выберите инструмент Interactive Fill (Интерактивная заливка), а затем с помощью 
элементов панели атрибутов задайте категорию заливки Fountain Fill (Градиентная заливка) и 
тип заливки Linear Fountain Fill (Линейная градиентная заливка). Выбранному объекту будет 
назначена градиентная линейная заливка (по умолчанию она представляет собой плавный 
переход от черного цвета к белому со средней точкой в середине интервала). Выделите верхний 
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эллипс и точно так же назначьте ему градиентную заливку, только на этот раз выбрав в списке 
панели атрибутов тип Conical Fountain Fill (Коническая градиентная заливка). Теперь цилиндр 
выглядит значительно объемнее (рис. 70, в). 

 
Инструмент Interactive Fill и диалоговое окно Fountain Fill. Инструмент Interactive 

Fill (Интерактивная заливка), панель атрибутов и диалоговое окно Fountain Fill (Градиентная 
заливка) служат для управления градиентными заливками. В момент активности инструмента 
Interactive Fill (Интерактивная заливка) поверх объектов, имеющих градиентную заливку, 
выводятся управляющие схемы заливок (далее просто схемы) – совокупности элементов, 
манипулируя которыми мышью можно менять внешний вид заливки. Схемы для построенных в 
последнем упражнении заливок представлены на рис. 71. 

Основным элементом схемы любой заливки является ее направляющая – пунктирная 
линия со стрелкой, показывающая направление распространения цветового перехода (его 
градиент). В линейной, круговой и квадратной градиентных заливках направляющая 
прямолинейна, в конической она представляет собой половину окружности и радиус. Форму 
направляющей нельзя изменить, не меняя типа градиентной заливки. Размеры и направление 
направляющей меняются путем перетаскивания мышью расположенных на ее концах 
начальной и конечной управляющих точек. 

Управляющие точки градиентной заливки представляют собой квадратики, 
расположенные на направляющей градиентной заливки. Их цвет определяет цвет градиентной 
заливки в том месте цветового перехода, где расположена управляющая точка. На 
управляющей схеме любой градиентной заливки имеются минимум две управляющие точки, 
расположенные на ее краях. В стандартных градиентных заливках имеются только крайние 
управляющие точки, а на направляющей имеется еще один управляющий элемент – ползунок 
средней точки цветового перехода. Перетаскивая его по направляющей, можно управлять 
скоростью изменения цвета. Ползунок отмечает точку, в которой компоненты цвета состоят из 
равных долей компонентов граничных цветов перехода. 

 

Рисунок 71 – Схемы линейной и конической стандартных градиентных заливок и их элементы 
 

При выделении управляющей точки обозначающий ее на управляющей схеме квадратик 
обводится дополнительной линией. 

Если на направляющей между крайними управляющими точками появляются 
дополнительные управляющие точки, такая градиентная заливка называется заказной. В 
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заказной заливке ползунок средней точки отсутствует (об этом – чуть позже). Чтобы добавить в 
схему новую управляющую точку, достаточно перетащить мышью на направляющую образец 
цвета с экранной палитры. Следует обратить внимание на то, что отпускать кнопку мыши при 
перетаскивании следует, только когда указатель мыши окажется на направляющей. В 
противном случае градиентная заливка будет замещена однородной и придется отменять 
последнее действие. Дополнительные управляющие точки можно перетаскивать вдоль 
направляющей, меняя схему цветового перехода, а если возникнет необходимость удалить 
такую точку, на ней достаточно щелкнуть правой кнопкой мыши. 

Всего на направляющей можно разместить до 99 управляющих точек – более чем 
достаточно даже для создания самого сложного цветового перехода. 

Для простых операций с градиентными заливками возможностей инструмента Interactive 
Fill (Интерактивная заливка) и управляющей схемы более чем достаточно, но точную настройку 
с их помощью провести трудно. Дополнительные возможности для этого дают панель 
атрибутов и диалоговое окно Interactive Fill (Интерактивная заливка), показанные на рис. 72 
(предполагается, что выделен объект со стандартной линейной градиентной заливкой). 

 

Рисунок 72 – Вид панели атрибутов и диалогового окна Fountain Fill 
для стандартной линейной градиентной заливки 
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Элементы панели атрибутов и диалогового окна позволяют менять атрибуты 

градиентных заливок.  
- Кнопка панели атрибутов Edit Fill (Редактирование заливки) позволяет открыть 

диалоговое окно редактирования градиентной заливки.  
- Раскрывающийся список Fill Type (Тип заливки) панели атрибутов предназначен для 

выбора типа градиентной заливки, переключая линейную, радиальную, коническую и 
квадратную схемы перехода. 

- Раскрывающиеся списки начального и конечного цветов перехода на панели атрибутов 
и в диалоговом окне управляют цветом перехода в конечных точках, позволяя назначать цвета 
без помощи экранных палитр (выбором в списке или в диалоговом окне выбора цвета, 
аналогичном окну однородной заливки). 

- Ползунок на панели инструментов и счетчик Mid-point (Средняя точка) в диалоговом 
окне управляют положением средней точки цветового перехода в стандартных градиентных 
заливках. 

- Счетчик на панели атрибутов и счетчик Angle (Угол) в диалоговом окне управляют 
углом наклона направляющей (в конической заливке – направлением ее радиуса со стрелкой) к 
горизонту. 

- Счетчик на панели атрибутов и счетчик Edge pad (Край) в диалоговом окне управляют 
расстоянием от управляющих точек, на протяжении которого начальный и конечный цвета 
стандартной заливки не меняются. Значения задаются в процентном отношении к длине 
перехода и не могут превышать 49 (в этом случае зона плавного перехода цветов составляет 
всего 2 % от общей длины направляющей градиентной заливки). 

- Счетчик на панели атрибутов и счетчик Steps (Градаций) в диалоговом окне управляют 
количеством промежуточных цветовых градаций в переходе. По умолчанию таких градаций 
строится 256, но можно заказать меньшее их число – для этого необходимо выключить 
блокировку кнопкой с изображением замка и установить другое значение в счетчике. Это 
позволяет существенно уменьшить размер файла при экспорте в точечные форматы графики 
(например, при подготовке изображений для web-страниц, на которых тонкие цветовые нюансы 
все равно не воспроизвести). 

- Переключатели Two color/Custom (Стандартная/Заказная) в диалоговом окне служат 
для выбора стандартного или заказного режима работы с градиентной заливкой. Если 
установить переключатель Custom (Заказная), то вид диалогового окна Fountain Fill 
(Градиентная заливка) изменится. Вместо элементов управления начальным и конечным 
цветами появится схема цветового перехода (рампа), а вместо цветового круга – палитра (рис. 
73). В таком варианте диалогового окна создаются и настраиваются заказные градиентные 
заливки.  

- Список Presets (Заготовки) в диалоговом окне позволяет пользоваться несколькими 
заранее подготовленными схемами заказных градиентных заливок – заготовками. CorelDRAW 
обеспечивает возможность пополнять их набор и исключать из него ставшие ненужными 
заливки. Чтобы воспользоваться одной из этих заготовок, раскройте список и выберите 
нужную. Строка списка по умолчанию пуста, так что вы можете ввести собственное 
наименование для созданной заливки и сохранить ее – для этого достаточно щелкнуть на 
кнопке со знаком «плюс». 

- В правой верхней части диалогового окна Fountain Fill (Градиентная заливка) 
находится область предварительного просмотра градиентной заливки. Щелчком в этой области 
можно сместить центр радиальной, конической и квадратной градиентных заливок, а, 
перетаскивая в ней мышь, – менять угол наклона направляющей заливки. 
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- В правой средней части диалогового окна расположены цветовой круг и три кнопки. 
Они позволяют управлять процессом выбора направления перехода цветов в градиентной 
заливке. Верхняя кнопка, Straight Path (По прямой), задает переход одного цвета в другой вдоль 
прямой линии, соединяющей эти цвета на цветовом круге. Например, если строится переход 
красного цвета в синий, этот переход будет состоять из исходных красного и синего цветов и 
набора промежуточных оттенков красного и синего.  

 

Рисунок 73 – Диалоговое окно Fountain Fill в режиме работы с заказной заливкой 
 

Вторая кнопка, Counterclockwise Path (Против часовой), задает переход цветов по дуге 
спирали в направлении против часовой стрелки. Если использовать тот же пример, то в состав 
градиентной заливки войдут следующие цвета: чистые красный и синий, а также оттенки 
оранжевого, желтого и зеленого, так как именно через эти цвета пройдет путь от красного к 
синему по дуге цветового круга в направлении против часовой стрелки. На цветовом круге 
траектория перехода цвета изображается в виде темной линии/  

Третья кнопка – Clockwise Path (По часовой). Если она нажата, то цветами, которые 
составят переход в рассмотренном ранее примере, будут чистые красный и синий, а также 
оттенки синего, сиреневого и розового 

 
Упражнение З. Изображение неба и земли 

1.  Откройте ранее сохраненный файл Sunset.cdr, в котором находится изображение 
пейзажа. 

2.  Выберите инструмент Interactive Fill (Интерактивная заливка) и перетащите 
указатель мыши от нижней части неба до верхней. Это назначит объекту стандартную 
двухцветную градиентную заливку с установками управляющих параметров по умолчанию. 
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Эти установки предполагают плавный цветовой переход от исходного цвета заливки объекта к 
сплошному белому.  

3.  Перетащите пурпурный цвет из соответствующего образца палитры и отпустите 
кнопку мыши, когда указатель будет находиться на пунктирной направляющей несколько выше 
начальной управляющей точки в схеме линейной градиентной заливки. Как видите, прием 
перетаскивания цвета годится не только для однородных заливок. Теперь перетащите 
оранжевый цвет и отпустите кнопку мыши прямо над пурпурным. Продолжайте создавать 
дополнительные управляющие точки, пока не получится цветовой переход от пурпурного через 
оранжевый, желтый и голубой к конечному черному. Должно получиться нечто больше 
похожее на закатное небо. 

4.  Теперь надо поместить на небо две-три звезды. Звезду построим отдельно, снизу от 
основного пейзажа. Ее роль сыграет квадрат с квадратной градиентной заливкой – ее четыре 
луча очень похожи на мерцание звезды. Итак, строим квадрат с помощью инструмента 
Rectangle (Прямоугольник) при нажатой клавише Ctrl, затем выбираем инструмент Interactive 
Fill (Интерактивная заливка), а на панели атрибутов выбираем градиентную заливку типа 
Square Fill (Квадратная заливка). Выберите инструмент Pick (Выбор) и уменьшите звезду до 
желаемого размера, перетаскивая внутрь любой угловой маркер ее рамки выделения. 
Перетащите звезду на небо, поближе к верхнему краю. Если одной звезды недостаточно, 
перетащите звезду на новое место, но перед отпусканием левой кнопки мыши не забудьте 
щелкнуть правой кнопкой – будет создана копия.  

5.  Чтобы замаскировать «квадратность» наших звезд, которую можно заметить на фоне 
градиентной линейной заливки неба, сделаем часть неба со звездами целиком черной. Для этого 
выделите небо, затем выберите инструмент Interactive Fill (Интерактивная заливка) и 
перетащите на направляющую пунктирную линию схемы заливки еще одну черную 
управляющую точку, разместив ее выше всех цветных управляющих точек. Перетаскивая 
новую управляющую точку вдоль направляющей, добейтесь, чтобы черный фон звезд не был 
виден на фоне неба (рис. 74). 

 

Рисунок 74 – Закатное небо над холмами 
 

6.  Выберите инструмент Pick (Выбор) и выделите объект, изображающий землю. 
Вернитесь к инструменту Interactive Fill (Интерактивная заливка) и задайте цветную 
градиентную заливку земли с переходом от светлого к темному коричневому цвету. Теперь наш 
закатный пейзаж готов. Снова сохраните на диске файл Sunset.cdr. 

7.  Попробуем переделать вечерний пейзаж в ночной. Начнем со светила. Превратить 
солнце в луну нам поможет радиальная градиентная заливка. Чтобы было удобнее работать, 
выберите инструмент Zoom (Масштаб) и растяните им вокруг круга, изображающего солнце, 
прямоугольник со стороной раза в два больше его диаметра. Выделите круг, затем выберите 
инструмент Interactive Fill (Интерактивная заливка), а на панели атрибутов задайте категорию 
заливки Fountain Fill (Градиентная заливка) и тип Radial Fountain Fill (Радиальная градиентная 
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заливка). Солнце в центре раскалилось добела, но на луну пока не похоже. Придется поработать 
со схемой градиентной заливки. 

8.  Для начала сменим цвет крайних управляющих точек схемы градиентной заливки. В 
начальную точку перетащите черный образец с экранной палитры, а на конечную – белый. 
Затем перетащите начальную точку чуть правее и ниже бывшего солнца, а конечную – вниз и 
вправо по отношению к центру. На направляющей пунктирной линии схемы надо разместить 
еще две управляющие точки: чуть ближе к начальной – черную, чуть ближе к конечной – 
белую. Должно получиться что-то похожее на рис. 75. 
 

 
 

Рисунок 75 – Схема заказной градиентной радиальной заливки месяца (вторая черная 
управляющая точка практически полностью перекрыта белой управляющей точкой) 

 
9.  Чтобы вогнутый край месяца получился достаточно резким, средние управляющие 

точки должны располагаться очень близко друг к другу, но черная обязательно должна быть 
ближе к центру, чем белая. Выполнить такой трюк мышью сложно, да и ни к чему – это можно 
со всеми удобствами проделать при помощи диалогового окна Fountain Fill (Градиентная 
заливка). Откройте его, щелкнув на второй слева кнопке панели инструмента Fill (Заливка), 
затем щелкните на правом среднем треугольнике над схемой градиентной заливки, запомните 
значение в счетчике Position (Позиция), щелкните на левом среднем треугольнике над схемой 
градиентной заливки и установите в счетчике значение на 1-2 % меньше запомненного (см. рис. 
73). После щелчка на кнопке ОК месяц должен принять достойный внешний вид. 

10.  Для имитации ночного неба снова воспользуемся заказной цветной градиентной 
заливкой, построив ее с помощью диалогового окна Fountain Fill (Градиентная заливка), – когда 
дело доходит до более тонкой настройки управляющих параметров и схемы цветовых 
переходов, с ним работать удобнее, чем со схемами заливок. Выделите объект, изображающий 
небо, и откройте диалоговое окно, нажав клавишу F11. Задайте следующую схему цветового 
перехода: от пурпурного к голубому, затем – к синему (100 % Cyan + 100 % Magenta) и 
черному. 

Чтобы в конце цветового перехода небо не выглядело просто серым, черный цвет в 
конечной управляющей точке должен содержать в себе хроматические компоненты, 
составляющие предыдущий цвет в переходе, – тогда переход получится плавным. Для этого 
выделите конечную черную управляющую точку цветового перехода, щелкните на кнопке 
Current (Текущий), затем – на кнопке Others (Другие), открывающей диалоговое окно, 
аналогичное окну Uniform Fill (Однородная заливка). В этом окне следует, воспользовавшись 
моделью цвета CMYK, добавить пурпурный и голубой к черному цвету. Это сделает 
градиентную заливку более плавной. 

11.  Измените схему цветового перехода в градиентной заливке земли: от светло-
зеленого к черному с зеленым цветом средней интенсивности посредине. Снова для построения 
более плавного цветового перехода может потребоваться регулировка цветовых составляющих 
в управляющих точках. Как правило, для сглаживания достаточно определить процентное 
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содержание базовых цветов в точке, предшествующей черной, а затем добавить те же базовые 
цвета в той же пропорции в черной управляющей точке. В изображении гор замените оттенки 
серого оттенками зеленого, при желании добавьте еще несколько звезд. Сохраните его на диске 
под именем night.cdr. Результат работы представлен на рис. 76. 

 

Рисунок 76 – Пейзаж в ночном варианте 

4.5. Сетчатые заливки 
Можно считать, что при назначении сетчатой заливки объекту произвольной формы на 

него накладывается сетка, имеющая заранее заданное число «строк» и «столбцов». Сетка 
состоит из узлов, соединенных линиями. Линии очень похожи на обычные кривые CorelDRAW, 
но узлы, находящиеся в местах пересечения вертикальных и горизонтальных линий, соединены 
друг с другом, и их нельзя перемещать по отдельности – только вместе. Так что в зависимости 
от того, в каком месте сетки расположен узел – посредине, с краю или в углу, – из него могут 
выходить четыре, три или два сегмента линии, и, соответственно, при выборе узла на экране 
появляются четыре, три или две направляющие точки. Перетаскивая узлы сетки и манипулируя 
направляющими точками, можно придавать ячейкам сетки произвольную форму. Это 
необходимо для последующего задания согласованной группы цветовых переходов, каждый из 
которых эквивалентен градиентной заливке. Каждой паре узлов, соединенных сегментом сетки, 
соответствует такой переход, причем плавная смена цвета происходит вдоль сегмента. А 
поскольку каждому узлу может быть назначен свой цвет, результат получается весьма 
впечатляющим. Более того, каждый такой элементарный переход может быть превращен из 
стандартной градиентной заливки в заказную, поскольку двойным щелчком мыши на сегментах 
можно размещать дополнительные узлы, играющие роль управляющих точек. На рис. 77 
представлена простейшая сетчатая заливка, примененная к квадрату. В сетке перемещено 
четыре узла, а затем для шести узлов, лежащих на границе, был назначен цвет 
(перетаскиванием с экранной палитры). Остальные узлы приняли цвет однородной заливки, 
назначенный для объекта до применения сетчатой заливки. 

 

Рисунок 77 – Сетчатая заливка 
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В середине виден выделенный узел с выходящими из него линиями сетки, обозначенными 
направляющими точками (размеры узлов и направляющих точек несколько увеличены) 
 
Упражнение 4. Изображение облаков 
 

1. Откройте сохраненный ранее файл sunset.cdr. Начнем с изображения абриса облака. В 
качестве такового сгодится практически любая замкнутая кривая, построенная инструментом 
Bezier (Кривая Безье). Однако, необходимо сделать ее вытянутой в ширину. Отмените обводку 
облака, щелкнув правой кнопкой мыши на перечеркнутом образце цвета экранной палитры. Для 
заливки облака выберите чистый белый цвет. 

2. Выберите на панели инструмента Interactive Fill (Интерактивная заливка) инструмент 
Mesh Fill (Сетчатая заливка). На объекте, изображающем облако, появится сетка (по умолчанию 
– 3x3 ячейки, чего для этого упражнения вполне достаточно). Попробуйте откорректировать 
форму облака, перетаскивая мышью узлы, расположенные на абрисе облака. В результате 
должно получиться что-то похожее на рис. 78. 

Обратите внимание, что при работе инструмент Mesh Fill (Сетчатая заливка) ведет себя в 
точности как инструмент Shape (Форма) – кстати, при этом действительно изменяется форма 
кривой, и если впоследствии сетчатую заливку убрать, эти изменения сохранятся. 

 

 

Рисунок 78 – Сетчатая заливка облака 
 

3. Теперь раскрасьте узлы в верхней части облака через один в легкие оттенки серого 
цвета, а в нижней части – в нежные оттенки розового, получится довольно похоже на облако, 
подсвеченное снизу заходящим солнцем. Чтобы назначить цвет узлу сетчатой заливки, 
достаточно выделить его щелчком инструментом Mesh Fill (Сетчатая заливка), а затем 
щелкнуть на образце экранной палитры с нужным цветом. 

Не забывайте о возможности получить доступ ко вторичной палитре оттенков 
выбранного цвета. Для этого нужно удерживать кнопку мыши в нажатом состоянии на образце 
экранной палитры чуть дольше обычного. 

4. После того как форма и расцветка облака приобретут завершенность, выберите 
инструмент Pick (Выбор) и перетаскиванием маркеров рамки выделения придайте облаку 
желаемые размеры, а затем переместите его на место. Второе облако – просто копия первого. 
Впрочем, скрыть это очень легко: достаточно перетащить инструментом Mesh Fill (Сетчатая 
заливка) несколько узлов на абрисе облака на новое место и задать новые оттенки в некоторых 
узлах сетки. Результат работы представлен на рис. 79. Сохраните пейзаж в новом файле под 
другим именем – ss&douds.cdr. 
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Рисунок 79 – Результат работы 
 

На рис. 80 представлена панель атрибутов при активном инструменте Mesh Fill 
(Сетчатая заливка). 

С помощью расположенных на панели атрибутов элементов управления можно 
воздействовать на сетку, лежащую в основе сетчатой заливки. 

- Счетчики числа строк и столбцов ячеек позволяют определять размерность сетки. 
Максимальное значение, которое можно установить в этих счетчиках, – 50.  

 

Рисунок 80 – Панель атрибутов при работе с сетчатой заливкой 
 

- Кнопки добавления и удаления узла позволяют изменять структуру сетки теми же 
приемами, что при редактировании кривой с помощью инструмента Shape (Форма). Однако 
имеются некоторые особенности. В частности, при удалении краевого узла удаляются не только 
примыкающий к нему сегмент сетки, но и вся линия, разделяющая строки или столбцы ячеек 
сетки (рис. 81). 

 

Рисунок 81 – Сетка до (слева) и после (справа) удаления краевого узла 

При удалении внутреннего узла сетки, в котором пересекаются две ее линии, вместе с 
ним сразу удаляются обе линии. 
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- Кнопки преобразования сегментов в прямолинейный и криволинейный позволяют 
выполнять преобразование примыкающих к выделенным узлам сегментов – точно так же, как 
при редактировании кривых инструментом Shape (Форма). 

- Кнопки преобразования типа узла позволяют преобразовывать тип выбранного узла, 
изменяя поведение связанных с ним направляющих точек при редактировании узла. 

- Ползунок сглаженности кривой позволяет влиять на степень плавности кривых, 
проходящих через узлы сетки. 

- Кнопка копирования атрибутов сетчатой заливки позволяет перенести ранее 
построенную сетчатую заливку на выделенный объект. 

- Кнопка отмены сетчатой заливки отменяет сетчатую заливку и восстанавливает ранее 
заданную заливку объекта.  

Независимо от класса объекта, для которого была назначена сетчатая заливка, он 
автоматически преобразуется в объект специального класса – Mesh fill (Сетчатая заливка). При 
отмене заливки исходный объект не восстанавливается, восстанавливается только форма его 
контура в виде замкнутой кривой. 

4.6. Заливки узором 
Заливки узором – это категория декоративных заливок, в которых используются заранее 

сделанные заготовки. Основой таких заготовок служит раппорт – фрагмент изображения, 
многократным тиражированием которого и образуется заливка. Раппорт представляет собой 
квадрат с самосовмешающимся изображением. Это означает, что при составлении двух 
раппортов в ряд по горизонтали или вертикали обрезанные краем раппорта части изображения 
совместятся. 

В зависимости от характера изображения, составляющего раппорт, заливки узором 
(возможно, их было бы правильнее назвать орнаментальными заливками) подразделяются на 
три категории: двухцветные, цветные (или полноцветные) и точечные. Две первые 
применяются практически одинаковыми способами за одним исключением – в двухцветных 
заливках выделяют цвет переднего плана и цвет фона, и этим ограничивается вся палитра 
раппорта. Двухцветные и точечные заливки представляют собой точечные узоры, то есть их 
преобразование неизбежно влечет за собой некоторую утрату качества изображения. Заливки 
многоцветным узором строятся на основе векторных изображении, и их преобразования не 
приводят к искажениям. Сказанное относится только к простейшим преобразованиям 
(масштабированию, скосу, повороту). Рассматриваемые далее более мощные и универсальные 
преобразования (перспектива, огибающие, линзы), воздействуя на форму объекта с заливкой 
узором, не оказывают влияния на узор заливки. 

В CorelDRAW предусмотрено два механизма задания заливок узором: с помощью 
инструмента Interactive Fill (Интерактивная заливка) и панели атрибутов (универсальной для 
всех заливок) и с помощью специальных диалоговых окон, специфических для каждой 
категории заливок узором.  

 
Заливка двухцветным узором. Чтобы назначить выделенному объекту или нескольким 

объектам заливку двухцветным узором, следует выполнить описанную ниже процедуру. 
1. Выберите инструмент Interactive Fill (Интерактивная заливка). 
2. На панели атрибутов, показанной на рис. 82, установите категорию заливки Pattern 

Fill (Заливка узором) и выберите в раскрывающемся списке альтернативу 2-Color 
(Двухцветная). 

3. В раскрывающемся списке выбора начальной заливки выберите необходимый узор. 
4. С помощью раскрывающихся списков основного и фонового цветов выберите пару 

цветов, в которых будет воспроизводиться заливка. 
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5. Используя кнопки или счетчики задания размеров плитки узора, установите величину 
раппорта (левая кнопка соответствует маленькой плитке, средняя – средней, правая – большой). 

В результате выделенные объекты получат заказанную заливку (вроде той, что 
изображена на рис. 82 на левом верхнем образце). Поверх заливки отображается схема заливки, 
состоящая из четырех маркеров и пунктирного четырехугольника, размеры которого 
соответствуют плитке узора (раппорту). Перетаскивая расположенный в центре ромбовидный 
маркер инструментом Interactive Fill (Интерактивная заливка) можно сместить начальную точку 
заливки по отношению к объекту. Перетаскивание квадратных черного и белого маркеров 
позволяет масштабировать и скашивать пунктирную рамку схемы, искажая форму плитки 
узора. Перетаскивая маркер в форме кружка, можно разворачивать схему заливки, меняя 
ориентацию узора по отношению к объекту с заливкой. 

Работать со схемой заливки узором удобнее при увеличенном масштабе изображения. 
Кнопка преобразования заливки с объектом управляет поведением заливки при 

некоторых преобразованниях объекта. Если режим преобразования с объектом выключен, то 
повороты объекта, его масштабирование и скос не оказывают влияния на ориентацию и 
рисунок плиток заливки.  

 

Рисунок 82 – Заливки двухцветным узором и средства управления ими 
 

Более сложные преобразования (оболочки линзы, перспектива, интерактивное 
искажение) не влияют на форму заливки узором вне зависимости от состояния режима 
преобразования вместе с объектом. 
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Кнопка Mirror Fill Tiles (Зеркальный переворот плиток) позволяет вместо каждой второй 
плитки узора вставлять ее зеркальное отражение вокруг вертикальной оси. Если требуется 
более точная настройка размеров раппорта и размещения узора по отношению к объекту, 
можно воспользоваться диалоговым окном Pattern Fill (Заливка узором). 

В диалоговом окне имеются следующие группы элементов управления.  
- Группа из трех переключателей позволяет выбрать тип заливки: 2-color (Двухцветный 

узор), Full color (Многоцветный узор), Bitmap (Точечное изображение). 
- Раскрывающийся список обеспечивает доступ к палитре образцов точечных заливок, 

предназначенной для выбора рисунка заливки. 
- Раскрывающиеся списки Front (Основной) и Back (Фоновый) служат для выбора цветов 

узора. 
- Кнопки Load (Загрузить), Delete (Удалить) и Create (Создать) предназначены для 

работы с пользовательскими заливками. Щелчок на кнопке Create (Создать) раскрывает 
диалоговое окно Pattern Editor (Редактор узоров), с помощью которого можно построить 
точечное изображение для дальнейшего использования в качестве раппорта. Щелчком на 
кнопке Delete (Удалить) текущий образец заливки удаляется с палитры образцов. Кнопка Load 
(Загрузить) позволяет импортировать образцы заливок из внешнего файла. 

- Счетчики группы Origin (Привязка) задают смещение левого нижнего угла раппорта по 
отношению к левому нижнему углу рамки выделения объекта. 

- Счетчики группы Size (Размер) устанавливают размер плитки узора. 
- Счетчики группы Transform (Преобразование) содержат управляющие параметры 

преобразований, применяемых к плитке узора: Skew (Скос) и Rotate (Поворот). 
- Последняя группа элементов управления диалогового окна управляет смещением 

четных строк или столбцов плиток по отношению к нечетным строкам или столбцам. Группа из 
двух переключателей Row (Строки) и Column (Столбцы) позволяет выбирать смещаемые 
фрагменты заливки. Счетчик дает возможность указать, на какую часть длины стороны 
раппорта будут смещаться плитки по отношению к соседним. В приведенном на рис. 82 
верхнем правом образце точечной заливки задано смещение четных столбцов на 50 % длины 
раппорта. 

- Флажок Transform fill with object (Преобразовывать с объектом) функционально 
аналогичен соответствующей кнопке на панели атрибутов (см. рис. 82). 

- Флажок Mirror Fill (Зеркальное отражение) функционально аналогичен 
соответствующей кнопке на панели атрибутов (см. рис. 82). 

В CorelDRAW имеется возможность преобразовать в узор для заливки любой ранее 
построенный фрагмент изображения. После щелчка на кнопке Select Pattern (Выбрать узор) и 
установки в промежуточном диалоговом окне значений атрибутов заливки (цветная или 
двухцветная, степень разрешения при преобразовании изображения в точечный рисунок 
раппорта) остается перетащить указатель мыши по диагонали прямоугольника, обозначающего 
границы создаваемого раппорта, и узор будет создан, добавлен в список выбора узоров и 
назначен выделенному объекту 

 
Упражнение 5. Имитация кирпичной кладки 
 

Изобразите штабель кирпичей, показанный на рис. 83. 
1. Начните с построения прямоугольника произвольного размера, а затем с помощью 

панели атрибутов установите размеры его сторон равными 50 и 25 мм. Далее с помощью 
диалогового окна Pattern Fill (Заливка узором) назначьте ему заливку двухцветным 
«кирпичным» узором, задав размер раппорта 5 мм и установив флажок Transform fill with object 
(Преобразовывать с объектом). 
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Рисунок 83 – Штабель кирпичей – пример заливки двухцветным узором 
 

2. Два раза скопируйте прямоугольник, перетащите на свободное место копии и 
приступайте к сборке развертки «штабеля». Включите режим привязки к объектам командой 
View > Snap To Objects (Вид > Привязать к объектам). С помощью панели атрибутов 
уменьшите вдвое ширину одного из прямоугольников (он будет изображать левую грань 
штабеля) и переместите его так, чтобы совместить правой стороной с левой стороной передней 
грани. Затем, перетаскивая оставшийся прямоугольник, совместите его нижнюю сторону с 
верхней стороной передней грани (рис. 84). 
 

 
 

Рисунок 84 – Развертка параллелепипеда 
 

3.  Установите вертикальную направляющую, перетащив ее с вертикальной 
координатной линейки до совмещения с левым краем левой грани. Щелкните два раза мышью 
на передней грани, чтобы появились стрелки скоса. Удерживая нажатой клавишу Ctrl, 
перетащите вниз левые стрелки скоса, доведя скос до 15°. 

Выполните скос левой грани на тот же угол, но теперь следует перетаскивать правые 
стрелки скоса. Верхние стрелки скоса верхней грани следует перетаскивать влево до 
совмещения угла верхней грани с вертикальной направляющей (рис. 85). Обратите внимание на 
то, как вместе с формой граней искажается рисунок заливки. 

4. Остается только снова совместить грани. Выделите левую грань и при нажатой 
клавише Ctrl сместите ее вниз до совмещения с передней гранью. Затем два раза щелкните 
мышью на верхней грани и, перетаскивая левые стрелки скоса, совместите ее длинную сторону 
с длинной стороной передней грани. Два раза щелкните на левой грани и, перетаскивая левые 
стрелки скоса, устраните оставшийся «зазор». 
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Рисунок 85 – Грани параллелепипеда готовы к окончательному совмещению 
 

Отметим, что таким образом можно «виртуально склеить» развертку прямоугольной 
коробки, на гранях которой может быть не только заливка узором, но и любые векторные 
изображения. Конечно, получится далеко не аксонометрическое изображение, но все же оно 
даст более наглядное представление о том, как будет выглядеть, например, упаковочная 
коробка для нового товара, чем развертка той же коробки. 

 
Заливка цветным узором. Работа с заливками цветным узором почти не отличается от 

работы с заливками двухцветным узором. Все различия обусловлены отсутствием выделенных 
цветов – основного и фонового. Средства управления заливками многоцветным узором 
представлены на рис. 86 там же приведены и образцы таких заливок, полученные 
преобразованием одного из стандартных образцов узора. 

 

Рисунок 86 – Заливки многоцветным узором и средства управления ими  
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Заливка точечным узором. Заливки точечным узором применяются теми же 

способами, что и описанные выше заливки двухцветным и многоцветным узорами. Они 
отличаются от заливок многоцветными узорами тем, что в качестве раппорта применяется не 
векторное, а точечное изображение, что влечет за собой проблемы при масштабировании и 
преобразовании объектов. Средства управления заливками точечным узором представлены на 
рис. 87. 

 

Рисунок 87 – Заливки точечным узором и средства управления ими 
 

Заливка растром PostScript. PostScript© – название языка, разработанного фирмой 
Adobe™ для описания объектов векторной графики. Существует большое количество 
программных средств, ориентированных на работу с графикой, представленной в формате этого 
языка, но не это главная причина его широчайшего распространения. Дело в том, что очень 
много моделей высококачественных воспроизводящих устройств (принтеров, фотонаборных 
автоматов, графопостроителей) имеют в своем составе встроенные средства интерпретации 
языка PostScript. 

В состав PostScript входит около сотни различных узоров для заливки объектов, каждый 
из которых имеет собственное название. Эти узоры представляют собой монохромные и 
цветные векторные изображения, строящиеся непосредственно перед выводом на печать 
каждый по своей математической модели. У каждого из узоров имеется несколько 
управляющих параметров, меняя которые можно существенно влиять на внешний вид заливки. 

В отличие от ранее рассмотренных вариантов заливки узорами, в заливке узором 
PostScript не выделяются отдельные плитки и нет возможности влиять на размеры и 
ориентацию раппорта. В этом смысле их изобразительные возможности несколько уже. 

На рис. 88 представлены средства управления заливками узором PostScript и четыре 
варианта такой заливки, полученные изменением управляющих параметров заливки под 
названием Basketweave (Корзиночное переплетение). 

При работе с заливками узором PostScript следует иметь в виду несколько особенностей.  
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Так же как и остальные категории заливок, заливка узором PostScript назначается либо с 
помощью панели атрибутов, появляющейся на экране после выбора инструмента Interactive Fill 
(Интерактивная заливка), либо с помощью диалогового окна PostScript Texture (Узор 
PostScript), открывающегося щелчком на специальной кнопке панели инструмента Fill 
(Заливка). 

 

Рисунок 88 – Заливки узором PostScript и средства управления ими 
 

Корректировать управляющие параметры узора можно только средствами диалогового 
окна PostScript Texture (Узор PostScript). Чтобы результаты изменения параметров отражались в 
области предварительного просмотра заливки в диалоговом окне, следует установить флажок 
Preview Fill (Предварительный просмотр заливки) и после изменения параметров щелкнуть на 
кнопке Refresh (Обновить). 

В качестве упражнения постройте на странице несколько прямоугольников, задайте для 
них одинаковую заливку PostScript, а затем для каждого из прямоугольников измените в два 
раза значение одного из управляющих параметров узора. 

 
Текстурные заливки. Текстурные заливки представляют собой особый вид точечных 

изображений, которые не формируются из заранее заготовленных и сохраненных раппортов, а 
подобно заливкам узорами PostScript при каждом использовании создаются заново путем 
расчета по математической модели. Это не означает, что у текстурных заливок, как и у заливок 
PostScript, отсутствуют плитки с повторяющимся узором. Такие плитки имеются, но рисунок на 
них создается динамически, а не хранится на диске.  

Основным параметром каждой из моделей, по которым строится изображение, является 
номер текстуры. Построение изображений по одной модели, но с разными номерами текстур 
дает значительно различающиеся результаты. И наоборот, если прочие управляющие 
параметры модели не меняются, то, построив два изображения по одной модели с одним 
номером текстуры, мы получим одинаковые результаты. 

Как и остальные заливки, текстурные заливки в CorelDRAW могут назначаться двумя 
способами: с помощью инструмента Interactive Fill (Интерактивная заливка) в паре с панелью 
атрибутов и с помощью диалогового окна Texture Fill (Текстурная заливка).  
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Упражнение 6. Выполнение текстурной заливки 
 

1. С помощью инструмента Ellipse (Эллипс) постройте на странице окружность (не 
забудьте удерживать нажатой клавишу Ctrl, чтобы окружность получилась правильной). 

2. Не отменяя выделения только что построенной окружности, выберите в наборе 
инструментов инструмент Interactive Fill (Интерактивная заливка) и раскройте список выбора 
начальной заливки на панели атрибутов (рис. 89). Подберите в нем понравившуюся вам 
текстуру и щелкните на ее образце. Обратите внимание, что поверх текстуры, заполнившей 
выделенный объект, отображается схема заливки. Попробуйте перетаскивать ее маркеры 
мышью и убедитесь, что функциональность схемы та же, что у заливок узором. Попробуйте 
выбрать на панели атрибутов другую текстуру, предварительно выбрав другую библиотеку 
текстур. 

 

Рисунок 89 – Панель атрибутов при работе с текстурными заливками и схема текстурной заливки 
 

3. На панели инструмента Fill (Заливка) щелкните на кнопке текстурной заливки. На 
экране появится диалоговое окно Texture Fill (Текстурная заливка), содержащее элементы 
управления более тонкой настройкой текстурной заливки (рис. 90). 

4. Ознакомьтесь с элементами управления диалогового окна Texture Fill (Текстурная 
заливка). В его левой верхней части располагаются раскрывающийся список с названиями 
библиотек текстур, ниже него – список названий текстур, содержащихся в текущей библиотеке 
Texture List (Список текстур). В панели атрибутов названия текстур отсутствуют, что 
затрудняет выбор нужной текстуры. 

Ниже списка текстур располагается область предварительного просмотра текстуры, 
изображение в которой обновляется каждый раз после щелчка на кнопке Preview 
(Предварительный просмотр). Кнопка Options (Режимы) открывает диалоговое окно Texture 
Options (Режимы текстур). Затем щелкните на кнопке Tiling (Плитки). Раскроется одноименное 
диалоговое окно (рис. 91). 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 76

 

 

Рисунок 90 – Диалоговое окно Texture Fill 

 

Рисунок 91 – Диалоговое окно Tiling 
 

5. Элементы этого окна представляют собой альтернативу элементам управляющей 
схемы заливки и позволяют манипулировать плитками узора без помощи инструмента 
Interactive Fill (Интерактивная заливка) и с большей точностью. Функциональность всех 
элементов этого диалогового окна та же, что у аналогичных элементов диалогового окна Pattern 
Fill (Заливка узором), рассматривавшегося ранее. Закройте его щелчком на кнопке ОК. 

6. В правой части диалогового окна Texture Fill (Текстурная заливка) расположены 
элементы управления, задающие значения параметров модели, по которой рассчитывается узор 
текстуры. Некоторые из них, например Softness (Мягкость), Density (Плотность) и Brightness 
(Яркость), присутствуют в диалоговом окне для большинства текстур, некоторые – только для 
отдельных текстур. Обратите внимание на кнопки блокировки с изображением замка справа от 
полей каждого из параметров. По умолчанию заблокированы все параметры, кроме номера 
текстуры (соответствующие замки закрыты). Поэтому при щелчке на кнопке Preview 
(Предварительный просмотр) без предварительного изменения значений управляющих 
параметров номер текстуры изменяется случайным образом. Это очень удобно, когда нужно 
подобрать вариант одного и того же образца текстуры по внешнему виду – нет необходимости 
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менять каждый раз номер текстуры вручную. Щелчком на кнопке блокировки любого из 
параметров его можно разблокировать, разрешив изменения. После этого каждый щелчок на 
кнопке предварительного просмотра будет вести к случайному изменению всех 
разблокированных параметров (в том числе – и номера структуры). Применив описанные 
приемы подбора внешнего вида текстуры, выберите в списке библиотек альтернативу Samples 
8, а в списке текстур – Shock Wave. Измените одно или два значения управляющих параметров 
и щелкните на кнопке ОК. 

После редактирования текстуры ее можно сохранить для дальнейшего использования в 
одной из библиотек образцов текстур. Для этого щелкните на кнопке со знаком «плюс» и 
задайте в раскрывшемся диалоговом окне Save Texture As (Сохранить текстуру как) имена 
новой текстуры и библиотеки, в которой она должна сохраняться. При этом следует иметь в 
виду, что в библиотеку Styles (Стили) записывать новые текстуры нельзя. 

Как уже упоминалось, щелчок на кнопке Options (Режимы) в диалоговом окне Texture 
Fill (Текстурная заливка) или на панели атрибутов открывает диалоговое окно Texture Options 
(Режимы текстур), представленное на рис. 92. Это окно позволяет задать разрешение и 
максимальный размер плитки текстурной заливки. 

 

 
 

Рисунок 92 – Диалоговое окно Texture Options 
 

Подбор значений параметров, доступных в этом диалоговом окне, позволяет обеспечить 
достаточное качество вывода текстурных заливок на различные устройства. 

Избыточное значение, выбранное в списке Bitmap resolution (Разрешение пиксельного 
изображения), может привести к значительному замедлению работы без видимого улучшения 
ее результата. 

 

4.7. Контрольные вопросы 
1. Назовите основные типы заливок. 
2. Что такое фиксированная палитра и модель цвета? 
3. Как происходит изменение цвета заливки по умолчанию? 
4. Как происходит выбор цвета заливки в диалоговом окне Uniform Fill? 
5. Как происходит назначение цвета однородной заливки с помощью смесителей? 
6. Для чего используют инструменты Eyedropper и Paintbucket? 
7. Что относят к специальным заливкам? 
8. Для чего и как используют инструмент Interactive Fill и диалоговое окно Fountain Fill? 
9. Для чего и как используют сетчатые заливки? 
10. Что такое заливка узором? 
11. Как создать текстурную заливку? 
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ЛАБОРАТОРНАЯ РАБОТА №5 

ТЕКСТ, РАБОТА С ТЕКСТОМ 
Цель лабораторной работы: ознакомиться с атрибутами текста, шрифтами, особенностями 
работы с текстом. Получить практические навыки по форматированию текста при различных 
типах обтекания. 

5.1. Фигурный текст 
В CorelDRAW имеется два класса текстовых объектов, во многом схожих, но в то же 

время четко различимых – как по своей структуре, так и по поведению. Первый из них 
предназначен для представления текстов, относительно небольших по своему объему (до 32 000 
символов), которые могут подвергаться всем видам преобразований изображений, 
поддерживаемых в CorelDRAW. Объекты, относящиеся к этому классу, называются блоками 
фигурного текста (artistic text). Второй класс объектов позволяет отображать на рисунках 
большие текстовые фрагменты – до 32 000 абзацев, в каждом из которых может содержаться до 
32 000 символов. Такие тексты могут разделяться на отдельные структурные единицы: абзацы, 
колонки и рамки. Потенциально большой объем текста не позволяет выполнять над этими 
объектами некоторые из преобразований.  

В общем случае фигурный текст представляет собой многоуровневый соединенный 
объект. С одноуровневыми соединенными объектами мы уже сталкивались, когда 
рассматривали кривые, состоящие из нескольких не связанных друг с другом ветвей, но 
ведущие себя как единый объект. Если такой объект выделить, а затем выбрать команду 
Arrange > Break Apart (Монтаж > Разъединить), он превращается в обычные объекты. Блок 
фигурного текста (иногда для краткости его называют просто фигурным текстом) в процессе 
разъединения командой Arrange > Break Artistic Text Apart (Монтаж > Разъединить фигурный 
текст) ведет себя иначе. После первого разъединения он превращается в совокупность 
фигурных текстов, каждый из которых соответствует строке исходного фигурного текста. 
Разъединение строки дает совокупность слов, и только разъединение слова дает совокупность 
«элементарных» фигурных текстов: каждый из них разъединить уже не удастся, поскольку он 
состоит из одной найменьшей структурной единицы текста, символа. Структурная организация 
фигурного текста представлена на рис. 93. 

 

Рисунок 93 – Иерархия структурных единиц фигурного текста 
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Возможна и обратная операция соединения блока фигурного текста из ранее 

построенных блоков при помощи команды Arrange > Combine (Монтаж > Соединить). 

5.2. Атрибуты фигурного текста 
Для каждого из символов (элементарных объектов фигурного текста) определены 

следующие атрибуты. 
- Гарнитурой (font) называется рисунок символов алфавита, разработанный дизайнером 

шрифта. Каждый символ гарнитуры имеет свой номер. В стандартных текстовых гарнитурах 
рисунки отдельных символов имеют одинаковые номера, поэтому тексты, представляющиеся в 
компьютере последовательностью чисел, при форматировании различными текстовыми 
гарнитурами отображают в разных видах одни и те же буквы. Кроме стандартных текстовых 
гарнитур в CorelDRAW имеются гарнитуры графических символов, в которых тем же номерам 
соответствуют уже не буквы, а графические изображения. Перед тем как гарнитурой можно 
будет воспользоваться, она должна быть установлена в системе Windows. После этого ее имя 
появляется в раскрывающихся списках выбора гарнитур. 

- Кеглем (size) называется высота символов текста в пунктах. Иногда сочетание 
гарнитуры и кегля называют шрифтом (например, по умолчанию фигурные тексты выводятся 
шрифтом Avant Garde Bk ВТ 24 пункта). Влияние гарнитуры и кегля на внешний вид фигурного 
текста иллюстрирует рис. 94. 

 

Рисунок 94 – Влияние гарнитуры и кегля на внешний вид символов фигурного текста 
 

- Начертанием (style) называют модификацию рисунка символов текста за счет 
изменения толщины штрихов и их наклона. Стандартными начертаниями принято считать 
обычное (Normal), курсивное (Normal-Italic), полужирное (Bold) и полужирное курсивное (Bold-
Italic). Примеры начертаний представлены на рис. 95. 

 

Рисунок 95 – Стандартные начертания текста 
 

- С помощью атрибутов подчеркивания (underline), зачеркивания (strikethru) и 
надчеркивания (overscore) описывается присутствие и характер линий, подчеркивающих, 
зачеркивающих или надчеркивающих текст. Стандартными наборами линий, использующихся 
для этих целей, в CorelDRAW считаются тонкая одиночная линия (Single Thin), толстая 
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одиночная линия (Single Thick) и двойная тонкая линия (Double Thin). Для каждого из наборов 
предусмотрена модификация, позволяющая подчеркивать текст за исключением пробелов 
(соответственно Single Thin Word, Single Thick Word и Double Thin Word). На рис. 96 
представлены стандартные варианты подчеркивания. Отметим, что в CorelDRAW можно 
менять параметры стандартных наборов линий (толщину, расстояние от базовой линии текста, 
величину просвета между двойными линиями). 

 

Рисунок 96 – Стандартные варианты подчеркивания 
 

- Атрибут регистра символов (uppercase) управляет отображением символов с учетом 
преобразования регистра. Он может принимать три значения: без преобразования (None), 
капитель (Small CAPS) и капитализация (All CAPS). При включении преобразования капители 
все строчные символы имеют обычную высоту, но по рисунку совпадают с соответствующими 
прописными символами. Преобразование капитализации отображает вместо строчных 
символов их прописные аналоги в высоту прописного символа. Установка любого из значений 
атрибута не изменяет символов в самом тексте – меняется только способ их отображения. 

- Атрибут режима индекса (position) управляет преобразованием символов при 
отображении в верхние (надстрочные) или нижние (подстрочные) индексы. 

- В группу смещения символов (character shift) входят три атрибута: смещение по 
горизонтали (Horizontal), смещение по вертикали (Vertical) и смещение угловое (Rotation). 
Значения этих атрибутов задают величины смещения символов в блоке фигурного текста 
относительно их «штатного» положения. На рис. 97 в верхней строке для некоторых символов 
изменено смещение по вертикали, в средней – по горизонтали, в нижней – для одной буквы 
введены дополнительные горизонтальное и вертикальное смещения и задан поворот на 160°. 

 

Рисунок 97 – Смещение символов из исходных положений 
 

Для блока фигурного текста в целом определены следующие атрибуты.  
- Атрибут выравнивания (alignment) управляет размещением слов в пределах строк блока 

фигурного текста. Он может принимать одно из шести значений: 
1. None (Отсутствует) – слова выравниваются по левой границе блока, но, задавая 

отрицательные значения смещения по горизонтали, можно вывести отдельные символы за нее 
влево; 
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2. Left (По левому краю) – слова выравниваются по левой границе блока, если при этом 
отдельные символы смещаются влево, то вместо их вывода за левую границу блока происходит 
смещение всей остальной строки вправо; 

3. Center (По центру) – слова выравниваются так, чтобы середины всех строк блока 
совпадали с воображаемой вертикальной линией, расположенной посредине между его левой и 
правой границами; 

4. Right (По правому краю) – слова выравниваются по правой границе блока, если при 
этом отдельные символы смещаются вправо, то вместо их вывода за правую границу блока 
происходит смещение всей остальной строки влево; 

5. Full (По ширине) – слова выравниваются так, чтобы первый символ первого слова 
каждой строки совмещался с левой границей блока, а последний символ последнего слова 
строки – с правой границей блока (исключение делается только для случая, когда в последней 
строке остается единственное слово или перенесенная с предыдущей строки часть слова – тогда 
это слово или его часть выравнивается по левому краю); 

6. Force Full (Полное по ширине) – то же, что по ширине, но без каких-либо 
исключений. 

- Атрибут интерлиньяжа (line space) управляет расстоянием между смежными строками 
блока фигурного текста. Численно интерлиньяж равен расстоянию между базовыми линиями 
смежных строк текста. По умолчанию эта величина указывается в CorelDRAW в процентах от 
высоты символов выбранного шрифта. Поскольку при разработке гарнитуры в высоту 
прописных символов текста включают и свободное пространство над ними, интерлиньяж 100 % 
означает, что расстояние между строками текста соответствует замыслу художника, 
разработавшего гарнитуру. В полиграфии для мелких кеглей это расстояние чаще всего 
увеличивают до 120 %, а для крупных иногда даже уменьшают. 

- Межсловные и межсимвольные интервалы (space). В CorelDRAW имеется возможность 
принудительно изменять предусмотренные рисунком гарнитуры расстояния между смежными 
символами (Character) и между смежными словами (Word). Межсимвольное расстояние 
измеряется в процентах от ширины символа пробела использованного шрифта и по умолчанию 
равно нулю, то есть расстояния между символами в словах соответствуют предусмотренным в 
гарнитуре. Увеличение межсимвольного расстояния раздвигает символы, уменьшение – 
сближает. Такая процедура в применении к тексту в целом называется тренингом. Межсловное 
расстояние также измеряется в процентах от ширины пробела для данного шрифта, но по 
умолчанию равно 100 %. Следует помнить, что при выравнивании текста по ширине величина 
пробела переменная и, естественно, не может точно соответствовать величине межсловного 
интервала. 

5.3. Создание блока фигурного текста 
Как фигурный, так и простой текст в CorelDRAW строятся с помощью инструмента Text 

(Текст), но различными приемами. После выбора инструмента Text (Текст) панель атрибутов 
будет выглядеть так, как показано на рис. 98. 

Чтобы начать ввод блока фигурного текста, достаточно щелкнуть мышью в той точке 
страницы, где должен разместиться текст. На странице появится текстовый курсор в виде 
вертикальной черты. Если включен режим отображения непечатаемых символов, то после 
ввода первого символа нового блока с клавиатуры вслед за ним появится символ конца абзаца 
(который в блоке фигурного текста означает только перевод на следующую строку, поскольку в 
фигурном тексте абзацы не выделяются). При необходимости перехода на новую строку 
следует нажать клавишу Enter. 
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Рисунок 98 – Панель атрибутов инструмента Text 
 

Чтобы ускорить процесс ввода или при необходимости импортировать текст во вновь 
создаваемый блок фигурного текста, можно воспользоваться окном, которое раскрывается 
после щелчка на кнопке режима ввода и редактирования на панели атрибутов (рис. 99). 

 
 

Рисунок 99 – Диалоговое окно Edit Text 
 
Расположенные в верхней части этого диалогового окна элементы управления 

дублируют соответствующие элементы управления панели атрибутов и позволяют назначать 
формат тексту в процессе ввода, не закрывая диалоговое окно. Особую роль играет кнопка с 
изображенной на ней латинской буквой F – она открывает диалоговое окно Format Text 
(Форматирование текста), предоставляющее пользователю доступ ко всем средствам 
форматирования фигурного текста, в том числе отсутствующим на панели атрибутов (рис. 100). 

Вкладки диалогового окна Format Text: 
- Вкладка Character (символы) содержит следующие элементы управления атрибутами, 

определяющими внешний вид символов текста: 
• раскрывающийся список Font (Гарнитура) содержит наименования установленных в 

системе гарнитур, доступных для форматирования текста; 

Дополнительно Импортирование Форматирование 

Отображение непечатаемых символов 

Гарнитура Кегль Выравнивание Начертание 

Стиль Гарнитура Кегль 

Режим ввода и редактирования 

Отображение непечатаемых символов 

Диалоговое окно форматирования 

Выравнивание 

Подчеркивание 

Курсив 

Полужирный 
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• комбинированный список Size (Кегль) определяет высоту символов текста; 
• раскрывающийся список Style (Стиль) позволяет выбрать один из вариантов 

начертания; 
• раскрывающиеся списки Underline (Подчеркивание), Strikethru (Перечеркивание) и 

Overscore (Надчеркивание) позволяют выбрать желаемый вариант дополнения символов текста 
горизонтальными линиями; 

• раскрывающийся список Uppercase (Регистр) позволяет выбрать вариант 
преобразования символов текста при отображении в капитель или прописные; 

• раскрывающийся список Position (Положение) служит для перевода символов текста в 
верхний или нижний индекс; 

• раскрывающийся список Script (Скрипт) позволяет дополнительно корректировать 
интерлиньяж для символов языка, предусматривающего диакритические знаки (например, 
французского). 

 
 

Рисунок 100 – Вкладка Character диалогового окна Format Text 
 

- Вкладка Paragraph (Абзац) содержит группу переключателей, определяющих порядок 
размещения слов в пределах строк блока фигурного текста. Функционально эта группа 
дублирует кнопки выравнивания панели атрибутов. Здесь же расположены три счетчика, 
управляющих величиной межсимвольного (Character) и межсловного (Word) интервалов, а 
также интерлиньяжем (Line). 

Расположенные в нижней части диалогового окна Edit Text (Редактирование текста) 
кнопки раскрывают дополнительные диалоговые окна и меню. 

- Кнопка Import (Импорт) раскрывает диалоговое окно выбора текстового документа, 
содержимое которого после завершения импорта добавляется в месте расположения курсора к 
имеющемуся там блоку текста. В комплект поставки CorelDRAW входят фильтры, 
позволяющие импортировать тексты, представленные в файлах большинства существующих 
форматов. 

- Щелчок на кнопке Options (Режимы) раскрывает контекстное меню, дающее доступ к 
вспомогательным инструментам для работы с текстом, аналогичным имеющимся в любом 
достаточно развитом текстовом процессоре (рис. 101). Команда Select All (Выделить все) 
выделяет весь текст блока. Вторая группа команд позволяет исправлять ошибки выбора 
регистра символов при вводе, осуществлять контекстный поиск и замену частей текста. Третья 
группа команд раскрывает диалоговые окна проверки орфографии, проверки грамматики и 
тезауруса. Эти команды работают практически так же, как в любом текстовом процессоре. 
Четвертая группа состоит из двух команд, управляющих отображением в верхней части окна 
редактирования списка выбора гарнитур и кнопок форматирования. Последняя команда 

Гарнитура

Кегль 
Стиль 

Индекс 
Регистр 
Надчеркивание 
Перечеркивание 
Подчеркивание 
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контекстного меню дает доступ к диалоговому окну настройки параметров инструмента Text 
(Текст). 

 

Рисунок 101 – Контекстное меню вспомогательных инструментов работы с текстом 
 

Большинство приемов редактирования и форматирования текста не слишком отличаются 
от приемов работы с текстовым процессором. 

 
Упражнение 1. Ввод, редактирование и форматирование фигурного текста 
 

1. Создайте новый документ CorelDRAW. Выберите в наборе инструментов инструмент 
Text (Текст) и щелкните мышью в левом верхнем углу страницы. В месте щелчка появится 
вертикальная черточка – текстовый курсор. На панели атрибутов выберите гарнитуру, 
содержащую символы кириллицы (например, Arial), установите кегль 48 и введите с 
клавиатуры следующий текст, разделяя строки нажатием клавиши Enter:  

Жили у бабуси  
Два веселых гуся:  
Один – серый,  
Другой – белый,  
Два веселых гуся. 

2. На панели атрибутов щелкните на кнопке включения режима отображения 
непечатаемых символов и обратите внимание на то, как текст отображается на экране – вместо 
пробелов выводятся маленькие кружки на середине высоты строки, а на концах строк 
появляются символы конца абзаца. Перетащив вдоль второй строки указатель инструмента, 
выделите все ее символы, кроме двоеточия, скопируйте выделенный текст в буфер обмена с 
помощью команды Edit > Сору (Правка > Копировать) или соответствующей кнопки на 
стандартной панели инструментов, затем щелчком мыши установите текстовый курсор в конец 
последней строки. Для перехода на новую строку нажмите клавишу Enter, а потом вставьте 
содержимое буфера обмена с помощью команды Edit > Paste (Правка > Вставить) или 
соответствующей ей кнопки на стандартной панели инструментов.  

3. Теперь вставим в текст специальный символ. Установите текстовый курсор после 
слова «серый» (там появится новый символ) и откройте пристыковываемое окно Insert Character 
(Вставка символа) командой Text > Insert Character (Текст > Вставить символ). В 
раскрывающемся списке пристыковываемого окна выберите название гарнитуры – Animals 
(если эта гарнитура не установлена на вашем компьютере, ее можно найти в комплекте 
поставки CorelDRAW), а в расположенной ниже палитре найдите изображение нужного 
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символа – в данном случае, гуся (рис. 102). Перетащите это изображение мышью в пределы 
прямоугольника выделения, окружающего блок фигурного текста. После отпускания кнопки 
мыши гусь займет свое место в тексте. Чтобы черная заливка изображения не диссонировала с 
текстом, выделите вставленный символ и щелкните мышью на образце экранной палитры с 
серым цветом. 

Тем же способом в фигурный текст можно вставлять не только символы специальных 
векторных изображений. В этом случае такое изображение перетаскивается указателем 
инструмента Text (Текст) внутрь текста не из пристыковываемого окна, а непосредственно со 
страницы. Перед вставкой размеры изображения будут приведены к стандартным размерам 
символа текущего шрифта, и в дальнейшем изменения кегля текста будут влиять на высоту 
вставленного изображения. Такие изображения называются вложенными в текст. Редактировать 
их стандартными приемами CorelDRAW нельзя. 

 

Рисунок 102 – Пристыковываемое окно Insert Character и вставка символа в фигурный текст 
 

4. Точно так же вставьте в конец следующей строки еще одного гуся, выделите его и 
щелкните на белом образце экранной палитры – гусь станет белым. Перейдите в окно 
редактирования текста щелчком на соответствующей кнопке панели атрибутов (см. рис. 98). 
Выбрав команду Options > Replace Text (Режимы > Заменить текст), откройте диалоговое окно 
контекстной замены и замените все вхождения слова веселых словом нескучных, введя 
соответствующие значения в поля диалогового окна и щелкнув на кнопке Replace All (Заменить 
все). 

После выполнения этой операции вновь вставленные слова окажутся подчеркнутыми 
волнистой красной линией. Это означает, что, по мнению алгоритма проверки правописания, 
этих слов не существует. Щелкнув на любом из подчеркнутых таким образом слов, мы узнаем 
из контекстного меню, что алгоритм предлагает нам либо заменить выделенное, либо 
проигнорировать его мнение. Остановитесь на варианте, выбрав команду Ignore All 
(Игнорировать все). 

5. Выделяя отдельные произвольно выбранные части текста мышью, измените их кегли 
и гарнитуры. Проверьте, какое влияние оказывают на фигурный текст кнопки режимов 
выравнивания. Воспользуйтесь диалоговым окном форматирования для установки значения 
интерлиньяжа равным 120 % от кегля. 

6. В заключение разъедините блок фигурного текста. Поскольку этот блок нам еще 
понадобится в целом виде для следующих упражнений, подготовьте его копию: выберите 
инструмент Pick (Выбор), щелкните им на блоке фигурного текста и перетащите блок на 
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свободное место страницы. Перед тем как отпустить кнопку мыши, щелкните ее правой 
кнопкой. Обратите внимание на расположение маркеров рамки выделения (они располагаются 
по краям блока фигурного текста) и на текст в строке состояния. Выберите команду Arrange > 
Break Apart (Монтаж > Разъединить). После этого маркеры рамки деления будут охватывать 
только первую строку бывшего блока фигурного текста. Повторите операцию разъединения 
еще два раза, разбивая строку на слова, а затем – слово на отдельные символы. При этом 
каждый раз в результате разъединения будут получаться блоки фигурного текста. 

Разъединение блоков фигурного текста чаще всего приходится выполнять перед их 
преобразованием в кривые. Такое преобразование часто приводит к появлению соединенных 
кривых с огромным количеством узлов, с которыми даже мощные компьютеры справляются с 
большим трудом, не говоря уже о практически неизбежных в этом случае проблемах при 
печати. Поэтому старайтесь, чтобы в получающихся объектах было не более 400-500 узлов. 

5.4. Простой текст 
Так же как фигурный, простой текст представляет собой многоуровневый соединенный 

объект, но уровней, которые простой текст проходит при разъединении, больше, чем у 
фигурного текста. При разъединении большого объема простого текста могут получаться 
следующие структурные единицы: колонки текста, пункты перечисления, абзацы, строки, 
слова, символы. Кроме того, в отличие от фигурного текста простой текст не может 
располагаться непосредственно на печатной странице. В CorelDRAW любой простой текст 
располагается внутри особого объекта – рамки простого текста (paragraph text frame) или 
связанной цепочки таких рамок. Рамки могут соединяться при помощи связей, образуя 
составной объект – цепочку рамок простого текста, отдельные элементы которой могут 
размещаться даже на различных страницах документа CorelDRAW. Базовая форма рамки 
простого текста – прямоугольник, но в процессе последующих преобразований эти 
прямоугольники могут принимать произвольные формы (рис. 103). 

 

Рисунок 103 – Цепочка рамок простого текста. Связи рамок отображены в виде стрелок 
 

Создание и редактирование простого текста. Простой текст создается при помощи 
того же инструмента, что фигурный, а именно – инструмента Text (Текст) и создание рамки 
простого текста.  
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При вводе простого текста поведение CorelDRAW иное, чем при вводе фигурного 
текста. Во-первых, переход на новую строку определяется уже не пользователем, а 
автоматически, по мере достижения текстом правой границы рамки. Нажатие клавиши Enter 
означает переход не к следующей строке, а к следующему абзацу, который является более 
крупной структурной единицей текста, чем строка. Во-вторых, когда вводимый текст достигает 
нижней границы рамки, текстовый курсор пропадает, и вновь вводимого текста уже не видно. 
Из этого не следует, что текст не вводится – он лишь не отображается в пределах рамки. 

Из-за этих особенностей при вводе значительного объема простого текста удобнее 
пользоваться диалоговым окном Edit Text (Редактирование текста), которое открывается после 
щелчка на соответствующей кнопке панели атрибутов (см. рис. 99). 

Если для работы над изображением требуется простой текст большого объема, удобнее 
вводить его с помощью текстового процессора, а впоследствии импортировать в CorelDRAW, 
воспользовавшись кнопкой Import (Импорт) диалогового окна Edit Text (Редактирование 
текста).  

Чтобы отредактировать простой текст, можно либо щелкнуть на нем указателем 
инструмента Text (Текст), после чего внутри рамки появится текстовый курсор, либо щелкнуть 
на рамке указателем инструмента Pick (Выбор) и воспользоваться диалоговым окном Edit Text 
(Редактирование текста), раскрыв его щелчком на кнопке панели атрибутов. 

 
Создание цепочки связанных рамок. Цепочками связанных рамок простого текста 

пользуются для того, чтобы разместить один текст в разных местах одной страницы или на 
разных страницах документа. Речь идет не о размещении копий, а о продолжении текста при 
переходе из одной рамки в другую (см. рис. 103). 

Если текст, содержащийся в рамке, отображается в ней не полностью, то индикатор, 
расположенный в середине нижней границы рамки, принимает вид прямоугольника со 
стрелкой, направленной вниз. После щелчка мышью на этом индикаторе указатель инструмента 
принимает форму листа с текстом, он как бы «заряжается» текстом (рис. 104). 

 

Рисунок 104 – Рамка с индикатором не размещенного текста 
и «заряженный» текстом указатель инструмента 

 
Чтобы добавить в цепочку новую рамку, остается только перетащить указатель по ее 

диагонали (рис. 105). 

 

Рисунок 105 – Вновь созданная рамка простого текста соединяется стрелкой 
со своей предшественницей в цепочке 
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Рамки, входящие в состав одной цепочки, соединяются цветными стрелками, которые 

отображаются только на экране, а на печать не выводятся. 
По форме верхних и нижних индикаторов можно судить о местоположении рамки в 

цепочке и наличии в ней неразмещенного текста. У первой рамки цепочки верхний индикатор 
пустой. Если рамка в цепочке не последняя, ее нижний индикатор выглядит как миниатюрная 
страница с текстом. Наконец, если рамка последняя, ее нижний индикатор пуст или содержит в 
себе стрелку, направленную вниз (если в рамке имеется неразмещенный текст). 

Режим отображения цветных стрелок, включенный по умолчанию, можно выключить с 
помощью специального флажка Show linking of text frames (Показывать связи рамок простого 
текста). Для отключения данного режима выберите команду Tools > Options (Сервис > 
Режимы), а затем в иерархическом списке в левой части раскрывшегося диалогового окна – 
пункт Workspace > Text > Paragraph (Рабочая область > Текст > Простой). 

Если необходимо, чтобы следующая рамка в цепочке имела форму, отличную от 
прямоугольника, следует вначале построить замкнутый криволинейный объект желаемой 
формы, а затем, «зарядив» указатель инструмента текстом, щелкнуть на нижнем индикаторе 
последней рамки цепочки. После этого при перемещении указателя внутрь замкнутого 
криволинейного объекта он примет форму широкой стрелки, направленной вправо. После 
щелчка на объекте таким указателем создается рамка, совпадающая с объектом по форме, – 
текст заключается внутрь объекта (рис. 106). 

В результате описанной выше процедуры создается составной объект, состоящий из 
замкнутой фигуры (управляющий объект) и прямоугольной рамки, заключенной в оболочку, по 
форме совпадающую с управляющим объектом. После построения рамки в оболочке 
управляющий объект больше не нужен, так как, в отличие, например, от суперлинии его 
изменение не оказывает влияния на форму рамки простого текста, заключенной в оболочку. 
Поэтому составной объект можно разъединить командой Arrange > Break Apart (Монтаж > 
Разъединить) и удалить замкнутую кривую. При этом рамка в оболочке остается в составе 
цепочки рамок простого текста. 

 

Рисунок 106 – Создание рамки простого текста произвольной формы 
 

Если после «зарядки» указателя инструмента текстом выполнить щелчок не на 
замкнутом объекте, а на разомкнутой кривой, то будет построена прямоугольная рамка 
простого текста, по габаритам совпадающая с рамкой выделения кривой, после чего начало 
попавшего в нее текста (не далее чем до первого конца абзаца) размещается вдоль этой кривой, 
а остальной текст остается неразмещенным (см. рис. 103). 
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В этом случае также создается соединенный объект, но другого типа (текст, 

размещенный на кривой). Поэтому при отделении управляющего объекта (кривой) рамка 
простого текста приобретает свою исходную прямоугольную форму. Таким образом, 
управляющую кривую удалять нельзя, но ее можно сделать невидимой, отменив обводку 
кривой. 

Чтобы удалить рамку, входящую в состав цепочки, достаточно выделить ее 
инструментом Pick (Выбор) и нажать клавишу Del. Если удаляется последняя рамка цепочки, 
содержавшийся в ней текст будет вытеснен в предпоследнюю рамку, сохраняясь в ней как 
неразмещенный. При удалении первой рамки цепочки текст вытесняется во вторую и 
размещается в ней, из второй – в третью и т. д. Избыток текста в цепочке всегда находится в 
последней рамке (как неразмещенный текст). При удалении промежуточной рамки цепочки 
автоматически создается новая связь, соединяющая предыдущую и следующую рамки. Текст из 
удаленной рамки вытесняется «вниз» по цепочке. 

Построенную цепочку связанных рамок простого текста можно «расцепить» в любом 
месте. Для этого достаточно описанным выше приемом «зарядить» указатель инструмента 
текстом, щелкнув на нижнем индикаторе рамки, и построить новую рамку на свободном месте. 
При этом весь текст из «хвоста» цепочки переносится в новую рамку, а рамки, входящие в 
состав «хвоста», остаются пустыми, но сцепленными друг с другом. Если впоследствии на 
первой «отцепленной» рамке будет выполнен щелчок «заряженным» указателем инструмента (в 
виде широкой стрелки), все отцепленные рамки вновь наполнятся текстом. 

Рамки, входящие в состав цепочки, могут размещаться на различных страницах 
документа CorelDRAW. При создании рамки на другой странице следует после «зарядки» 
указателя инструмента текстом перейти на эту страницу и создать на ней новую текстовую 
рамку. Если требуется перенести ранее созданную текстовую рамку на другую страницу, 
необходимо вначале перетащить ее инструментом Pick (Выбор) за пределы страницы на 
рабочий стол, перейти на другую страницу и перетащить туда рамку с рабочего стола. 

Так можно размещать весьма значительные объемы простого текста в связанной цепочке 
рамок, расположенных в пределах одной или нескольких страниц документа CorelDRAW, а 
также на рабочем столе. 

5.5. Обтекание текстом 
Обтеканием простым текстом называется режим, при котором текст в рамках 

размещается с учетом не только конфигурации этих рамок, но и формы объектов, 
перекрывающихся с рамками цепочки. Этот режим включается для всех объектов CorelDRAW, 
у которых атрибут обтекания имеет значение, отличное от None (Без обтекания). Этот атрибут 
может быть установлен с помощью меню, связанного с кнопкой Wrap Paragraph Text 
(Обтекание простым текстом) панели атрибутов (рис. 107). Кроме режима обтекания может 
задаваться зазор, то есть минимальное расстояние между текстом и обтекаемым объектом. 

Все режимы обтекания делятся на две группы: обтекание по контуру объекта (в качестве 
границы области, в которой текст не размещается, выступает граница объекта произвольной 
конфигурации) и обтекание по рамке выделения (в качестве границы области, в которой текст 
не размещается, выступает габаритный прямоугольник объекта, совпадающий по размерам с 
его рамкой выделения). Примеры обтекания текстом приведены на рис. 108 и 109. 
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Рисунок 107 – Настройка режима обтекания простым текстом 
 

Атрибуты простого текста. Практически все атрибуты фигурного текста имеются и у 
простого текста, но за счет того, что у последнего больше структурных единиц, на вкладках 
диалогового окна Format Text (Форматирование текста) для простого текста появляются 
дополнительные элементы управления, которые и рассматриваются ниже. 

 
Атрибуты шрифта. Вкладка Character (Символы) в диалоговом окне Format Text 

(Форматирование текста) для простого текста выглядит так же, как для фигурного. 
 

 
 

а – без обтекания, 6 – обтекание слева,  
б – обтекание справа, г – обтекание вокруг 

Рисунок 108 – Обтекание текстом по контуру объекта  
 

а 

в 

б 

г 
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а – обтекание слева, 6 – обтекание справа, в – обтекание вокруг; г – обтекание вразрез 
Рисунок 109 – Обтекание текстом по рамке выделения объекта 

 
Атрибуты интервалов. В случае простого текста на вкладке Paragraph (Абзац) 

диалогового окна Format Text (Форматирование текста) появляются дополнительные элементы 
управления (рис. 110). 

 

Рисунок 110 – Вкладка Paragraph диалогового окна Format Text для простого текста 
 

- Кнопка Settings (Установки) открывает диалоговое окно со счетчиками Max. word 
spacing (Максимальный интервал между словами), Min. word spacing (Минимальный интервал 
между словами) и Max. char spacing (Максимальный интервал между символами). Эти счетчики 
позволяют более гибко управлять выравниванием текста в режимах Full justify (По ширине) и 
Force justify (Полное выравнивание по ширине), регулируя плотность верстки текста (рис. 111). 

- В группу счетчиков Spacing (Интервалы) входят счетчики Before paragraph (Перед 
абзацем) и After paragraph (После абзаца), которые позволяют создавать просветы между 
абзацами, называемые в полиграфии отбивками. По умолчанию интервал перед абзацем 
устанавливается равным обычному межстрочному интервалу, а после абзаца – равным нулю. 

 
 

а 

в 

б 

г 
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Рисунок 111 – Элементы управления интервалами для простого текста 
во вспомогательном диалоговом окне 

 
- Кнопка Hyphenation Settings (Установки переноса) открывает вспомогательное 

диалоговое окно, элементы которого управляют переносом слов (рис. 112). 

 

Рисунок 112 – Диалоговое окно Hyphenation Settings 
 

- Флажок Use automatic hyphenation (Автоматическая расстановка переносов) включает 
режим автоматической расстановки переносов слов простого текста (по умолчанию 
выключенный) и делает доступными другие элементы управления диалогового окна. 

- Флажок Break capitalized (Разбивать прописные) отключает включенный по умолчанию 
режим запрета на перенос слов, набранных прописными буквами. 

- Счетчик Hot zone (Зона переноса) задает ширину зоны переноса – полосы, 
примыкающей к правой границе рамки простого текста. Если в процессе верстки слово не 
помещается в строку, то в режиме автоматического переноса проверяется, где находится начало 
этого слова. Если оно попадает в зону переноса, слово целиком перемещается на следующую 
строку. Если начало слова находится левее зоны переноса, будет предпринята попытка 
перенести его. 

Чем уже зона переноса, тем больше строк, оканчивающихся знаком переноса, и тем 
плотнее располагаются слова в строках. 

- Счетчик Min. word length (Минимальная длина слова) задает минимальное количество 
символов в слове, которое может быть перенесено (по умолчанию – шесть символов). 

- Счетчики Min. characters before (Минимальное число символов до) и Min. characters 
after (Минимальное число символов после) задают минимальное количество символов слова, 
которое может остаться на строке соответственно до и после знака переноса. 

Группа счетчиков Indents (Отступы) позволяет задавать втяжки и абзацные отступы. 
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- Счетчик Left (Левый) задает величину левой втяжки – расстояния от левого края рамки 
простого текста до вертикальной линии, по которой выравниваются первые символы строк 
абзаца (кроме первой, выравнивание которой задается отдельно). 

- Счетчик Right (Правый) задает величину правой втяжки – расстояния от правого края 
рамки простого текста до вертикальной линии, по которой выравниваются последние символы 
строк абзаца (кроме первой, выравнивание которой задается отдельно). 

- Счетчик First line (Первая строка) задает величину левой втяжки для первой строки 
абзаца. Согласованно регулируя значения левой втяжки и левой втяжки для первой строки, 
можно управлять величиной абзацного отступа – смещением первого символа первой строки 
абзаца относительно линии левой втяжки. 

Значения, содержащиеся в счетчиках группы Indents (Отступы), могут быть только 
положительными, но следует иметь в виду, что соответствующие расстояния всегда измеряются 
от края рамки к ее середине. 

 
Табуляции. Позицией табуляции, или табулостопом, называется точка в пределах длины 

строки, управляющая режимом выравнивания части строки, следующей за специальным 
символом табуляции. Работая с простым текстом, можно задавать позиции табуляции с 
помощью координатной линейки простого текста и вкладки Tabs (Табуляции) диалогового окна 
Format Text (Форматирование текста), представленной на рис. 113. 

 

Рисунок 113 – Вкладка Tabs диалогового окна Format Text 
 

В правой части вкладки располагается таблица с параметрами всех установленных на 
текущий момент позиций табуляции. Первый столбец таблицы указывает положение 
соответствующего табулятора. После щелчка мышью в любой ячейке этого столбца можно 
изменить значение непосредственно в ячейке вводом нового числа с клавиатуры или 
воспользоваться кнопками счетчика со стрелками. 

Щелчок в любой ячейке столбца Alignment (Выравнивание) позволяет раскрыть список 
альтернатив выравнивания для позиции табуляции: Left (Влево), Right (Вправо), Center (По 
центру) и Decimal alignment (По десятичной точке). 

Столбец флажков Leadered (С заполнителем) позволяет указать, нужно ли связывать 
позицию табуляции с заполнителем. Заполнитель представляет собой повторяющуюся 
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последовательность символов, заполняющих (вместо обычных пробелов) строку в промежутке 
между текстами, выровненными по предыдущей и текущей позициям табуляции. 

Для задания символа-заполнителя можно либо ввести сам символ в текстовое ноле 
Character (Символ) раздела Trailing Leader (Заполнитель), либо указать ASCII-код символа в 
счетчике Characters (Код символа). По умолчанию в качестве заполнителя применяется пробел. 
Счетчик Spacing (Интервал) используется для управления межсимвольным интервалом в 
заполнителе. 

В пределах одного абзаца может использоваться только один вариант заполнителя. 
Чтобы добавить новую позицию табуляции, достаточно щелкнуть на кнопке Add tab 

(Добавить), на которой изображен плюс. Если требуется удалить позицию табуляции, сначала 
выделите соответствующую ей ячейку в таблице, а затем щелкните на кнопке Delete tab 
(Удалить), на которой изображен минус. Для удаления сразу всех позиций табуляции щелкните 
на кнопке Delete All (Удалить все), расположенной в правом нижнем углу диалогового окна. 

 
Колонки текста. Простой текст, размещенный в пределах рамки, можно расположить в 

нескольких колонках (не более восьми). Колонки текста могут быть равной или разной 
ширины, они отделяются друг от друга средниками – свободным пространством, исключенным 
из процесса верстки. Элементы управления, задающие значения атрибутов, имеющих 
отношение к колонкам текста, расположены на вкладке Columns (Колонки) диалогового окна 
Format Text (Форматирование текста), представленной на рис. 114. 

 

Рисунок 114 – Вкладка Columns диалогового окна Format Text 
 

- Счетчик Number of columns (Число колонок) задает количество текстовых колонок, на 
которое разбивается простой текст, размещенный в рамке. 

- В столбце Width (Ширина) задается ширина каждой из колонок текста в пределах 
рамки. 

- В столбце Gutter (средник) указывается ширина средников. 
- Флажок Equal column width (Колонки равной ширины) включает режим, при котором 

атрибуты ширины и средника задаются только для первой колонки, а для всех остальных 
автоматически устанавливаются идентичные значения. 
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- В информационном поле Paragraph frame width (Ширина рамки) можно увидеть 
значение суммарной ширины колонок и средников абзаца. 

- Ниже информационного поля расположена группа переключателей. Если установлен 
переключатель Maintain current frame width (Сохранять ширину рамки), то ширина рамки абзаца 
будет оставаться постоянной независимо от размеров колонок и средников. При установке 
переключателя Automatically adjust frame width (Автоматически изменять ширину рамки) 
ширина рамки будет автоматически изменяться, оставаясь равной общей ширине колонок и 
средников. 

- В раскрывающемся списке Vertical justification (Выравнивание по вертикали) 
выбирается способ размещения строк текста по вертикали в пределах колонки. В списке 
имеются альтернативы Тор (По верху), Center (По центру), Bottom (По низу) и Full 
(Полностью). В последнем случае интерлиньяж в неполной колонке увеличивается таким 
образом, чтобы «растянуть» колонку на всю высоту рамки. 

Изображение в области предварительного просмотра, расположенной в правой верхней 
части вкладки, меняется в соответствии с выбранными значениями атрибутов колонок текста. 

5.6. Типографские эффекты 
Название последней из вкладок диалогового окна Format Text (Форматирование текста) – 

Effects (Эффекты) – подразумевает не графические, а типографские эффекты, а именно 
маркированные списки и буквицы. По умолчанию в раскрывающемся списке Effect Type (Тип 
эффекта) выбрана альтернатива None (Нет эффекта), поэтому все элементы управления вкладки 
недоступны. Настройка типографских эффектов возможна после выбора альтернативы Bullet 
(Маркер списка) или Drop cap (Буквица) 

 
Маркированный список. Маркированным списком в полиграфии принято называть 

последовательность одинаково отформатированных абзацев, в начале каждого из которых 
размещен маркер списка – как правило, тире или специальный графический символ. В 
CorelDRAW имеется возможность выбрать для выделенного абзаца (или совокупности абзацев) 
маркер списка и его расположение относительно текста. На рис. 115 вкладка Effects (Эффекты) 
представлена в режиме настройки атрибутов маркированного списка. 

 

Рисунок 115 – Вкладка Effects в режиме настройки атрибутов маркированного списка 
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- Раскрывающийся список Font (Гарнитура) позволяет выбрать гарнитуру, символы 

которой отображаются в раскрывающейся палитре Symbol (Символ), расположенной снизу от 
него. Чтобы выбрать маркер списка, достаточно щелкнуть на одном из символов, 
представленных в палитре. 

- Поле Symbol # (Код символа) позволяет вместо выбора маркера с помощью мыши 
ввести его ASCII-код. 

- Счетчик Size (Размер маркера) задает кегль маркера списка. По умолчанию это 
значение устанавливается равным кеглю первого символа абзаца. 

- Счетчик Baseline shift (Смещение маркера) задает смещение маркера списка 
относительно базовой линии первой строки абзаца по вертикали. 

- Счетчик Position (Положение) устанавливает расстояние от левого края рамки простого 
текста до маркера списка. 

Если абзацный отступ превышает это расстояние, то текст абзаца маркированного 
списка размещается так же, как без маркера. В противном случае первая строка абзаца 
дополнительно смещается вправо, освобождая место для маркера списка. 

В нижней части вкладки расположены две графические кнопки, играющие роль 
переключателей и управляющие расположением маркера списка относительно текста 
маркированного абзаца. При выборе варианта Bulleted (Маркированный) маркер «вставляется» 
в первую строку абзаца (см. примечание выше), а вторая и последующие строки выравниваются 
по положению маркера. Вариант Hanging Indent (С выступом) размещает маркер слева от 
абзаца, так называемым висячим абзацным отступом, при этом все строки абзаца 
выравниваются одинаково по линии левой втяжки абзаца. 

 
Настройка буквицы. В полиграфии буквицей называется первый символ абзаца, 

выделенный очень крупным (по сравнению с телом абзаца) кеглем и расположенный особым 
образом по отношению к остальному тексту абзаца. В CorelDRAW имеется масса возможностей 
для художественного оформления буквиц в виде изображений, но следует иметь в виду и 
возможность прибегнуть к традиционному типографскому приему. После выбора альтернативы 
Drop cap (Буквица) в раскрывающемся списке Effect Туре (Тип эффекта) вкладка Effects 
(Эффекты) выглядит так, как показано на рис. 116. 

 

Рисунок 116 – Элементы управления форматированием буквицы 
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- Счетчик Dropped lines (Высота в строках) задает количество строк текста, совокупная 

высота которых будет принята за высоту буквицы. 
- Счетчик Distance from text (Расстояние до текста) задает интервал между правым краем 

буквицы и текстом абзаца. Графические кнопки Dropped (Опущенная) и Hanging Indent 
(Висячим отступом) управляют режимом размещения буквицы по отношению к абзацу. Их 
назначение очевидно из приведенных на кнопках рисунков. 

 
Упражнение 2. Приемы работы с простым текстом 
 

Создайте макет условного меню еще более условного кафе. Вид макета представлен на 
рис. 117. 

 

Рисунок 117 – Макет меню 
 

1. Создайте новую страницу в открытом документе CorelDRAW. Выберите инструмент 
Text (Текст), постройте в верхней части страницы блок простого текста произвольных размеров 
и перейдите в диалоговое окно Edit Text (Редактирование текста), щелкнув на соответствующей 
кнопке панели атрибутов.  

2. Выберите в раскрывающемся списке гарнитур любую, включающую символы 
кириллицы (например, Arial), и введите текст меню, разбивая его на абзацы нажатием клавиши 
Enter. Названия разделов меню и каждого из блюд должны располагаться в отдельных абзацах. 
По завершении ввода закройте диалоговое окно Edit Text (Редактирование текста). 

3. Задайте гарнитуры и кегли для отдельных абзацев. Технически это выполняется 
следующим образом: продолжая работать в диалоговом окне Edit Text (Редактирование текста), 
выделите мышью часть текста, подлежащую форматированию. Выделенный текст 
отображается на темном фоне. Затем в раскрывающихся списках гарнитур и кеглей выберите 
желаемые альтернативы. 

4. Устанавливая текстовый курсор в абзацы заголовков разделов меню, задайте 
параметры буквиц (в данном макете заголовки невелики по длине, и целесообразно указать 
высоту буквиц не более двух строк). Для этого вначале щелкните на кнопке панели атрибутов с 
изображением буквицы, а затем откройте диалоговое окно форматирования щелчком на кнопке 
в диалоговом окне Edit Text (Редактирование текста). Перейдя на вкладку эффектов, установите 
желаемую высоту буквицы. 
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5. Выделяя абзацы, соответствующие названиям блюд каждого из разделов меню, 
задайте для них маркеры списка. В данном макете использованы маркеры из символов 
специальной гарнитуры Food. По завершении форматирования закройте диалоговое окно Edit 
Text (Редактирование текста). 

6. Постройте цепочку связанных рамок простого текста. Рамок в цепочке может быть 
либо шесть, либо три – в последнем случае текст в двух последних рамках придется размещать 
в несколько колонок. Цепочку стройте, «заряжая» указатель инструмента Pick (Выбор) 
щелчком на нижнем индикаторе последней рамки цепочки. Выбирайте расположение рамок и 
их размеры в соответствии с макетом, приведенным на рисунке. Перетаскивая тем же 
инструментом маркеры рамки выделения, отрегулируйте размеры рамок простого текста таким 
образом, чтобы в первой из них разместился заголовок меню, а в последующих – по одному из 
его разделов. 

7. Сохраните документ CorelDRAW в файле с именем texts.cdr. 

5.7. Взаимные преобразования фигурного и простого текстов 
Фигурный текст можно преобразовать в простой. При соблюдении определенных 

условий возможно и обратное преобразование – блока простого текста в текст фигурный. 
Чтобы преобразовать фигурный текст в простой, следует выделить его при помощи 

инструмента Pick (Выбор), а затем выбрать команду Text > Convert To Paragraph Text (Текст > 
Преобразовать в простой текст). 

Чтобы преобразовать простой текст в фигурный, следует выделить его при помощи 
инструмента Pick (Выбор), а затем выбрать команду Text > Convert To Artistic Text (Текст > 
Преобразовать в фигурный текст). 

В тех случаях, когда преобразование возможно, в меню доступна соответствующая 
команда. 

При преобразовании простого текста в фигурный утрачиваются атрибуты, 
отсутствующие в объектах этого класса, а именно: колонки текста, позиции табуляции, 
буквицы. 

В тех случаях, когда в рамке простого текста имеется неразмещенный текст, или она 
входит в состав цепочки рамок, или к ней было применено специальное преобразование 
(например, размещение текста по кривой), преобразование в фигурный текст невозможно. 

 

5.8. Контрольные вопросы 
1. Назовите основные классы для текстовых объектов. 
2. Назовите основные атрибуты фигурного текста. 
3. Назовите основные элементы диалогового окна Edit Text. 
4. Для чего нужны цепочки связанных рамок? 
5. Что такое обтекание простым текстом? 
6. Как используют табуляцию? 
7. Назовите основные типографские эффекты и как их используют? 
8. Как происходит взаимное преобразование фигурного и простого текстов? 
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ЛАБОРАТОРНАЯ РАБОТА №6 

ОБВОДКА КОНТУРОВ 
Цель лабораторной работы: ознакомиться с параметрами контуров, возможностями обводки 
контуров. Приобрести практические навыки назначения параметров контура. 

6.1. Параметры контуров и управление ими 
Обводка – совокупности параметров модели, управляющих цветом и другими 

характеристиками отображения линий.  
Теперь линии будут рассматриваться как самостоятельные элементы изображения, и 

особое внимание будет уделяться не их форме, а способу, которым они отображаются на экране 
монитора и печатной странице. Предлагается следующая метафора: линия представляет собой 
тончайшее стекловолокно, которому можно придать форму, но которое невозможно увидеть в 
силу его прозрачности. Видимым это волокно становится только после того, как на него 
надевается непрозрачная (или полупрозрачная) оболочка. Оболочка может быть любого цвета и 
толщины, иметь специальные наконечники и множество других свойств. Именно она видна на 
изображении, но длина и форма оболочки полностью определяются той линией, на которую она 
надета. 

Существует несколько терминов для обозначения описанной выше «оболочки»: контур, 
контурная линия, линия обводки, обводка абриса, обводка контура или просто обводка. 

Таким образом, под термином «обводка» будем понимать процедуру задания значений 
параметров контура, построение контурной линии. Термином «линия» будем обозначать 
линию, определяющую форму и размеры контура.  

6.2. Атрибуты, управляющие внешним видом контура 
Толщина. Толщиной контура называется расстояние между его краями, измеренное в 

направлении перпендикуляра к линии, определяющей форму контура. На рис. 118 представлено 
несколько отрезков прямых, контуры которых имеют различную толщину. 

 

Рисунок 118 – Контуры с последовательным увеличением толщины от 0,5 до 8 пунктов 
 

Толщина контура обычно задается в пунктах, как высота символов текста, но 
допускается использование и любой другой единицы длины, принятой в CorelDRAW. 

В CorelDRAW по умолчанию считается, что с линией, задающей форму фигуры, 
совпадает середина контура, а сама контурная линия располагается поверх заливки фигуры 
(если она назначена). Об этом следует помнить при назначении параметров контурной линии 
для объектов небольших размеров. Например, назначение контура толщиной 4 пункта для 
текстового объекта с кеглем 8 пунктов может привести к невозможности чтения текста – все 
внутренние просветы букв будут закрыты контурной линией. 
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Вид. Видом, или стилем (style), контура называется фиксированное сочетание штрихов и 

просветов, повторяющееся вдоль всей длины линии, определяющей форму объекта. В 
CorelDRAW предусмотрено примерно два десятка стандартных стилей контуров на любой вкус 
и имеется возможность дополнительно создавать свои собственные стили. На рис. 119 
представлены некоторые из стандартных стилей контуров. 

 

Рисунок 119 – Контуры различных стилей толщиной 2 пункта 
 

Завершители. Завершителем (line cap) называется элемент оформления контурной 
незамкнутой линии в области ее крайнего узла. Модель линии CorelDRAW предусматривает 
три варианта стандартных завершителей незамкнутого контура: срез, закругление и квадрат. 
Они представлены на рис. 120 (начальные узлы линий на рисунке изображены квадратиками). 

 

Рисунок 120 – Три типа завершителей контуров 
 

Верхняя линия завершается срезами – в этом варианте контур просто «обрезается» по 
прямой, перпендикулярной линии, определяющей форму и проходящей через крайний узел 
этой линии.  

Вторая линия завершается закруглениями – контур «обрезается» по окружности, 
диаметр которой равен толщине контура, а центр совмещен с крайним узлом линии, 
определяющей форму. 

Третья линия завершается квадратами – эти завершители отличаются от срезов только 
тем, что контур продлевается за крайний узел линии, определяющей форму, на расстояние, 
равное половине толщины контура. 

Завершители на противоположных концах линии могут быть только одинаковыми. Если 
линия состоит из нескольких ветвей, то завершители на всех ее крайних узлах также будут 
одинаковыми. 

 
Углы. Углом (corner) контура называется элемент его оформления в узле типа «точка 

излома». В CorelDRAW приняты три стандартных варианта оформления углов: заостренный 
(mitered), закругленный (rounded) и срезанный (beveled). Они представлены на рис. 121. 
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Рисунок 121 – Варианты оформления углов контура в местах излома линии 
 

При построении заостренного угла контура его края продолжаются за точку излома до 
пересечения друг с другом. При построении закругленного узла диаметр закругления контура 
линии равен его толщине. При построении срезанного угла контурные линии подводятся к 
точке излома с двух сторон (как если бы примыкающие к этому узлу сегменты принадлежали 
отдельным линиям, а для завершения были выбраны срезы), а затем достраивается линия среза. 

По умолчанию все заостренные углы, величина которых не превышает 45° (так 
называемый предел среза), автоматически преобразуются в срезанные. Это делается для того, 
чтобы граница контура в узле, соответствующем такому углу, не отходила слишком далеко от 
узла. В принципе величину предела среза можно изменить, но на практике это требуется крайне 
редко. 
 

Наконечники. Наконечником (arrow) контура называется стандартное изображение, 
размещаемое в крайних узлах незамкнутой линии, размер которого определяется толщиной 
контура, а ориентация – направлением линии в конечном узле. В CorelDRAW предусмотрено 
много вариантов наконечников и имеется возможность пополнять их список наконечниками, 
разработанными пользователем. На рис. 122 представлены некоторые из стандартных 
наконечников. 

 

Рисунок 122 – Примеры стандартных наконечников незамкнутых линий 
 

В отличие от завершителей наконечники можно назначать индивидуально для 
начального и конечного узлов незамкнутой линии. Если в состав линии входит несколько 
ветвей, то для всех начальных и конечных узлов незамкнутых ветвей могут быть назначены 
только одинаковые пары наконечников. 

 
Цвет. Цвет контура назначается с помощью палитр и цветовых моделей, рассмотренных 

в лабораторной работе 4. На всем протяжении контурной линии, даже состоящей из нескольких 
ветвей, выбранный цвет остается неизменным. 

Поскольку контур не является самостоятельным объектом CorelDRAW, ему нельзя 
назначить градиентную или текстурную заливку. Впрочем, это ограничение можно обойти с 
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помощью специальной команды преобразования контура в самостоятельный объект – Arrange > 
Convert Outline To Object (Монтаж > Преобразовать контур в объект). 

После выделения объекта и выбора команды Arrange > Convert Outline To Object 
(Монтаж > Преобразовать контур в объект) контур объекта преобразовывается в 
самостоятельный объект, а для «старого» объекта построение контура отменяется. Все 
остальные его атрибуты (например, заливка) остаются неизменными. 

 
Форма и разворот пера контурной линии. При желании пользователь может задать 

параметры формы пишущего инструмента, с помощью которого строится контур. Имеется 
возможность задавать отношение ширины инструмента к его высоте и фиксировать разворот 
рабочей части инструмента. Это позволяет имитировать каллиграфические штрихи. 

Разворот рабочей части инструмента аналогичен развороту инструмента Smudge 
(Размазывание) вокруг вертикальной оси. Положительные значения угла соответствуют 
развороту его рабочей части против часовой стрелки от вертикального положения, 
отрицательные значения – развороту по часовой стрелке. 

На рис. 123 представлены два варианта построения контуров одинаковых фигур, 
отличающиеся лишь углом разворота инструмента. В обоих случаях высота инструмента 
составляет 15 % от его ширины, в верхнем ряду угол наклона составляет 40°, а в нижнем -40°. 
Шириной пишущего инструмента управлять нельзя – она определяется шириной линии 
обводки. 

Форма пишущего инструмента получается преобразованием масштабирования, 
примененного к исходной форме – квадрату или кругу. Выбор между этими формами 
определяется способом оформления углов контура. В случае заостренных или срезанных углов 
в качестве исходной формы используется квадрат, в случае закругленных углов – круг. Если в 
качестве завершителей контура выбраны закругления, то преобразование масштабирования 
пишущего инструмента оказывает влияние и на их форму – края контура будут обрезаться не 
по окружности, а по форме пишущего инструмента, эллипсу с той или иной степенью сжатия.  

 

Рисунок 123 – Два варианта выбора наклона пера для контуров 
 

Взаимное расположение заливки и контура объекта. Как уже упоминалось, по 
умолчанию контур изображается поверх заливки объекта, ограниченного замкнутой линией. 
При большой толщине контура и малых размерах объекта это обстоятельство оказывает 
существенное влияние на внешний вид изображения. На рис. 124 поверх серого 
прямоугольника расположены два блока фигурного текста, состоящие каждый из одного слова. 
Для обоих блоков задана заливка черным цветом и кегль 24 пункта, а также режим построения 
контура белого цвета толщиной 4 пункта. 
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Рисунок 124 – Расположение контура поверх заливки и позади заливки 
 

Отчетливо видно, что в левом блоке контуры целиком перекрыли не только штрихи 
букв, но и внутренние просветы (например, в букве «о»). Для правого блока задан режим 
размещения контуров позади заливки, в результате буквы не исказились, а надпись в целом 
оказалась отделенной от фона просветом, что визуально подчеркнуло ее, сделало более 
броской. 
 

Изменение толщины контурной линии при изменении размеров объекта. Как мы 
только что убедились, соотношение размера объекта и толщины его контура может оказывать 
существенное влияние на внешний вид изображения. Однако размеры объектов могут меняться 
в результате преобразований, что может привести к нарушению этого соотношения и, 
соответственно, к нежелательному искажению авторского замысла. На рис. 125 представлено 
две группы объектов, в каждую из которых входят квадрат и круг с заданными контурами. Под 
объектами представлены результаты их масштабирования: сначала пропорционального с 
коэффициентом 50%, а затем – непропорционального, только по вертикали, с коэффициентом 
10%. 

 

Рисунок 125 – Влияние режимов неизменного (слева) и пропорционального (справа) изменения 
толщины контура при масштабировании объектов 

 
У левой группы объектов толщина контура при преобразовании остается неизменной 

(этот режим принят в CorelDRAW по умолчанию). Для правой группы объектов задан режим 
пропорционального изменения толщины контура при выполнении преобразований, меняющих 
размеры объекта. Особенно заметна разница в степени искажения окружностей, сжимаемых в 
вертикальном направлении. 
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6.3. Инструменты для задания параметров контуров 
Особенность CorelDRAW, позволяющая выполнять одно и то же действие несколькими 

способами, наиболее ярко проявляется в средствах выполнения обводки. Помимо основного 
средства – диалогового окна Outline Pen (Перо для контуров) – в распоряжении пользователя 
имеются панель инструмента Outline (Контур), одноименная вкладка пристыковываемого окна 
Object Properties (Свойства объекта), панель атрибутов, пристыковываемое окно Graphic and 
Text styles (Стили графики и текста). 

Самым мощным инструментом для обводки контуров является диалоговое окно Outline 
Pen (Перо для контуров), представленное на рис. 126, но во многих случаях достаточно 
возможностей панели инструмента Outline (Контур), которая показана на рис. 127. 

 

Рисунок 126 – Диалоговое окно Outline Pen 
 
Ниже перечислены кнопки напели инструмента Outline (Контур). 
- Щелчок на кнопке Outline Pen Dialog (Диалоговое окно параметров контура) 

раскрывает диалоговое окно Outline Pen (Перо для контуров), в котором содержатся все 
средства управления параметрами контура. 

- Кнопка Outline Color Dialog (Диалоговое окно цвета контура) раскрывает диалоговое 
окно Outline Color (Цвет контура), аналогичное рассмотренному в предыдущем уроке 
диалоговому окну назначения цвета заливки. 

- Кнопка No Outline (Удалить контур) позволяет отменить построение контура для 
выделенных объектов. 

- Щелчок на кнопке Hairline Outline (Визирная линия) изменяет толщину контурной 
линии на наименьшую из возможных. Контурная линия такой толщины называется визирной, 
ее толщина равна примерно 0,2 пункта. На некоторых устройствах вывода линии такой 
толщины не отображаются из-за ограничения разрешающей способности. По умолчанию 
именно такая толщина контура применяется ко всем объектам CorelDRAW кроме текстовых 
(для них по умолчанию контуры вовсе не строятся). 
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Рисунок 127 – Панель инструмента Outline 
 

- При щелчке на любой из кнопок, устанавливающих толщину контура равной 
соответственно 0,5, 1, 2, 8, 16 и 24 пункта, соответствующее значение назначается 
управляющему параметру толщины контура выделенных объектов. 

- Щелчок на кнопке Color Docker (Пристыковываемое окно цвета) раскрывает 
соответствующее пристыковываемое окно, с помощью элементов управления которого можно 
задать значения управляющих параметров цветовой модели для линий контуров выделенных 
объектов. 

В тех случаях, когда функциональности панели инструмента Outline (Контур) 
недостаточно, пользуются элементами управления, находящимися в диалоговом окне Outline 
Pen (Перо для контуров). 

- Щелчок на кнопке Color (Цвет) раскрывает палитру цветов. Расположенная в палитре 
кнопка Other (Другие) раскрывает диалоговое окно Select Color (Выбор цвета), аналогичное 
диалоговому окну Fill Color (Цвет заливки), рассматривавшемуся в предыдущем уроке. Это 
диалоговое окно предоставляет доступ ко всем средствам настройки цвета, имеющимся в 
CorelDRAW. 

- Значение в счетчике Width (Толщина) определяет толщину контура. Справа от него 
расположен раскрывающийся список, позволяющий выбрать желаемые единицы измерения 
толщины (по умолчанию – пункты). 

- Графические альтернативы раскрывающегося списка Style (Вид) дают возможность 
выбрать один из стандартных стилей контурной линии. 

- Щелчок на кнопке Edit Style (Правка вида) раскрывает диалоговое окно, управляющие 
элементы которого позволяют создать новый стиль контурной линии и сохранить его для 
дальнейшего использования. 

- Группа переключателей Line caps (Завершители) предназначена для выбора 
завершителя контурной линии. 

- Группа переключателей Corners (Углы) определяет способ оформления контура в 
точках излома линии при углах смежных сегментов, не превышающих предела среза (см. 
выше). 

- Флажок Behind fill (Заливка выше контура) определяет режим отображения контура по 
отношению к заливке замкнутого объекта. По умолчанию флажок сброшен. 

- Флажок Scale with image (Сохранять пропорции) определяет поведение параметра, 
управляющего толщиной контура при изменении размеров объекта. По умолчанию флажок 
сброшен. 

- Элементы управления в группе Calligraphy (Каллиграфия) позволяют задать форму 
пишущего инструмента. Счетчики определяют соотношение ширины и высоты рабочей части 
пишущего инструмента, а также его угол разворота; в области предварительного просмотра 
схематически отображается форма пера (на которую влияет также и выбранный тип 
завершителя линии). 
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Перетаскивая произвольную точку в области предварительного просмотра, соотношение 
ширины и высоты рабочей части пишущего инструмента можно менять интерактивно. 

- Пара кнопок Arrows (Наконечники) соответствует наконечникам, размещаемым в 
начальном и конечном узлах разомкнутой линии. При щелчке на любой кнопке раскрывается 
палитра со стандартными наконечниками, для выбора которых достаточно щелчка мышью. 
Палитра снабжена полосой прокрутки, поскольку стандартных наконечников очень много. По 
умолчанию наконечники не назначаются. 

- Щелчок на любой из двух кнопок Options (Режимы) раскрывает контекстное меню 
наконечника, команды которого позволяют менять наконечники местами, редактировать форму 
стандартного наконечника или создавать наконечники оригинальной формы. 

Некоторые элементы управления рассмотренного диалогового окна присутствуют также 
и на панели атрибутов, появляющейся при активизации инструментов построения линий 
(рис. 128). 

 

 
 

Рисунок 128 – Элементы управления контуром на панели атрибутов 
 

Однако на панели атрибутов элементы управления контуром присутствуют далеко не всегда. В 
частности, их нет на панели атрибутов, соответствующей любому из инструментов для построения 
примитивов, нет их и в случае совместного выделения нескольких объектов. Из-за этого панель 
атрибутов не может служить основным инструментом обводки контуров. 

6.4. Процедура назначения параметров контура 
Процедура обводки содержит следующие этапы. 
1. Выделите объекты, контуры которых вы хотите изменить. 
Если требуется изменить принятые по умолчанию параметры контуров, следует, 

напротив, отменить выделение всех ранее выделенных объектов, а далее процедура изменения 
параметров, принятых по умолчанию, не отличается от стандартной процедуры обводки. 

2. Щелкнув на кнопке инструмента Outline (Контур) в наборе инструментов, раскройте 
панель этого инструмента и выберите толщину обводки. Если нужна более точная настройка 
толщины, щелкните на кнопке, раскрывающей диалоговое окно Outline Pen (Перо для 
контуров). 

3. При необходимости задать цвет контура щелкните правой кнопкой мыши на образце 
цвета экранной палитры или перетащите этот образец на линию. Для более точной настройки 
цвета на панели инструмента Outline (Контур) щелкните на кнопке, раскрывающей диалоговое 
окно Outline Color (Цвет контура). 

При перетаскивании цвета необходимо следить за формой указателя. Для назначения 
цвета контуру он в момент отпускания кнопки мыши должен сопровождаться квадратиком 
выбранного цвета с белой серединой. Если цвет середины квадратика будет тем же, что и цвет 
края, произойдет назначение цвета заливке, а не контуру. 
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4. Назначение стиля контура, завершителей, углов, наконечников и параметров 
пишущего инструмента выполняется с помощью элементов управления диалогового окна 
Outline Pen (Перо для контуров) или панели атрибутов. 

Некоторые модификации контура (например, завершители и наконечники) имеют смысл 
только для незамкнутых линий. Однако их можно задать и для замкнутых линий. Значения 
управляющих параметров будут запомнены, хотя и не повлияют на внешний вид объекта. Если 
впоследствии линия будет разомкнута, например, с помощью инструмента Knife (Лезвие), эти 
параметры сразу же окажут влияние на внешний вид объекта. 

 
Упражнение 1. Обводка контуров 
 

1. Постройте изображения, представленные на рисунках 118-125. 
2. Построийте стилизованную виньетку с авиационной тематикой, представленную на 

рис. 129. 

 

Рисунок 129 – Этапы построения виньетки 
 

3. Начните с построения квадрата со стороной 8 см. С помощью панели атрибутов 
задайте закругление углов квадрата, введя значение управляющего параметра закругления 
любого из углов, равное 75. 

4. Щелкнув на соответствующей кнопке панели атрибутов, преобразуйте полученную 
фигуру в кривые. Выберите инструмент Shape (Форма) и выделите им все узлы новой кривой, 
растянув вокруг нее прямоугольную рамку выделения. Щелкните на кнопке разъединения 
кривой на панели атрибутов. В результате кривая будет разделена на восемь ветвей – по числу 
выделенных узлов. Выберите команду Arrange > Break Apart (Монтаж > Разъединить), и ветви 
кривой станут самостоятельными объектами. 

5. Выберите инструмент Pick (Выбор) и с его помощью выделите четыре прямолинейных 
отрезка. Щелкнув правой кнопкой мыши на перечеркнутом образце цвета экранной палитры, 
отмените построение контуров для этих объектов. После этого они перестанут отображаться на 
экране. 

6. Отмените выделение и, удерживая нажатой клавишу Shift, поочередно щелкните на 
четырех дугообразных объектах, чтобы совместно выделить их. 

Выделить дуги, растягивая вокруг них прямоугольник выделения, нельзя – в выделение 
попадут хоть и невидимые, но вполне реальные прямолинейные объекты, что нам не нужно. 

7. С помощью панели атрибутов выберите и назначьте полукруглым объектам 
наконечник в виде аэроплана. Для второго конца контурных линий назначать наконечник не 
следует. Установите ширину контурной линии равной 4 пунктам. 

8. Изображение должно выглядеть так, как показано на рис. 129, слева. Однако плоские 
концы линий выглядят как-то не в стиле виньетки. Выделите правую нижнюю дугу и выберите 
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команду Arrange > Convert Outline To Object (Монтаж > Преобразовать контур в объект). Теперь 
контур преобразован в кривую, точнее – в замкнутую кривую со сплошной заливкой черным 
цветом. 

9. Чтобы преобразовать бывший плоский конец линии в изящно тающий инверсионный 
след, примените к этому объекту градиентную коническую заливку, схема которой 
представлена на рис. 129, справа. При работе над этой заливкой придется не только поменять 
местами цвета в управляющих точках схемы заливки, но и добавить две дополнительные точки 
на дугу управляющей схемы, перетащив образцы цвета с палитры: черный – в точку на хвосте 
самолета, белый – в точку, отстоящую на некоторое расстояние от конца линии. 

10. Остается проделать два предыдущих шага с остальными видимыми объектами 
виньетки (к сожалению, прием копирования заливки в этом примере не даст экономии усилий, 
поскольку градиентную заливку для каждого из четырех углов придется настраивать 
индивидуально). 

6.5. Способы копирования параметров контура 
Процедура копирования параметров контура позволяет ускорить обводку линий в 

случае, если ранее те или иные линии изображения уже были оформлены контурами желаемого 
вида. Эту процедуру можно выполнить с помощью Eyedropper (Пипетка) и Paint Bucket (Банка с 
краской). 

1. Выберите в панели инструментов инструмент Eyedropper (Пипетка) и на панели 
атрибутов с помощью крайнего слева раскрывающегося списка установите режим работы 
Object Attributes (Атрибуты объектов). 

2. Раскрыв щелчком на кнопке Properties (Свойства) панели атрибутов вспомогательную 
палитру, установите в ней флажок Outline (Контур) и сбросьте два других флажка. 

3. Щелкните указателем инструмента на объекте, который послужит образцом контура. 
4. Выберите инструмент Paint Bucket (Банка с краской) и на панели атрибутов с 

помощью крайнего слева раскрывающегося списка установите режим работы Object Attributes 
(Атрибуты объектов). 

5. Раскрыв щелчком на кнопке Properties (Свойства) панели атрибутов вспомогательную 
палитру, установите в ней флажок Outline (Контур) и сбросьте два других флажка. 

6. Поочередно щелкните указателем инструмента Paint Bucket (Банка с краской) на всех 
объектах, на которые следует скопировать параметры контура. 
Ту же процедуру можно выполнить быстрее с помощью инструмента Pick (Выбор). Достаточно 
перетащить указателем этого инструмента объект с образцом контура на объект, подлежащий 
обводке. Хитрость состоит в том, что перетаскивание следует выполнять, нажав и удерживая не 
левую, а правую кнопку мыши. В этом случае в конце перетаскивания на линии объекта 
появляется цветное изображение маленькой мишени. Если освободить правую кнопку мыши в 
этот момент, раскроется контекстное меню, в котором следует выбрать команду Copy Outline 
Here (Скопировать контур). Этот же прием можно применять и для копирования заливки, 
только в конце следует выбрать в контекстном меню команду Copy Fill Here (Скопировать 
заливку). 
 

6.6. Контрольные вопросы 
1. Что такое обводка? 
2. Какие атрибуты управляют внешним видом контура? 
3. Назовите основные инструменты для задания параметров контуров. 
4. Назовите основные элементы панели инструмента Outline. 
5. Опишите способы копирования параметров контура? 
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ЛАБОРАТОРНАЯ РАБОТА №7 

ОГИБАЮЩИЕ И ДЕФОРМАЦИИ 

Цель лабораторной работы: ознакомиться с параметрами огибающих и эффектами 
деформации. Приобрести практические навыки по управлению эффектами огибающих и 
деформации. 

7.1. Огибающие 
В случае огибающих деформация сводится к растягиванию или сжатию объекта в 

соответствии с формой вспомогательного объекта – огибающей. В случае деформации 
воздействие на объект оказывается более замысловатым, например, может закручиваться ее 
центр при закрепленных краях, или нанесенным на ее линиям может придаваться 
зигзагообразная форма, или пленка может растягиваться не за края, а за точки, в которых 
расположены узлы объекта. 

Огибающей называется служебный (не отображаемый при печати) объект, 
использующийся для деформирования заключенного в него объекта или группы объектов. 

Совокупность объектов, не связанных в группу, заключить в огибающую не удастся ее 
следует предварительно сгруппировать. 

Огибающие похожи на замкнутые кривые и отображаются на экране пунктирными 
линиями красного цвета. Узлы огибающих отображаются, в отличие от узлов настоящих 
кривых, не кружками, а квадратиками. Эти узлы можно перемещать, меняя форму огибающей, 
что влечет за собой изменение внешнего вида заключенного в нее объекта.  

Помимо перетаскивания узлов огибающей их можно редактировать теми же 
инструментами, что узлы обычной кривой. Редактировать можно также и сегменты огибающей, 
выбирая, какие из них будут прямыми, а какие – криволинейными. 

Однако в отличие от обычной кривой на форму огибающей при желании можно 
наложить ограничения, определяющие возможности редактирования ее формы. Перечислим 
варианты этих ограничений в порядке убывания жесткости (первые три режима редактирования 
формы огибающей поддерживались, начиная практически с первых версий CorelDRAW). 

- В режиме редактирования огибающей Straight Line (Прямая) любая из четырех сторон 
огибающей может представлять собой только отрезок прямой. 

- В режиме Single Arc (Дуга) сторона огибающей может представлять собой кривую, 
форма которой определяется направляющими точками двух ее конечных узлов, совпадающих с 
углами огибающей. 

- В режиме Double Arc (Волна) форма стороны огибающей определяется не двумя, а 
тремя узлами. 

- В режиме Unconstrained (Кривая) все четыре стороны огибающей представляют собой 
полнофункциональные кривые, что позволяет более гибко настраивать ее форму. 

Основным средством для заключения объектов в огибающие является инструмент, 
кнопка которого расположена четвертой слева на панели интерактивных инструментов, 
представленной на рис. 130 (вверху слева). После щелчка на объекте инструментом Interactive 
Envelope (Интерактивная огибающая) он оказывается заключенным в огибающую, параметры 
которой определяются по умолчанию, а в рабочей области появляется панель атрибутов, 
представленная на рис. 130 (внизу слева). Имеется также пристыковываемое окно Envelope 
(Огибающая), элементы управления которого (рис. 130, справа) имеют ту же 
функциональность, что элементы панели атрибутов. 
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Ниже перечислены элементы управления панели атрибутов. 
- Группа кнопок инструментов для редактирования узлов и сегментов. 
- Группа кнопок инструментов для задания режима редактирования огибающей. По 

умолчанию задан режим Unconstrained (Кривая). 
 

 
 

Рисунок 130 – Панель интерактивных инструментов с выбранным инструментом Interactive 
Envelope и соответствующие панель атрибутов и пристыковываемое окно 

 
- Кнопка Add New Envelope (Добавить огибающую) позволяет заключить в огибающую 

объект, ранее уже заключенный в огибающую. 
- Кнопка Clear Envelope (Удалить огибающую) позволяет удалить последнюю из 

огибающих, в которые заключен объект. 
- Кнопка Copy Envelope Properties (Копировать огибающую) позволяет заменить 

последнюю из огибающих, в которые заключен объект, на огибающую другого объекта. 
- Кнопка Convert To Curves (Преобразовать в кривые) служит для удаления огибающей, 

преобразуя заключенный в нее объект в кривые таким образом, что получившийся объект 
полностью сохраняет ту форму, которую имел исходный объект в огибающей. 

- После щелчка на кнопке Create Envelope From (Создать огибающую из) появляется 
горизонтальная стрелка, которой можно щелкнуть на любой замкнутой кривой на печатной 
странице. В результате огибающая будет создана из копии указанной кривой. 

- Кнопка Keep Lines (Сохранять прямые) переключает режим преобразования 
огибающей таким образом, что в процессе преобразования прямолинейные сегменты объекта 
остаются прямолинейными и после преобразования. 

- Раскрывающийся список Mapping Mode (Режим заполнения) определяет режим 
преобразования исходного объекта в процессе заполнения заданной огибающей. Выбранный 
режим не влияет ни на форму самой огибающей, ни на режим ее редактирования. В 
раскрывающемся списке имеется пять альтернатив. Первые четыре могут выбираться для 
любых объектов, заключаемых в огибающую: 

• Horizontal (По горизонтали) – объект масштабируется так, чтобы габариты его рамки 
выделения совпали с габаритами огибающей, а затем узлы объекта перемещаются по 
горизонтали для придания объекту формы огибающей; 

• Vertical (По вертикали) – объект масштабируется так, чтобы габариты его рамки 
выделения совпали с габаритами огибающей, а затем узлы объекта перемещаются по вертикали 
для придания объекту формы огибающей; 
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Волна 
Кривая 

Сохранить прямые Добавить 
огибающую 

Режим 
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Преобразовать в кривые 
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• Putty (По углам) – угловые маркеры рамки выделения объекта совмещаются с 
угловыми узлами огибающей, а прочие узлы огибающей и узлы объекта в этом режиме 
заполнения не совмещаются; 

• Original (По касательным) – угловые маркеры рамки выделения объекта, как и в 
предыдущем случае, совмещаются с угловыми узлами огибающей, однако в этом режиме 
остальные узлы огибающей также совмещаются с точками соответствующего края рамки 
выделения, равномерно распределенными по его длине (например, если на верхней стороне 
огибающей кроме угловых имеется еще три узла, то с ними будут совмещены точки рамки 
выделения, располагающиеся на расстоянии в одну, две и три четверти от углового маркера 
рамки выделения, как показано на рис. 131); 

 

 

а – исходный объект, 6 – объект заключен в прямоугольную огибающую в режиме Putty, 
в – объект заключен в прямоугольную огибающуюв режиме Original 

Рисунок 131 – Влияние режима заполнения на внешний вид объекта 

 
• Text (Текст) – специальный режим заполнения, который принудительно включается 

при заключении в огибающую рамки простого текста. 
- Раскрывающийся список Add Preset (Добавить заготовку) позволяет заключать объект в 

огибающую одной из стандартных форм. При выборе в списке той или иной заготовки рядом 
появляется схематическое изображение ее формы (рис. 132). Формы заготовок огибающих, как 
было показано на рис. 132, представлены также в пристыковываемом окне Envelope 
(Огибающая). 

 

Рисунок 132 – Некоторые из стандартных форм огибающих 
 

Добавление и удаление огибающей. Чтобы воздействовать на форму объекта или 
группы объектов с помощью огибающей, вначале требуется заключить их в эту огибающую. 
Заключить в огибающую можно также объект или группу объектов, ранее уже заключенную в 
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огибающую. После добавления второй огибающей первая становится недоступной для 
редактирования. Удаляются огибающие также по одной, начиная с добавленной позднее всех 
остальных. 

Чтобы заключить объект или группу объектов в огибающую с помощью инструмента 
Interactive Envelope (Интерактивная огибающая), следует выполнить описанную ниже 
процедуру. 

1. Выберите в панели интерактивных инструментов инструмент Interactive Envelope 
(Интерактивная огибающая). 

2. Щелчком выделите объект (или группу объектов), который будет заключен в 
огибающую. При этом вокруг объекта появляется огибающая прямоугольной формы с восемью 
узлами, и дальнейшие шаги относятся уже к уточнению режимов работы с ней. 

3. Выберите один из режимов редактирования огибающей, щелкнув на соответствующей 
кнопке панели атрибутов: Straight Line (Прямая), Single Arc (Дуга), Double Arc (Волна), 
Unconstrained (Кривая). После этого огибающая будет добавлена, и можно переходить к 
редактированию ее формы. 

Вместо редактирования формы огибающей можно выбрать одну из стандартных форм 
огибающих в списке Add Preset (Добавить заготовку). Чтобы добавить огибающую к объекту 
или группе, ранее заключенной в огибающую, требуется следующая процедура. 

1. Выберите инструмент Interactive Envelope (Интерактивная огибающая). 
2. Выделите щелчком мыши объект, которому требуется дополнительная огибающая. 

Новая огибающая пока не добавляется – по умолчанию выделение объекта в огибающей 
инструментом Interactive Envelope (Интерактивная огибающая) просто включает режим 
редактирования этой огибающей. 

3. Щелкните на кнопке Add New Envelope (Добавить огибающую) панели атрибутов.  
Процедура удаления огибающей выглядит так. 
1. С помощью инструмента Pick (Выбор) выделите объект, из которого требуется 

удалить огибающую. 
2. Щелкните на кнопке Clear Envelope (Удалить огибающую) панели атрибутов или 

выберите команду Effects > Clear Envelope (Эффекты > Удалить огибающую). 
Перед удалением огибающей необходимо отменить все эффекты, которые применялись 

к объекту (или к группе) после заключения его в огибающую. В противном случае огибающая 
оказывается недоступной для удаления и изменения. 

 
Копирование огибающей. Если требуется заключить в одинаковые огибающие 

несколько объектов, можно построить только одну огибающую для первого объекта, а на 
остальные просто скопировать ее. Чтобы скопировать огибающую, выполните описанную ниже 
процедуру. 

1. С помощью инструмента Pick (Выбор) выделите объект, который следует заключить в 
копию ранее построенной огибающей. 

2. Щелкните на кнопке Copy Envelope Properties (Скопировать огибающую) панели 
атрибутов. 

3. Появившемся на экране указателем в виде толстой горизонтальной стрелки щелкните 
на объекте, заключенном в огибающую, которую следует скопировать. 

Если после заключения объекта в огибающую к нему применялись эффекты, огибающую 
скопировать не удастся. 

 
Перемещение узлов огибающей. В общем случае узлы огибающей перетаскиваются 

мышью при выбранном инструменте Interactive Envelope (Интерактивная огибающая). При 
наведении его на пунктирную линию красного цвета, изображающую огибающую, указатель 
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мыши приобретает форму, характерную для инструмента Shape (Форма), что говорит о 
переходе в режим редактирования узлов. Простейший прием изменения формы огибающей – 
перетаскивание ее узлов. Например, на рис. 133,а представлена группа объектов сразу же после 
добавления простейшей огибающей в виде прямоугольника с режимом редактирования Straight 
Line (Прямая). Добавление огибающей само по себе не изменило формы объекта, хотя на 
экране стали отображаться (синей штриховой линией) части контурных линий, перекрытых 
другими объектами группы. На рис. 133,б правый верхний угол огибающей смещен вниз, а на 
рис. 133,в вправо и вниз смещены сразу два верхних угловых узла огибающей. 

 

Рисунок 133 – Изменение формы огибающей перетаскиванием ее узлов 
 

Способы перемещения узлов огибающей зависят от того, какой для нее назначен режим 
редактирования. Если это режим Unconstrained (Кривая), который назначается CorelDRAW по 
умолчанию, имеется возможность одновременного перемещения нескольких узлов в одном 
направлении на одинаковое расстояние. В других режимах редактирования это возможно 
только для пары противоположных узлов 

Чтобы одновременно переместить несколько узлов, требуется следующая процедура 
1. Выберите инструмент Interactive Envelope (Интерактивная огибающая). 
2. Щелкните на объекте, заключенном в огибающую, чтобы выделить ее. 
3. При необходимости переведите огибающую в режим редактирования Unconstrained 

(Кривая), щелкнув на одноименной кнопке панели атрибутов. 
4. Выделите перемещаемые узлы последовательными щелчками мыши при нажатой 

клавише Shift или растянув вокруг них рамку выделения. 
5. Перетащите мышью любой из выделенных узлов – по мере его перемещения все 

выделенные узлы будут перемещаться в том же направлении на то же рас стояние. 
CorelDRAW изменяет форму заключенного в огибающую объекта только после 

окончания текущей операции ее редактирования – в нашем случае после перемещении узлов. 
Перемещение узлов можно ограничить смещением по вертикали или по горизонтали, 

если удерживать нажатой клавишу-модификатор Ctrl. Если в процессе перетаскивания узлов 
огибающей нажать клавишу Esc, огибающая примет форму, которая была у нее до начала 
перетаскивания. 

Чтобы одновременно переместить два узла, лежащих на противоположных сторонах 
огибающей, режим редактирования которой отличается от режима Unconstrained (Кривая), 
необходимо перетащить любой из них при нажатой клавише Ctrl. Если при перетаскивании 
удерживать нажатой клавишу Shift, узлы огибающей будут смещаться на одинаковое 
расстояние, но в противоположных направлениях 

 
Редактирование узлов и сегментов огибающей. Редактирование узлов и сегментов 

огибающей, для которой задан режим редактирования Unconstrained (Кривая), требуется для 
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настройки ее формы и мало отличается от редактирования узлов и сегментов обычной кривой. 
Для огибающих, имеющих другие режимы редактирования, количество и типы узлов 
фиксированы. 

Чтобы изменить тип узла огибающей, выделите его щелчком инструментом Interactive 
Envelope (Интерактивная огибающая), а затем щелкните мышью на одной из кнопок панели 
атрибутов: Make Node A Cusp (Точка излома), Make Node Smooth (Сглаженный узел), Make 
Node Symmetrical (Симметричный узел). 

Для преобразования сегментов огибающей можно воспользоваться расположенными там 
же кнопками Convert Curve Jo Line (Прямолинейный сегмент) и Convert Line То Curve 
(Криволинейный сегмент). 

Манипулируя направляющими точками узлов огибающей, можно управлять 
направлением сегментов на входе и выходе из узла. 

Для добавления нового узла огибающей достаточно выполнить двойной щелчок в той ее 
точке, где должен появиться новый узел, или воспользоваться кнопкой панели атрибутов со 
знаком «плюс». Во втором случае следует предварительно выделить узел, управляющий 
сегментом, в середине которого должен появиться новый узел. Для удаления узла выделите его 
и щелкните на кнопке со знаком «минус» панели атрибутов 

 
Изменение режимов редактирования и заполнения огибающей. Режимы 

редактирования огибающей переключаются с помощью соответствующих им кнопок Straight 
Line (Прямая), Single Arc (Дуга), Double Arc (Волна) и Unconstrained (Кривая) на панели 
атрибутов (см. рис. 130). Следует помнить, что в режим Unconstrained (Кривая) переключиться 
можно всегда, а чтобы переключиться в режимы, предусматривающие более строгие 
ограничения, текущее состояние узлов и сегментов огибающей должно соответствовать этим 
ограничениям. Например, для переключения в режим Straight Line (Прямая) все сегменты 
огибающей должны быть прямолинейными, узлов (типа «точка излома») должно быть ровно 
восемь, стороны должны составлять отрезки прямой. 

Режим заполнения огибающей можно выбирать при помощи раскрывающегося списка 
Mapping Mode (Режим заполнения) на панели атрибутов (см. рис. 130). 

Старайтесь сразу после создания огибающей задать режим ее редактирования в 
соответствии с назначением. Чем меньше ограничений предусматривает режим редактирования 
огибающей, тем более гибкие возможности она предоставляет пользователю, но, одновременно, 
тем больший объем работы требуется для настройки ее формы. Поэтому пользоваться 
огибающей, имеющей режим редактирования Unconstrained (Кривая), рекомендуется только 
когда это действительно оправдано. 

Если в огибающую заключена рамка простого текста, режим заполнения изменить не 
удастся. 

 
Упражнение 1. Модификация формы объекта при помощи огибающих 
В ходе упражнения необходимо изобразить упругую деформацию воздушного шарика и 

нанести на его поверхность надпись таким образом, чтобы возникала иллюзия объема. 
1. В библиотеке клипарта CorelDRAW имеется множество превосходных изображений 

воздушных шариков, поэтому импортируйте изображение продолговатого желтого шарика из 
файла библиотеки \Spec_occ\Misc\Ball0007.cdr. Далее импортируйте изображение игрушечного 
бегемотика из файла \Ammals\Wild\Hippoc.cdr той же библиотеки клипарта, входящей в 
комплект поставки CorelDRAW. Постройте вытянутый по горизонтали прямоугольник, 
который будет играть роль поверхности стола, и поместите шарик так, чтобы веревочка от него 
свисала слева (рис. 134, слева). 
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Рисунок 134 – Исходный объект и огибающая, имеющая режим редактирования Single Arc 
 
2. Выделите шарик, а затем перетащите вправо левый средний маркер рамки выделения 

при нажатой клавише Ctrl. Перед тем как отпустить левую кнопку мыши, щелкните ее правой 
кнопкой, чтобы получилась зеркально отраженная копия шарика. Сдвиньте ее вправо, к краю 
«стола». Отрегулируйте размеры бегемота и перетащите его на копию шарика несколько ниже 
его верхнего края. 

3. Выберите инструмент Interactive Envelope (Интерактивная огибающая) и щелкните на 
копии шарика. Поскольку искажение требуется несложное, вполне достаточно задать режим 
редактирования огибающей Single Arc (Дуга). Все что теперь требуется – перетащить узел, 
расположенный посредине верхней стороны огибающей, вниз, совместив его с уровнем 
нижнего края изображения игрушки. В результате шарик прогнулся под тяжестью бегемота. 

4. Для нанесения надписи импортируйте изображение другого шарика – круглого. Оно 
находится в файле Spec_Occ\Misc\Ball0002.cdr. Разгруппируйте изображение и удалите группу 
объектов, составляющих синий шарик. Красный шарик выделите и немного поверните, чтобы 
веревочка располагалась снизу. Заблокируйте его командой Arrange > Lock Object (Монтаж > 
Заблокировать объект). Выберите инструмент Text (Текст) и щелкните им примерно посредине 
шарика. Задайте выравнивание по центру, щелкнув на соответствующей кнопке панели 
атрибутов, введите с клавиатуры слово Фестиваль и отформатируйте таким кеглем, чтобы 
ширина получившегося текстового блока была примерно в полтора или два раза больше 
ширины шарика. 

5. Теперь следует ввести надпись в габариты шарика с помощью огибающей. Для этого 
добавьте к надписи огибающую тем же приемом, что на шаге 3, только на этот раз в качестве 
режима редактирования огибающей оставьте назначенный по умолчанию режим Unconstrained 
(Кривая). 

6. Отредактировайте огибающую. Прежде всего, немного сожмите огибающую по краям 
надписи. Для этого выделите два верхних угловых узла и сместите их немного вниз. Затем 
сместите на такое же расстояние вверх два нижних угловых узла. 

7. Теперь совместите угловые узлы огибающей с абрисом шарика. Сначала выделите два 
левых угловых узла и перетащите их до совмещения с границей шарика (при нажатой клавише 
Ctrl), а затем проделайте то же самое с правыми угловыми узлами. Совместите с границей 
шарика средние узлы боковых сторон и откорректируйте положение направляющих точек 
угловых узлов так, чтобы боковые границы огибающей совместились с контурной линией 
шарика. Надпись должна «вписаться» в абрис шарика. Однако пока надпись выглядит 
неестественно и разрушает иллюзию его объема, созданную бликами. 

7. Создадим иллюзию, имитирующую размещение надписи на сферической 
поверхности. Для этого нам потребуется изменить назначенный по умолчанию режим 
заполнения огибающей Putty (По углам) режимом Original (По касательным). Это делается 
выбором соответствующей альтернативы в раскрывающемся списке Mapping Mode (Режим 
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заполнения) панели атрибутов. Теперь нужно создать дополнительные узлы огибающей. Они 
должны располагаться примерно так, как показано на рис. 135, слева. Дополнительные узлы 
можно вставлять «на глазок» двойными щелчками мыши в нужных точках огибающей, но в 
нашем случае удобнее делать это с помощью кнопки «плюс» на панели атрибутов, поскольку 
тогда дополнительные узлы будут вставлены точно посредине между существующими, что и 
требуется. Когда все дополнительные узлы будут вставлены, должно получиться что-то 
похожее на рис. 135, справа. 

Самое замечательное в этом способе создания иллюзии – то, что текст, заключенный в 
огибающую, остается текстом, а не преобразуется в кривые. Если его выделить инструментом 
Pick (Выбор), то можно выполнять редактирование и форматирование. На рис. 135 слева внизу 
представлен результат изменения текста в огибающей: изменен не только текст надписи, но и 
гарнитура, а иллюзия, создаваемая огибающей, при этом полностью сохраняется. 

 

Рисунок 135 – Имитация надписи на сферической поверхности с помощью огибающей 
 
На базе описанного приема можно легко построить последовательность кадров 

анимации, демонстрирующей вращение шарика с надписью вокруг вертикальной оси. Чтобы 
получить изображение очередного кадра, достаточно удалить один символ надписи в начале 
текстового блока и добавить один в конце. Последовательность таких кадров приведена на рис. 
136 – надпись «Чествование юбиляра» последовательно прокручивается через огибающую. Для 
полной иллюзии вращения шарика хорошо было бы менять в каждом кадре и положение 
веревочки – самую малость. Получается практически готовый элемент страницы веб-узла – 
остается только собрать последовательность изображений в анимированный ролик. 

 

Рисунок 136 – Последовательность кадров анимации с вращением шарика с надписью 
(не меняющийся фон с изображением шарика не показан) 

 

7.2. Простой текст и огибающие 
Применение огибающих к рамке простого текста имеет одну особенность – в отличие от 

случая с текстом фигурным, символы простого текста, заключенные в огибающую, никогда не 
меняют своей формы. Модификация внешнего вида сводится к изменению конфигурации 
области верстки, то есть могут измениться длины строк, на которые разбивается текст, и 
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местоположение начальных и конечных точек строк. На рис. 137 представлена рамка простого 
текста, заключенная в огибающую, после перемещения и редактирования некоторых узлов 
последней. 

 

Рисунок 137 – Рамка простого текста, заключенная в огибающую 
 

7.3. Деформации 
Деформацией называется обратимое преобразование формы объектов. Основным 

инструментом для этого является инструмент Interactive Distortion (Интерактивная 
деформация). Кроме того, быстро выполнять локальную деформацию зигзага (см. далее) и 
точнее настраивать ее управляющие параметры позволяет инструмент Roughen Brush (Грабли). 

7.4. Инструмент Interactive Distortion 
Добавленную к объекту деформацию можно удалить подобно огибающей, и при этом 

восстановится исходная форма объекта. Из-за весьма специфического характера искажений 
формы объектов, вызываемых этим инструментом, он используется в практической работе 
значительно реже, чем огибающие. 

По технике работы инструмент Interactive Distortion (Интерактивная деформация) похож 
на инструмент Interactive Fill (Интерактивная заливка) – с помощью мыши создается 
управляющая схема, определяющая характер деформации, а затем эта схема корректируется 
перетаскиванием ее отдельных элементов. Используя этот инструмент, можно задавать 
преобразования деформации трех типов: Push and Pull (Центростремительная и центробежная 
деформации), Zipper (Зигзаг) и Twister (Скручивание). У каждого из этих типов деформации – 
собственная управляющая схема и свои элементы управления на панели атрибутов. На рис. 138 
представлены инструмент Interactive Distortion (Интерактивная деформация) и кнопки панели 
атрибутов этого инструмента, с помощью которых выбирается нужный тип деформации. 

 

 

Рисунок 138 – Инструмент Interactive Distortion на панели интерактивных инструментов 
и кнопки выбора типа деформации на панели атрибутов 

 
Деформация Push and Pull. Суть центростремительной деформации состоит в 

принудительном смещении всех узлов деформируемого объекта к центру деформации. 
Центробежная деформация смещает все узлы деформируемого объекта по радиусам от центра 

Интерактивная 
деформация 

Центростремительная и 
центробежная силы 

Зигзаг Скручивание 
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деформации. Если считать объект нарисованным на эластичной пленке, то при выполнении 
этих деформаций края пленки и центр деформации фиксируются, а пленка растягивается или 
сжимается с захватом за точки, в которых расположены узлы. 

Результаты деформации определяются положением центра деформации по отношению к 
объекту и амплитудой – значением, показывающим в процентах, насколько узлы смещаются к 
центру из исходного положения. Отрицательные значения амплитуды соответствуют 
центростремительной деформации, положительные – центробежной. 

Значение амплитуды -50% означает, что все узлы объекта в процессе деформации станут 
в два раза ближе к ее центру, чем в исходном объекте. Значение 0% соответствует отсутствию 
деформации, значение 100% означает, что в процессе деформации узлы отодвинутся от центра 
деформации на расстояние, равное их расстоянию до центра деформации в исходном объекте. 

Центр деформации может устанавливаться произвольно. Если он совпадает с 
центральным маркером рамки выделения деформируемого объекта, такой частный случай 
называется центральной деформацией. 

Однако при деформации этого типа смещаются не только узлы объекта, но и их 
направляющие точки, причем в направлении, противоположном направлению смещения узлов 
(то есть от центра при центростремительной деформации и к центру при центробежной). В 
результате при малых амплитудах середины сегментов объекта практически не смещаются, а 
при больших – смещаются из исходных положений значительно медленнее, чем узлы. 

При деформации все узлы деформируемого объекта преобразуются в точки излома. 
Управляющая схема преобразования деформации состоит из двух элементов. Ромб с 

белой заливкой определяет местоположение центра деформации, а квадрат с белой заливкой – 
ее амплитуду. Если квадрат расположен слева от ромба, амплитуда считается отрицательной 
(центростремительная деформация), а если справа – положительной (центробежная 
деформация). Расстояние между квадратом и ромбом пропорционально амплитуде деформации. 
Ниже представлены результаты центральной центростремительной (то есть амплитуда 
отрицательна) деформации круга с дополнительными узлами. Чтобы было удобнее сравнивать 
результаты с исходным объектом, под деформируемый объект белого цвета подложена его 
копия с серой заливкой. На рис. 139, а абсолютная величина амплитуды равна 150%, на рис. 
139, б - 100%, на рис. 139, в - 50 %, на рис. 139, г - 25 % и на рис. 139, д – 10 %. На рис. 139, д, 
кроме того, показан указатель мыши при выбранном инструменте Interactive Distortion 
(Интерактивная деформация). 

Перед применением деформации представленный на рис. 139 круг для усиления эффекта 
был преобразован в кривую, и посредине каждого из ее сегментов был расположен 
дополнительный узел. Без этого количество лепестков деформированной фигуры равнялось бы 
не восьми, а четырем. 

 

Рисунок 139 – Результаты центростремительной деформации круга 
с различными амплитудами 
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Ниже представлены результаты центральной центробежной (то есть амплитуда 

положительна) деформации того же объекта – круга с дополнительными узлами. На рис. 140, а 
амплитуда равна 10%, на рис. 140, б – 25 %, на рис. 140, в – 50%, на рис. 140, г - 100% и на рис. 
140, д – 150%. 

 

 

Рисунок 140 – Результаты центробежной деформации круга с различными амплитудами 
(управляющая схема показана только для одного варианта, последнее изображение уменьшено) 

 
При смещении центра деформации форма деформированного объекта становится еще 

более причудливой (рис. 141). 

 

Рисунок 141 – Результаты центробежной (слева) и центростремительной деформации круга с 
дополнительными узлами при эксцентричном расположении центра деформации 

 
На рис. 142 представлены элементы панели атрибутов, использующиеся при работе с 

центробежной и центростремительной деформациями. 
 

 
 

Рисунок 142 – Панель атрибутов инструмента Interactive Distortion  
для центробежной или центростремительной деформации 
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Ниже перечислены элементы управления панели атрибутов. 
- Кнопка Add New (Добавить деформацию) предназначена для добавления новой 

деформации к объекту с ранее заданным преобразованием деформации. 
- Счетчик Amplitude (Амплитуда) позволяет точнее, чем с помощью управляющей 

схемы, задать значение амплитуды деформации. 
- Кнопка Center Distortion (Центральная деформация) принудительно совмещает центр 

деформации с центральным маркером рамки выделения объекта. 
- Кнопка Convert To Curves (Преобразовать в кривые) преобразует результат 

деформирования объекта в новый объект, причем как исходный объект, так и заданная для него 
деформация удаляются. 

- Кнопка Copy Distortion Attributes (Копировать деформацию) позволяет заменить 
текущую деформацию объекта деформацией, ранее заданной для другого объекта (см. выше 
описание копирования огибающей). 

- Кнопка Clear Distortion (Удалить деформацию) удаляет последнюю из деформаций, 
заданных для объекта. 

- Раскрывающийся список Preset List (Список заготовок) позволяет добавить к объекту 
деформацию с заранее заданными параметрами. 

Процедуры работы с центробежной и центростремительной деформациями: 
Чтобы добавить деформацию к объекту, следует проделать описанные ниже шаги. 
1. Выберите в наборе инструментов инструмент Interactive Distortion (Интерактивная 

деформация). 
2. Выберите тип деформации щелчком на соответствующей ему кнопке панели 

атрибутов. 
3. Нажмите кнопку мыши при наведенном на деформируемый объект указателе 

инструмента Interactive Distortion (Интерактивная деформация) и, не отпуская кнопки мыши, 
перетащите указатель влево или вправо. В момент отпускания кнопки мыши на объекте 
появится управляющая схема деформации. 

При наведении указателя на объекты, входящие в состав групп, форма указателя будет 
меняться – к нему добавится миниатюрный знак запрета остановки. 

Чтобы сместить центр деформации, перетащите его мышью. По умолчанию центр 
деформации совмещается с центральным маркером рамки выделения объекта. Чтобы вернуть 
его в середину объекта, щелкните на кнопке Center Distortion (Центральная деформация) панели 
атрибутов. 

Чтобы увеличить абсолютное значение амплитуды преобразования, перетаскивайте 
квадрат управляющей схемы от ромба, чтобы уменьшить – к ромбу. 

Нажатие клавиши Esc в процессе перетаскивания элемента управляющей схемы 
возвращает деформируемому объекту состояние, предшествовавшее началу перетаскивания, и 
прерывает операцию редактирования деформации. 

Чтобы отменить последнюю деформацию, примененную к объекту, выделите его 
инструментом Interactive Distortion (Интерактивная деформация) и щелкните на кнопке Clear 
Distortion (Удалить деформацию) панели атрибутов. 

 
Деформация Zipper. Суть деформации зигзага состоит в создании с обеих сторон от 

линии исходного объекта на некотором расстоянии от нее двух последовательностей, 
равномерно распределенных по длине линии точек. Линии исходного объекта заменяются в 
ходе преобразования зигзагом, соединяющим точки этих последовательностей. Количество 
точек в последовательностях определяется частотой деформации, а расстояние точек от линии – 
ее амплитудой. Управляющая схема деформации такая же, как у центробежной и 
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центростремительной деформаций, с одним дополнительным элементом – местоположение 
прямоугольного белого ползунка на прямой, соединяющей ромб и квадрат, определяет частоту 
деформации. Ниже представлены результаты деформации круга. Чтобы результаты было 
удобнее сопоставлять с исходным объектом, круг перед деформированием был дублирован. На 
рис. 143,а значения амплитуды и частоты равны соответственно 100 и 1, на рис. 143,б – 100 и 
10, на рис. 144,в – 45 и 5, на рис. 143,г – 45 и 10. На рис. 143,г показана также управляющая 
схема деформации. 

 

Рисунок 143 – Результаты деформации круга с разными значениями амплитуды и частоты 
 

При регулярной деформации зигзага последовательности точек создаются на равных 
расстояниях от линии объекта, при случайной – расстояние каждой точки от линии 
уменьшается на произвольно выбранный процент. Кроме рандомизации деформация зигзага 
позволяет использовать еще два модификатора: сглаживание узлов и локализацию деформации. 
При включенном сглаживании после деформации в кривой вместо точек излома создаются 
симметричные узлы. Режим локализации деформации позволяет подавлять амплитуду 
деформации на отдельных участках линии объекта. 

При перетаскивании ромба управляющей схемы от центра рамки выделения к линии 
объекта характер деформации меняется. Если режим локализации выключен, при перемещении 
ромба управляющей схемы вслед за ним перемещаются и узлы из внешней по отношению к 
исходному объекту последовательности точек. Результат деформации смещается относительно 
исходного положения объекта, как бы притягиваясь к центру управляющей схемы. Этот эффект 
демонстрируют рис. 144,а и б. В первом случае центр управляющей схемы смещен в правый 
верхний угол рамки выделения объекта, во втором – в левый нижний. При включении режима 
локализации деформации амплитуда деформации при приближении центра управляющей 
схемы не увеличивается, а при удалении – подавляется. При центральной деформации 
включение режима локализации приводит к подавлению амплитуды деформации до нуля по 
всему абрису. Два других примера (рис. 144,в и г) отличаются от предыдущих только 
включенным режимом локализации. 

 

Рисунок 144 – Влияние смещения центра управляющей схемы и режима  
локализации на результат деформации 
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Назначение некоторых элементов управления панели атрибутов см. рис. 145. 
 

 
 

Рисунок 145 – Панель атрибутов инструмента Interactive Distortion для деформации зигзага 
 

Деформация Twister. Деформация скручивания состоит в повороте изображения на 
заданный угол при фиксации одного или нескольких углов рамки выделения и центра 
деформации. При выполнении деформации фиксируются углы рамки выделения объекта, 
наиболее удаленные от заданного центра деформации. 

При центральной деформации скручивания фиксируются все четыре угла рамки 
выделения деформируемого объекта. 

Управляющая схема деформации содержит те же элементы, что центробежная и 
центростремительная деформации: ромб указывает местоположение центра деформации, 
квадрат используется только для фиксации направления оси управляющей схемы. Перетаскивая 
квадрат вокруг ромба по часовой стрелке или против нее, можно задавать угол деформации 
скручивания – ее основной управляющий параметр. Начальное направление оси, 
соответствующее углу деформации 0°, отмечается голубой штриховой линией. 

На рис. 146 представлены два варианта центральной деформации сетки с квадратными 
ячейками для углов 90° (слева) и 180° (справа). На заднем плане видны недеформированные 
копии объектов. 

 

Рисунок 146 – Центральная деформация скручивания сетки с квадратными ячейками 
 

Смещение центра деформации оказывает существенное влияние на внешний вид 
результата деформации. На рис. 147 представлена деформация той же сетки с углом 
деформации 90° и смещением центра деформации по диагонали на один квадрат сетки. 

Поскольку сетка, которая была построена инструментом Graph Paper (Диаграммная 
сетка), представляет собой группу прямоугольников, перед применением деформации 
скручивания ее пришлось разгруппировать и соединить полученные прямоугольники в одну 
кривую командой Combine (Соединить) – эта деформация, как и предыдущие, не может 
применяться к группе объектов. 

Амплитуда Частота 

Сглаживание Рандомизация 

Локализация 
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Рисунок 147 – Влияние смещения центра деформации на внешний вид ее результата 
 

Чтобы добавить деформацию к объекту, следует выполнить описанную ниже процедуру. 
1. Выберите в наборе инструментов инструмент Interactive Distortion (Интерактивная 

деформация). 
2. Выберите тип деформации щелчком па соответствующей ему кнопке напели 

атрибутов. 
3. При наведенном на деформируемый объект указателе инструмента Interactive 

Distortion (Интерактивная деформация) нажмите кнопку мыши в точке, где необходимо 
разместить центр деформации, и, не отпуская кнопку мыши, перетащите указатель в 
произвольном направлении от центра. В момент отпускания кнопки мыши на объекте появится 
управляющая схема деформации. Угол деформации определяется направлением 
перетаскивания мыши. 

Корректировать управляющие параметры деформации удобнее с помощью элементов 
управления панели атрибутов, представленных на рис. 148. 

 

 
 

Рисунок 148 – Панель атрибутов инструмента Interactive Distortion 
для деформации скручивания 

 
Полный угол деформации разбит на два управляющих значения – количество полных 

оборотов по 360° плюс дополнительный угол скручивания. Направление скручивания 
определяется не знаком угла скручивания (он всегда положителен), а специальными кнопками. 
Остальные элементы управления панели атрибутов нам уже знакомы – они работают так же, 
как в случае других деформаций 

 
Упражнение 2. Выполнение интерактивных деформаций 

Постройте изображения, приведенные на рис 139-141, 143-144, 146-147, а затем те, что 
показаны на рис. 149. 

Количество полных 
оборотов

Дополнительный 
угол скручивания

Направление 
деформации 
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Рисунок 149 – Задание к упражнению 2 
 

Рекомендации к построению рис 149: 
Расположенный слева букет астр представляет собой три копии одного изображения 

(белой астры, расположенной посредине). Она построена из нескольких ярусов, 
представляющих собой уменьшенные и повернутые копии внешнего яруса. Последний, в свою 
очередь, представляет собой результат центростремительной деформации кривой с заливкой 
белого цвета, полученной из окружности, на которой расположено 32 узла. 

Чтобы не размещать эти узлы вручную, щелчком на кнопке Convert To Curves 
(Преобразовать в кривые) выделите все узлы кривой, полученной из окружности, и три раза 
подряд щелкните на кнопке добавления узлов (со знаком «плюс») панели атрибутов. 

После того как будет достигнута желаемая форма яруса, преобразуйте деформацию в 
кривую, а затем постройте несколько уменьшенных копий с помощью пристыковываемого окна 
Transformation (Преобразование). Разворачивать уменьшенные копии удобнее буксировкой 
стрелок поворота в рамке выделения. Когда астра будет готова, сгруппируйте все копии. 
Постройте две копии полученной группы и задайте цветные заливки. Разместите копии справа 
и слева от оригинала и слегка деформируйте их с помощью прямолинейной огибающей для 
имитации перспективы, сдвинув одну из боковых сторон вниз. 

Для имитации водоворота (см. рис. 149, справа) постройте высокий и узкий 
равнобедренный треугольник с цветной заливкой, переместите в нем центр поворота в вершину 
угла и постройте несколько копий с поворотом каждой из них. Это также удобнее делать с 
помощью пристыковываемого окна Transformation (Преобразование). Когда треугольники 
образуют полный круг, выделите их все и соедините в одну кривую. К ней-то и следует 
применить деформацию скручивания. 

7.5. Инструмент Roughen Brush 
Инструмент Roughen Brush (Грабли) позволяет быстрее выполнять локальную 

деформацию зигзага и точнее настраивать ее управляющие параметры, чем инструмент 
Interactive Distortion (Интерактивная деформация). Для применения деформации достаточно 
выбрать инструмент, щелкнуть им на кривой, а затем перетащить инструмент вдоль той части 
кривой, на которую требуется нанести зубцы. Возможность указывать часть кривой, к которой 
будет применена деформация, – основное достоинство этого инструмента. 

В качестве примера нарисуем парик снеговику. На рис. 150,а и б показано, как влияет на 
результат применения инструмента Roughen Brush (Грабли) изменение амплитуды. 
Рисунок 150,в иллюстрирует фиксированное направление зубцов, заданное по умолчанию, а на 
рис. 150,г и д зубцы повернуты соответственно на 45° и -45°. 
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Рисунок 150 – Применение инструмента Roughen Brush к верхней четверти круга 
 

Элементы управления эффектом расположены на панели атрибутов инструмента и 
представлены на рис. 151. 

 

Рисунок 151 – Панель атрибутов инструмента Roughen Brush 
 

7.6. Контрольные вопросы 
1. Что такое огибающие деформации? 
2. Назовите основные атрибуты инструмента Interactive Envelope. 
3. Как происходит добавление и удаление огибающих? 
4. Как происходит модификация формы объекта при помощи огибающих? 
5. Как работает инструмент Interactive Distortion (Интерактивная деформация)? 
6. В чем состоит суть центростремительной деформации? 
7. Назовите основные элементы управления панели атрибутов инструмента Interactive 

Distortion. 
8. Для чего предназначен Инструмент Roughen Brush (Грабли)? 
9. Назовите основные элементы управления панели атрибутов инструмента Roughen Brush 

(Грабли). 
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ЛАБОРАТОРНАЯ РАБОТА №8 

РЕЖИМ ОТОБРАЖЕНИЯ ОБЪЕКТОВ НА РАБОЧЕМ ЛИСТЕ 
Цель лабораторной работы: ознакомиться с режимами отображения объектов на рабочем 
столе. 

8.1. Режимы отображения на экране 
В CorelDRAW предусмотрено несколько режимов отображения рисунков на экране с 

различной степенью подробности воспроизведения – от минимальной до полной. 
CorelDRAW позволяет создавать очень сложные изображения, включающие в себя 

огромное количество деталей. Размеры изображений практически не ограничиваются – их 
габариты могут составлять от долей миллиметра до километров, что, конечно же, намного 
превышает практические потребности. Однако даже если размеры рисунка (например, 
рекламного плаката) не очень велики, в натуральную величину он, как правило, на экране 
монитора не помещается. Следовательно, чтобы увидеть рисунок целиком, требуется его 
уменьшить. Обратная задача встает при необходимости выполнить тонкую доработку мелких 
деталей – в этом случае требуется увеличить изображение, отобразив на экране лишь 
небольшую его часть. Подобные задачи решаются в CorelDRAW сменой масштаба отображения 
рисунка и прокруткой рисунка в окне документа. 

В CorelDRAW предусмотрено пять режимов отображения рисунка на экране: Simple 
Wireframe (Упрощенный каркас), Wireframe (Каркас), Draft (Эскиз), Normal (Нормальный) и 
Enhanced (Улучшенный). Вариант отображения выбирается в меню View (Вид), первые пять 
команд которого совпадают по названиям с перечисленными режимами. В разных режимах 
отображения один и тот же объект может выглядеть по-разному (рис. 152). 

 

Рисунок 152 – Различные режимы отображения на экране группы  
экструзии с градиентной заливкой и обводкой 

 
В режиме Simple Wireframe (Упрощенный каркас) не отображаются ни заливки 

объектов, ни контурные линии. Все контуры представлены линиями одинаковой толщины 
черного цвета, независимо от того, какой цвет контура был назначен. Вместо групп, 
образующихся при применении таких эффектов, как экструзии, ореолы и пошаговые переходы, 
изображаются только линии управляющих объектов (рис. 152, а). Включенные в состав рисунка 
точечные изображения отображаются в монохромной шкале цвета. 

В режиме Wireframe (Каркас) отображаются только контуры всех объектов, в том числе 
и контурные линии объектов, построенных при применении эффектов (рис. 152, б). Точечные 
изображения представлены в монохромной шкале цвета. Именно этим режимом чаще всего 
пользуются при настройке формы объектов. 
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В режиме Draft (Эскиз) на экране отображаются все объекты рисунка. Однородные 
заливки изображаются в нормальном виде, градиентные заливки заменяются сплошными. 
Текстурные заливки, а также заливки двухцветным, многоцветным или растровым узором 
отображаются в упрощенном виде – узорами, принятыми по умолчанию (рис. 152, в). Точечные 
изображения выводятся с пониженным разрешением. Эффекты линз заменяются сплошными 
заливками. 

В режиме Normal (Нормальный) все объекты и заливки изображаются без ограничений 
(рис. 152, г). Точечные изображения выводятся с заданным при импорте разрешением. Все 
заливки, кроме заливок PostScript, отображаются без упрощений. Заливки PostScript 
отображаются в виде узора из символов «PS». 

Режим Enhanced (Улучшенный) включен по умолчанию. При отображении линий в этом 
режиме динамическое преобразование в точечное изображение для вывода на экран 
выполняется с удвоенным разрешением (supersampling). Это позволяет уменьшить видимую 
«ступенчатость» наклонных линий (рис. 152). По умолчанию заливки PostScript отображаются 
без упрощений. 

При заметном замедлении (например, при работе со сложным изображением или при 
малой производительности компьютера) режим отображения заливок PostScript можно 
отключить, перейдя в диалоговое окно, раскрывающееся после выбора команды Tools > Options 
(Сервис > Режимы), и выбрав в иерархическом списке в левой части окна пункт Workspace > 
Display (Рабочая среда > Дисплей). 

Если выбрать команду View > Full Screen Preview (Вид > Во весь экран) или нажать 
клавишу F9, то на экране монитора будет отображаться только рисунок, без элементов рабочей 
среды CorelDRAW. По умолчанию для полноэкранного просмотра установлен режим Normal 
(Нормальный). Для возврата в обычный режим отображения достаточно нажать клавишу Esc. 

Начиная с CorelDRAW версии 10, имеется еще один режим просмотра – режим 
сортировки страниц. Его можно задать командой View > Page Sorter View (Bид> Сортировка 
страниц). В этом режиме пользователь видит миниатюры каждой из страниц многостраничного 
документа. Перетаскивая страницы по экрану, можно изменять порядок их следования в 
документе. Выход из режима сортировки страниц выполняется щелчком на кнопке выключения 
режима, появляющейся при переходе в этот режим на панели атрибутов, или повторным 
выбором той же командой меню. 

8.2. Масштабирование и прокрутка  
Масштабом отображения рисунка на экране принято называть соотношение размера 

печатной страницы и размера ее отображения на экране монитора. Это соотношение 
выражается в процентах (например, 1000 % означает, что на экране видна примерно одна 
десятая часть печатной страницы). Масштаб отображения 100 % означает, что печатная 
страница видна в окне документа целиком. 

Поскольку размер окна документа может меняться (например, сокращаться по мере 
раскрытия пристыковываемых окон или при добавлении палитр), размер изображения, 
соответствующий одному и тому же значению масштаба, тоже будет меняться. 

 
Инструмент Zoom. Основным средством изменения масштаба отображения является 

инструмент Zoom (Масштаб), панель которого представлена на рис. 153. 
 

 
 

Рисунок 153 – Панель инструмента Zoom 

Масштаб Прокрутка 
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Инструмент Zoom (Масштаб) позволяет увеличивать и уменьшать масштаб отображения 

несколькими способами. После выбора этого инструмента указатель мыши принимает форму 
миниатюрной лупы, в середине которой изображен знак «плюс». Это подсказка: по умолчанию 
инструмент настроен на увеличение масштаба отображения. 

Если просто щелкнуть левой кнопкой мыши в любой точке окна документа CorelDRAW, 
масштаб отображения увеличится в два раза, причем точка, в которой был выполнен щелчок, 
окажется в центре окна документа. При перетаскивании указателя в виде лупы на экране 
растягивается рамка выделения. По окончании перетаскивания изображение будет увеличено 
так, чтобы выделенная область занимала все окно документа. 

Щелчок правой кнопкой мыши при выбранном инструменте Zoom (Масштаб) по 
умолчанию вызывает уменьшение масштаба отображения в два раза, причем в указателе мыши 
знак «плюс» временно заменяется знаком «минус». 

Функцию правой кнопки мыши можно изменить с помощью группы переключателей, 
расположенной в диалоговом окне, раскрывающемся по команде Tools > Options (Сервис > 
Режимы) с последующим выбором в иерархическом списке в левой части окна пункта 
Workspace > Toolbox > Zoom, Pan Tool (Рабочая среда > Панель инструментов > Инструмент 
Масштаб, Прокрутка). 

Вторая кнопка на панели инструмента Zoom (Масштаб) позволяет выбрать инструмент 
Pan (Прокрутка), с которым мы познакомимся позже. 

 
Панель атрибутов инструмента Zoom и панель инструментов Zoom. Удобные 

средства настройки масштаба отображения предоставляются двумя представленными 
соответственно на рис. 154 и 155 панелями, совпадающими по составу своих элементов 
управления: это панель атрибутов инструмента Zoom (Масштаб) и панель инструментов Zoom 
(Масштаб). 

Панель атрибутов появляется в рабочем пространстве сразу же после выбора 
инструмента Zoom (Масштаб). 

Панель инструментов Zoom (Масштаб) можно ввести в рабочее пространство двумя 
способами. Ее, как и любую панель инструментов, можно открыть, щелкнув правой кнопкой 
мыши на краю любой открытой панели инструментов и выбрав команду Zoom (Масштаб) в 
появившемся контекстном меню. 

 

 
 

Рисунок 154 – Панель атрибутов инструмента Zoom 
 

 

Рисунок 155 – Панель инструментов Zoom 

Страница по высоте 

Масштаб Крупнее 

Мельче 

Только выделенные объекты Все объекты 

Страница целиком 

Страница по ширине 
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Кроме того, эта панель инструментов в полном составе представлена в верхней части 

пристыковываемого окна View Manager (Диспетчер видов), описываемого далее. Рассмотрим 
подробнее работу с инструментами этого окна. 

- Инструмент Zoom In (Крупнее) аналогичен уже знакомому нам инструменту Zoom 
(Масштаб). 

- Инструмент Zoom Out (Мельче) сразу же после выбора уменьшает масштаб 
отображения. Если последнее увеличение масштаба выполнялось растягиванием рамки 
выделения, восстанавливается установленный ранее масштаб. В противном случае масштаб 
отображения просто уменьшается в два раза. Вместо щелчка на кнопке инструмента Zoom Out 
(Мельче) можно нажать клавишу F3. 

Если масштаб отображения несколько раз подряд немного увеличивался с помощью 
рамки выделения, то может показаться, что инструмент Zoom Out (Мельче) не производит 
никакого действия, поскольку масштаб меняется незначительно. 

Чтобы при предварительном просмотре изображения с масштабом 100% размеры 
изображений на экране и печати совпадали, необходимо предварительно выполнить калибровку 
координатных линеек. Эта процедура начинается со щелчка на кнопке Calibrate Rulers 
(Калибровать линейки), расположенной среди элементов управления диалогового окна, 
раскрывающегося по команде Tools > Options (Сервис > Режимы), и последующем выборе в 
иерархическом списке в левой части окна пункта Workspace > Toolbox > Zoom, Pan Tool 
(Рабочая среда > Панель инструментов > Инструмент Масштаб, Прокрутка). В результате экран 
примет вид, представленный на рис. 156 показана только левая верхняя четверть экрана). В 
левом верхнем углу экрана расположены два счетчика, задающих разрешение экрана по 
горизонтали (Horizontal) и по вертикали (Vertical) Значения, указанные в счетчиках, следует 
подобрать так, чтобы деления линеек на экране совпадали с делениями приложенной к экрану 
обычной чертежной линейки. По завершении калибровки щелкните на кнопке ОК. 

 

Рисунок 156 – Вид экрана в процессе калибровки координатных линеек 
 
- Если на рисунке имеется хотя бы один выделенный объект, то выбор инструмента 

Zoom To Selected (Только выделенные объекты) вызовет изменение масштаба изображения 
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таким образом, чтобы выделенные объекты целиком заняли окно документа. Такого же 
результата можно добиться, нажав комбинацию клавиш Shift+F2. 

- Щелчок на кнопке Zoom To All Objects (Все объекты) изменяет масштаб отображения 
таким образом, чтобы все имеющиеся на рисунке объекты поместились в окне документа. Для 
выбора инструмента Zoom To Alt Objects (Все объекты) с помощью клавиатуры служит 
клавиша F4. Инструментом Zoom To All Objects (Все объекты) удобно пользоваться для поиска 
объектов, не связанных ни с одной из страниц документа. 

- Инструмент Zoom To Page (Страница целиком) увеличивает или уменьшает масштаб 
отображения так, чтобы печатная страница целиком поместилась в окне документа. С помощью 
клавиатуры данный инструмент выбирается нажатием комбинации клавиш Shift+F4. 

- Инструмент Zoom To Page Width (Страница по ширине) меняет масштаб отображения 
так, чтобы печатная страница поместилась в окне документа по ширине. 

- Инструмент Zoom To Page Height (Страница по высоте) меняет масштаб отображения 
так, чтобы печатная страница поместилась в окне документа по высоте. 

Изменение масштаба отображения с помощью стандартной панели инструментов 
На стандартной панели инструментов имеется раскрывающийся список уровнен 

увеличения, представленный на рис. 157. 

 

Рисунок 157 – Стандартные альтернативы списка масштабов отображения 
 
Первые пять альтернатив списка эквивалентны по действию следующим инструментам 

панели инструментов Zoom (Масштаб): Zoom To Selected (Только выделенные объекты), Zoom 
To All Objects (Все объекты), Zoom To Page (Страница целиком), Zoom To Page Width 
(Страница по ширине целиком), Zoom To Page Height (Страница по высоте целиком). 
Остальные альтернативы позволяют выбрать любое из приведенных значений коэффициента 
масштабирования при отображении. Поле ввода этого комбинированного списка позволяет 
вводить любое числовое значение коэффициента в диапазоне от 1 до 405 651%. Первое из этих 
значений позволяет поместить в окно документа целиком страницу со стороной около 30 
метров, а второе – со стороной примерно 0,05 мм. 

При необходимости можно сохранить введенный в поле списка масштаб отображения 
для повторного применения. Для этого после изменения масштаба отображения введите в поле 
списка текстовое название нового масштаба и нажмите клавишу Enter. При последующем 
раскрытии списка вновь заданные режимы появляются в его нижней части в качестве 
дополнительных альтернатив. 

 
Прокрутка. Прокруткой называется перемещение рисунка в окне документа. Конечно, в 

CorelDRAW реализован стандартный для интерфейса Windows метод прокрутки с помощью 
полос прокрутки – горизонтальной и вертикальной, но также имеется и специальный 
инструмент для выполнения этого действия. 
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Прокрутка с помощью инструмента Pan. При выборе инструмента Pan (Прокрутка) на 

панели инструмента Zoom (Масштаб) или инструмента однократной прокрутки указатель 
мыши приобретает форму кисти руки. Перетаскивание этим указателем любой точки рисунка 
перемещает эту точку в окне документа, совмещая ее с позицией, в которой освобождается 
кнопка мыши. Таким образом, если нажать кнопку мыши в нижней части окна и перетащить 
указатель снизу вверх, рисунок также сместится вверх, показывая свою часть, ранее скрытую 
под нижним краем окна документа. 

 
Прокрутка с помощью клавиатуры. Прокрутку можно выполнять и без помощи 

мыши. Нажатие клавиш управления курсором при удерживаемой клавише-модификаторе Alt 
приводит к прокручиванию рисунка в соответствующем направлении 

8.3. Диспетчер видов 
Пристыковываемое окно View Manager (Диспетчер видов) предоставляет пользователю 

возможность запоминать виды: варианты отображения частей рисунков, сопоставляя каждой из 
них содержательное имя и масштаб отображения. Пристыковываемое окно View Manager 
(Диспетчер видов) представлено на рис. 158. 

 

Рисунок 158 – Пристыковываемое окно диспетчера видов 
 

Для каждого из сохраненных видов (на рисунке области, соответствующие этим видам, 
обозначены пунктиром) сохраняется название, номер страницы и коэффициент 
масштабирования при отображении. Видам соответствуют отдельные строки в окне диспетчера. 

Дополнительно к перечисленным параметрам для каждого вида запоминается 
расположение рисунка по отношению к окну документа, хотя эти сведения и невидны в списке 
видов. Благодаря этому при переходе к виду восстанавливается не только масштаб 
отображения, но и положение рисунка в окне. 

Чтобы раскрыть пристыковываемое окно диспетчера видов, следует выбрать команду 
Window > Dockers > View Manager (Окно > Пристыковываемые окна > Диспетчер видов) или 
нажать комбинацию клавиш Ctrl+F2. 

Чтобы сохранить новый вид, следует вначале выбрать страницу рисунка и задать, 
желаемый масштаб отображения. Затем необходимо щелкнуть на расположенной в заголовке 
пристыковываемого окна View Manager (Диспетчер видов) кнопке со знаком «плюс» или 
выбрать команду New (Создать) в раскрывающемся меню этого окна. Новый вид будет 
добавлен в список; остается только переименовать его, задав с помощью команды Rename 
(Переименовать) того же меню содержательное название. 

Чтобы перейти к ранее запомненному виду, следует выполнить двойной щелчок на 
строке, соответствующей этому виду, пли выбрать в меню пристыковываемого окна команду 
Switch To View (Перейти к виду). 
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Щелкать можно в любой части строки вида, кроме имени. Если двойной щелчок 

выполняется на имени, активизируется режим переименования вида. 
Чтобы удалить ранее созданный вид, выделите его щелчком мыши на соответствующем 

строке списка, а затем щелкните на кнопке со значком «минус» или выберите в меню 
пристыковываемого окна команду Delete (Удалить). 

Ввод имени в поле ввода комбинированного списка масштабов отображения на 
стандартной панели инструментов автоматически приводит к внесению в список запомненных 
видов и этого именованного масштаба. В качестве остальных параметров будут внесены 
параметры отображения рисунка, находившегося в окне документа в момент ввода имени. 

Слева от названия вида располагаются две колонки значков – в виде лупы и в виде 
страницы (см. рис. 159). Они управляют способом переключения режима отображения при 
переходе к выбранному виду. Щелчок на любом из этих значков мышью переключает режим из 
включенного состояния (яркий значок) в выключенное (тусклый значок), и наоборот. 

Выключение значка со страницей отключает переход на запомненную страницу при 
переходе к выбранному виду – восстанавливаются только масштаб отображения и положение 
рисунка по отношению к окну документа. 

Выключение значка с лупой отключает восстановление запомненных масштаба 
отображения и положения рисунка по отношению к окну документа – выполняется только 
переход на запомненную страницу документа. 

Выключение обеих значков приводит к тому, что при переходе к выбранному виду не 
выполняется никаких действий. 

 

8.4. Контрольные вопросы 
1. Какие существуют режимы отображения рисунков на экране? 
2. Как происходит масштабирование и прокрутка рисунка на экране? 
3. Назовите основные элементы управления панели атрибутов инструмента Zoom. 
4. Как происходит прокрутка рисунка инструментом Pan? 
5. Для чего используется диспетчер видов? 
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ЛАБОРАТОРНАЯ РАБОТА №9 

УПОРЯДОЧИВАНИЕ ОБЪЕКТОВ НА ЭКРАНЕ 
Цель лабораторной работы: ознакомиться с элементы рабочей среды. Научиться 
распределять объекты на рабочем столе 

9.1. Линейки 
Линейками называются элементы рабочей среды, имеющие вид узких панелей, 

размеченных в текущих единицах измерения. Линейки располагаются вдоль верхнего и левого 
краев окна документа и позволяют наглядно судить о реальных размерах объектов рисунка. 

Текущие единицы измерения проще всего задать с помощью списка на панели 
атрибутов, появляющейся при отмене выделения всех объектов рисунка (рис. 159). 

 

Рисунок 159 – Список выбора единиц измерения для разметки координатных линеек 
 

Некоторые единицы измерения общеизвестны, некоторые могут показаться 
незнакомыми. 

- Inches (Дюймы) – единица измерения, принятая по умолчанию. Дюйм равен 
приблизительно 25,4 мм. 

- Millimeters (Миллиметры) – основная единица измерения в соответствии с российскими 
стандартами оформления графических документов, поэтому рекомендуется сразу же изменить 
разметку линеек на миллиметры, если нет веских причин для выбора других единиц. 

- Picas; points (Пики и пункты) – основные полиграфические единицы измерения длины. 
Пункт равен 1/72 дюйма, или приблизительно 0,35 мм. Пика равна 12 пунктам. В этих единицах 
константа 1,5 означает одну пику и пять пунктов, то есть 17 пунктов. Традиционной областью 
применения этих единиц остается задание высоты символов текста и связанных с текстом 
интервалов (например, величины интерлиньяжа). 

- Pixels (Пикселы) – относительные единицы измерения, равные размеру элементарного 
фрагмента точечного изображения (пиксела). 

Реальная разметка линейки в пикселах зависит от разрешения – количества пикселов на 
единицу длины экрана. По умолчанию разрешение установлено 300 dpi (точек на дюйм). При 
подготовке рисунков для Web рекомендуется изменить это значение на 72 dpi. 

- Ciceros; didots (Цицеро и дидо) – полиграфические единицы длины, использующиеся 
практически только во Франции и Канаде. Дидо равен 1,07 пункта, или приблизительно 0,38 
мм. Цицеро равен 12 дидо. 

- Feet (Футы) – производная от дюйма единица длины. Фут равен 12 дюймам, пли 
приблизительно 305 мм. 

- Yards (Ярды) – производная от фута единица длины. Ярд равен 3 футам, или 
приблизительно 915 мм. 
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- Miles (Мили) – производная от фута единица длины. Одна миля равна 5280 футам, или 
приблизительно 1609 м. 

- Centimeters (Сантиметры), Meters (Метры), Kilometers (Километры) – производные 
единицы измерения, использующиеся в графических документах достаточно редко. 

- Q и Н – специальные единицы измерения, численно равные четверти миллиметра. 
Помимо смены единиц измерения с координатными линейками можно выполнять еще 

две операции: перемещение линеек в рабочем пространстве и перемещение нулевых отметок 
шкал. 

Чтобы переместить координатную линейку внутрь окна документа, достаточно 
перетащить в нужном направлении любую ее точку при нажатой клавише Shift. Таким образом 
можно приблизить линейку к тому или иному объекту или, например, перенести 
горизонтальную координатную линейку в более привычное со школьных времен положение 
снизу от рисунка. Чтобы возвратить линейки в стандартные положения, достаточно выполнить 
на любой из них двойной щелчок при нажатой клавише Shift. 

Чтобы переместить нулевые отметки на шкалах линеек (а вместе с ними – и начало 
абсолютной системы координат рисунка), достаточно перетащить кнопку, расположенную на 
пересечении линеек. Новое начало координат будет совмещено с точкой, в которой будет 
освобождена кнопка мыши. Для возвращения начала координат в исходное положение 
достаточно выполнить двойной щелчок на пересечении координатных линеек. 

При создании нового документа начало его системы координат по умолчанию 
совмещается с левым нижним углом листа выбранного формата. Положительные направления 
осей координат – вправо и вверх 

9.2. Координатные сетки 
Координатной сеткой называется совокупность горизонтальных и вертикальных линий, 

размещенных с фиксированным шагом. Эти линии располагаются на отдельном слое, 
недоступном для редактирования, поэтому их невозможно изменить. Кроме того, объекты, 
расположенные на этом слое, по умолчанию даже не отображаются на экране. 

Чтобы увидеть координатную сетку, выберите команду View > Grid (Вид > 
Координатная сетка). Цветные линии координатной сетки появятся на экране, закрывая 
«сеткой» с прямоугольными ячейками все пространство окна документа (рис. 160). 

Обратите внимание на то, что в начале координат страницы находится пересечение 
горизонтальной и вертикальной линий сетки. Остальные линии проведены параллельно им с 
заданным шагом. Конечно, на листе бумаги в клеточку рисовать удобнее, но если бы 
возможности координатной сетки ограничивались только ее отображением на экране, такой 
инструмент был бы не слишком полезен. 

Команда View > Snap To Grid (Вид > Привязать к сетке) включает режим привязки к 
линиям сетки. То есть все вновь создаваемые, редактируемые или перемещаемые объекты 
будут «притягиваться» к линиям координатной сетки. Это позволяет выравнивать объекты и 
строить новые объекты с габаритными размерами, кратными шагу координатной сетки.  

На панели атрибутов, появляющейся при отмене выделения всех объектов, имеется 
кнопка Snap To Grid (Привязать к сетке), которая позволяет быстро включать или отключать 
режим привязки к сетке. 

В режиме привязки к сетке к ближайшему узлу координатной сетки привязывается 
структурный элемент выделенного объекта, располагающийся при перетаскивании ближе всего 
к указателю мыши, – его название отображается на экране цветной надписью. Если 
воспользоваться метафорой, то можно сказать примерно так: та точка контура, за которую мы 
перетаскиваем объект, и привязывается к узлам и линиям координатной сетки. 

При перетаскивании объекта за средний маркер рамки выделения к сетке привязывается 
центр этого объекта. Чтобы задать шаг линий координатной сетки, проделайте следующую 
процедуру. 

1. Выберите команду Tools > Options (Сервис > Режимы) 
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2. В иерархическом списке, расположенном в левой части раскрывшегося диалогового 
окна, выберите пункт Document > Grid (Документ > Координатная сетка). 

 

 

Рисунок 160 – Координатная сетка с шагом 25 мм по обеим координатам 
 
Оба этих шага можно объединить в одном, выбрав команду View > Grid And Ruler Setup 

(Вид > Настройка сетки и линеек). 
3. В раскрывшемся диалоговом окне настройки координатной сетки (рис. 161) 

установите переключатель Spacing (Шаг). Это позволит задать на следующем шаге расстояние 
между смежными линиями сетки. При установке переключателя Frequency (Частота) можно 
задать количество линий сетки, приходящихся на одно деление шкалы координатной линейки. 

 

Рисунок 161 – Диалоговое окно настройки параметров координатной сетки 
 

5. В счетчиках Horizontal (По горизонтали) и Vertical (По вертикали) в области Spacing 
(Шаг) установите значения шага сетки по горизонтали и по вертикали соответственно и 
щелкните на кнопке ОК. 
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9.3. Направляющие 
Координатная сетка удобна для равномерного размещения объектов, но для решения 

многих задач не требуется такого числа линий, притягивающих к себе объекты. Более того, из-
за координатной сетки могут возникать неожиданные затруднения. 

Направляющая линия обладает всеми свойствами отдельной линии координатной сетки, 
но размещается на странице индивидуально и в любом месте. Активность направляющих 
определяется включением или выключением режима Snap To Guides (Привязать к 
направляющим), выполняемом с помощью одноименной команды меню View (Вид) или кнопки 
панели атрибутов. 

Чтобы создать направляющую, достаточно перетащить внутрь окна документа 
произвольную точку любой из координатных линеек. После освобождения кнопки мыши в 
конце перетаскивания на экране появится цветная направляющая линия. Горизонтальные 
направляющие перетаскиваются с горизонтальной линейки, а вертикальные – с вертикальной. 
Вновь созданная направляющая остается выделенной. В отличие от объектов вокруг 
выделенной направляющей не строится рамка выделения – наличие выделения определяется по 
присутствию в рабочем пространстве панели атрибутов направляющих, представленной на рис. 
162. Кроме того, выделенные направляющие меняют свой цвет на красный. 

Направляющие линии размещаются на отдельном слое Guides (Направляющие) и, в 
отличие от координатной сетки, по умолчанию отображаются на экране. Кроме того, с 
направляющей можно выполнять некоторые операции редактирования и форматирования. В 
частности, направляющую можно выделить инструментом Pick (Выбор), перетащить и 
повернуть. Можно даже назначить цвет выделенной направляющей, щелкнув правой кнопкой 
мыши на образце экранной палитры. 

Чтобы выделить сразу все направляющие, можно воспользоваться командой Edit > Select 
All > Guidelines (Правка > Выделить все > Направляющие). 

 

 
 

Рисунок 162 – Панель атрибутов направляющих 
 

На панели атрибутов направляющих имеются следующие элементы управления. 
- Пара полей в левой части панели содержат координаты точки, через которую проходит 

направляющая. Если направляющая горизонтальна или вертикальна, один из счетчиков 
недоступен. 

- Следующее поле содержит угол наклона направляющей к горизонтали в градусах. 
- Далее располагается пара полей с координатами центра поворота направляющей. Если 

щелкнуть мышью на выделенной направляющей, на ней появится маркер центра поворота в 
виде круга с точкой посредине. Если этот маркер перетащить, то последующие повороты 
направляющей при изменении ее наклона будут осуществляться вокруг заданного таким 
образом центра поворота. 

- Кнопка блокировки позволяет запретить последующее выделение выделенных 
направляющих и, таким образом, делает невозможным их редактирование. Чтобы отменить 
блокировку, следует щелкнуть на блокированной направляющей правой кнопкой мыши и 
выбрать в контекстном меню команду Unlock Object (Разблокировать объект). 

Привязать к направляющим 

Типовые 
направляющие 

Настройка 
направляющих 

Координаты центра поворота 

Угол наклона Координаты 
опорной точки 

Блокировка 
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- Кнопка привязки к направляющим позволяет включить или выключить режим 
привязки к направляющим (см. выше). 

- Кнопка типовых направляющих раскрывает на экране диалоговое окно, позволяющее 
добавить на страницу один или несколько типовых наборов направляющих (например, 
отделяющих поля шириной 1 см со всех сторон страницы или ограничивающих область 
страницы, воспроизводимую при печати на выбранном принтере). 

- Кнопка настройки направляющих раскрывает на экране диалоговое окно, на трех 
вкладках которого представлены все управляющие параметры каждой из заданных к этому 
моменту направляющих. С помощью расположенных на этих вкладках элементов управления 
можно выполнить точную настройку направляющих. 

Чтобы переместить ранее построенную направляющую, достаточно перетащить ее на 
новое место мышью или выделить щелчком мыши и откорректировать координаты опорной 
точки на панели атрибутов. 

Чтобы превратить направляющую в наклонную, достаточно выделить ее и щелкнуть на 
ней еще раз. Перетаскивая появившиеся на экране стрелки и маркер центра поворота, можно 
придать направляющей желаемый наклон (рис. 163), который впоследствии можно уточнить 
при помощи панели атрибутов. 

Для удаления направляющей достаточно выделить ее и нажать клавишу Delete. 
При работе с направляющими применимы многие приемы работы с объектами. 

Например, удерживая клавишу Shift, можно выделить сразу несколько направляющих. Если 
перед окончанием перетаскивания или наклона направляющей щелкнуть правой кнопкой 
мыши, преобразована будет не выделенная направляющая, а ее копия. 

 

 
 

Рисунок 163 – Наклон направляющей мышью 
 
В качестве направляющих могут использоваться ранее созданные объекты. Чтобы они 

«притягивали» к себе перемещаемые объекты, следует включить режим Snap to Objects 
(Привязать к объектам) одноименной командой меню View (Вид). Поведение объектов в 
качестве направляющих мало отличается от поведения настоящих направляющих и линий 
координатной сетки – этим свойством они стали обладать только в версии 12 программы. Ранее 
«притягивающими свойствами» объектов обладали только точки присоединения примитивов и 
узлы линий. Контурные линии объектов такими свойствами не обладали.  

Параметры режима привязки к объектам можно настраивать с помощью диалогового 
окна (рис. 164), раскрыть которое можно командой View > Snap To Objects Setup (Вид > 
Настройка привязки к объектам). 

Ниже перечислены флажки, представленные в области Modes (Режимы).  
- Node (Узел) – привязка к любому из узлов объекта. 
- Intersection (Пересечение) – привязка к любой из точек пересечения контуров объектов. 
- Midpoint (Середина) – привязка к середине сегмента контура объекта. 
- Quadrant (Квадрант) – привязка к точкам контура объекта (окружности, эллипса, 

сектора или дуги), имеющим относительно его центра угловые координаты 0°, 90°, 130° и 270°. 
- Tangent (Касательная) – привязка к точке касания (точке на контуре объекта, в которой 

привязываемый объект будет касаться контура, но не пересекать его). 
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- Perpendicular (Перпендикуляр) – привязка к нормали (точке на контуре объекта, в 
которой линия контура привязываемого объекта будет перпендикулярна линии контура 
объекта, к которому выполняется привязка). 

 

Рисунок 164 – Диалоговое окно настройки режима привязки к объектам 
 

- Edge (Кромка) – привязка к произвольной точке контура объекта. 
- Center (Центр) – привязка к среднему маркеру рамки выделения объекта (середине 

объекта) 
- Text Baseline (Базовая линия текста) – привязка к произвольной точке базовой линии 

текста. 
С помощью флажков можно задать любое сочетание режимов привязки к объектам. В 

раскрывающемся списке можно выбрать величину, на которую достаточно приблизить 
перемещаемый объект к точке привязки, чтобы произошло притягивание к этой точке. 

Если объект планируется использовать только в качестве направляющей, удобнее не 
включать режим привязки к объектам (поскольку он действует на все объекты рисунка), а 
поместить объект на слой Guides (Направляющие).  

В CorelDRAW предусмотрен совершенно новый режим динамических направляющих, не 
поддерживающийся в предыдущих версиях. Он включается командой View > Dynamic Guides 
(Вид > Динамические направляющие). Когда этот режим включен, то по мере перетаскивания 
привязываемого объекта на экране появляются и пропадают направляющие, проходящие через 
возможные точки его привязки к другим объектам. Эти направляющие обладают всеми 
свойствами обычных направляющих, но по окончании операции перетаскивания они 
пропадают с экрана. Настройка режима отображения динамических направляющих 
выполняется с помощью диалогового окна, раскрывающегося командой View > Dynamic Guides 
Setup (Вид > Настройка динамических направляющих). Это окно представлено на рис. 165. 

С помощью элементов управления, расположенных в этом окне, можно выбрать те 
динамические направляющие, которые должны отображаться. В примере, представленном на 
рисунке, кроме направляющих, проведенных с интервалом 45° (они отображаются по 
умолчанию), заказано отображение еще одной направляющей, проведенной под углом 30°. 
Динамические направляющие позволяют разгрузить изображение, отказавшись от вывода 
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статических направляющих. Однако нужно иметь в виду, что при сильно загруженном 
объектами изображении разобраться, какому именно узлу соответствует отображаемая в тот 
или иной момент динамическая направляющая, может оказаться непросто 

 

 

Рисунок 165 – Диалоговое окно настройки параметров динамических направляющих 
 

9.4. Выравнивание объектов 
Выравниванием называется размещение всех выделенных объектов таким образом, 

чтобы их определенные точки (например, середина рамки выделения) располагались на одной 
прямой. 

Применение координатной сетки и направляющих позволяет выравнивать объекты с 
высокой точностью, но для этого требуется много дополнительных операций: нужно создать 
направляющую или задать параметры координатной сетки, а затем индивидуально перемещать 
каждый из объектов. В CorelDRAW предусмотрен мощный инструмент, автоматизирующий 
выстраивание объектов в ряд вдоль прямой, положение которой задается одним из 
выравниваемых объектов или страницей документа. 

Далее предполагается, что прямая, задающая направление ряда размещаемых объектов, 
всегда параллельна тому или иному краю печатной страницы. Выравнивание объектов по 
наклонной прямой возможно только в режиме привязки к наклонной направляющей. В этом 
случае все объекты придется перемещать к желаемым позициям «вручную». 

Команда Arrange > Align and Distribute (Монтаж > Выровнять и распределить) и кнопка 
Align (Выровнять) на панели атрибутов раскрывают диалоговое окно, с помощью первой 
вкладки которого можно автоматически выровнять середины или края рамок выделения 
объектов по горизонтали и/или вертикали (рис. 166). 

Расположенные в верхней и левой стороне диалогового окна флажки определяют, 
которые именно точки выделенных объектов будут выровнены при их автоматическом 
перемещении. 
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Рисунок 166 – Вкладка Align диалогового окна Align and Distribute 
 

Верхний из двух раскрывающихся списков позволяет модифицировать режим 
выравнивания. В нем имеются следующие альтернативы: 

- Active objects (Выделенные объекты) – перемещение объектов при выравнивании и 
распределении не выходит за границы их общей рамки выделения; 

- Edge of page (Границы страницы) – объекты перемещаются в пределах печатной 
страницы; 

- Center of page (Середина страницы) – объекты выравниваются относительно 
воображаемых направляющих, проведенных по вертикали и горизонтали через середину 
печатной страницы; 

- Grid (Координатная сетка) – выделенные объекты выравниваются относительно линий 
координатной сетки. 

Общая схема работы с этим диалоговым окном достаточно проста, но ее следует четко 
придерживаться – в противном случае результаты выравнивания могут оказаться весьма 
далекими от желаемых. 

1. Необходимо определить, где будет располагаться линия, по которой будут 
выравниваться объекты. Альтернатив несколько: она может совпадать с любым из краев 
печатной страницы, проходить через середину печатной страницы, проходить через середину 
или совпадать с любым из краев рамки выделения одного из выравниваемых объектов. Если 
положение линии выравнивания задается одним из выравниваемых объектов, его следует 
разместить желаемым образом. 

2. Выделите все выравниваемые объекты. Если положение линии выравнивания задается 
одним из выравниваемых объектов, он должен быть выделен последним. Это очень важно, 
поскольку именно по этому признаку CorelDRAW определяет, который из выделенных 
объектов задает линию выравнивания. 

При выделении объектов щелчками мыши при нажатой клавише Shift с этим 
требованием сложностей не возникает. Однако если выделять объекты растягиванием рамки 
выделения, последним выделенным будет считаться объект, расположенный ниже других в 
стопке объектов. Это далеко не всегда совпадает с тем, что задумано. Чтобы гарантировать себя 
от неприятностей при последующем выравнивании, после выделения объектов растягиванием 
рамки нажмите клавишу Shift и щелкните мышью на объекте, задающем положение линии 
выравнивания. Это выведет его из состава выделения. А затем, не отпуская клавишу Shift, 
щелкните на нем еще раз. Это добавит его в выделение, но теперь-то он точно будет последним 
из выделенных объектов! 

3. Установите флажки, указывающие, какие точки объектов будут «выстраиваться» по 
линии. Если объекты должны выравниваться по горизонтальной линии, это могут быть верхние 
маркеры рамки выделения (флажок Тор), середина рамки выделения (флажок Center) или 
нижние маркеры рамки выделения (флажок Bottom). Если объекты будут выравниваться по 
вертикальной линии, это могут быть левые маркеры рамки выделения (флажок Left), середина 
рамки выделения (флажок Center) или правые маркеры рамки выделения (флажок Right). 

Если выбранные на предыдущем шаге точки объектов должны совместиться с краем 
печатной страницы, выберите в верхнем раскрывающемся списке вариант Edge of Page 
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(Границы страницы). Если эти точки следует выровнять по средней линии листа, выберите 
вариант Center of Page (Середина страницы). 

После выбора варианта Center of Page (Середина страницы) все остальные флажки 
вкладки автоматически сбрасываются, и устанавливаются оба флажка Center. Если в ваши 
планы не входит собрать все выделенные объекты в середине печатной страницы, один из этих 
флажков следует сбросить. 

5. Остается только щелкнуть на кнопке Apply (Применить). Если результат 
выравнивания неудовлетворителен, следует, не закрывая диалогового окна, вернуться к шагу 3 
и попробовать установить флажки еще раз. Окончательный вариант выравнивания фиксируется 
при закрытии диалогового окна. 

Если одновременно установить по одному флажку в группах выравнивания по 
горизонтали и вертикали, в результате выравнивания будут совмещены выбранные точки всех 
выделенных объектов. Например, одновременная установка флажков Left (По левому краю) и 
Тор (По верху) приведет к перемещению всех выделенных объектов в левый верхний угол 
страницы. Кстати, это удобный способ размещения единственного выделенного объекта на 
краю или в углу страницы.  

 
Упражнение 1. Выравнивание объектов 
 

В ходе выполнения этого упражнения мы импортируем стандартные рисунки, которые в 
терминологии CorelDRAW называются клипартом, из библиотеки клипарта, входящей в 
комплект поставки программы, и воспользуемся ими для отработки приемов выравнивания. 

1. Создайте новый документ CorelDRAW и задайте альбомную ориентацию его 
страницы, на панели атрибутов страницы щелкнув на кнопке с прямоугольником, вытянутым 
по горизонтали. 

2. Для импорта клипарта воспользуйтесь компакт-диском с библиотекой клипарта, 
входящим в комплект поставки CorelDRAW. Для импорта рисунков из этой библиотеки можно 
воспользоваться командой File > Import (Файл > Импорт). Диалоговое окно, раскрывающееся 
по этой команде, похоже на диалоговое окно открытия файла. Выберите устройство чтения 
компакт-диска и папку с нужными изображениями (в нашем примере используются рисунки из 
папки \Animals\). Чтобы было удобнее подбирать подходящее изображение, не забудьте 
установить в диалоговом окне флажок Preview (Предварительный просмотр). После щелчка на 
кнопке ОК выберите подходящее место для рисунка и перетащите указатель мыши по 
диагонали воображаемого прямоугольника, отведенного для его размещения. Импортируйте 
три рисунка и разместите их на странице примерно так, как показано на рис. 167. При 
необходимости откорректируйте размеры и размещение рисунков. 

 

Рисунок 167 – Исходное положение объектов для выравнивания 
 
Большинство рисунков из библиотеки клипарта представляют собой группы объектов 

(подтверждение этому можно найти в строке состояния после выделения любого из 
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импортированных рисунков), но в плане выравнивания они вполне эквивалентны объектам. 
Если в вашем распоряжении нет библиотеки клипарта или вы не хотите возиться с импортом, 
вместо стандартных рисунков можно построить любые объекты, например прямоугольник, 
эллипс и многоугольник. 

3. Начнем с выравнивания объектов по краю страницы. Выделите все объекты, растянув 
вокруг них рамку выделения инструментом Pick (Выбор). Чтобы совместить левый край 
объектов с левым обрезом страницы, вызовите диалоговое окно выравнивания щелчком на 
кнопке Align (Выровнять) панели атрибутов, задайте параметры выравнивания в соответствии с 
рис. 168 и щелкните на кнопке Apply (Применить). Перед тем как закрыть диалоговое окно, 
попробуйте поочередно установить вместо флажка Left (По левому краю) флажки Center (По 
центру) и Right (По правому краю), что приведет к размещению объектов в середине страницы 
и по ее правому краю, а затем вернитесь к исходному варианту. 

 

Рисунок 168 – Выравнивание объектов по левому краю страницы 
 

4. Теперь выровняем рисунки по вертикальной линии, совпадающей с правой стороной 
рамки выделения одного из рисунков. Для этого отмените выделение объектов, нажав клавишу 
Esc, и снова выделите все объекты, но на этот раз – поочередно, при нажатой клавише Shift, 
сначала – льва, затем – корову и последним – слона. Раскройте диалоговое окно выравнивания, 
настройте параметры выравнивания в соответствии с рис. 169 и щелкните на кнопке Apply 
(Применить). Отмените последнюю операцию, отмените выделение объектов, выделите их 
снова так, чтобы последним был выделен рисунок с пумой, и повторите выравнивание по 
правому краю. Сравните результат с предыдущим. 

 

Рисунок 169 – Выравнивание производится по правому краю объекта, выделенного последним 
 
5. Выровняем объекты по верхнему краю страницы, предварительно вернув их в 

исходное положение (по диагонали листа, как показано на рис. 167) с помощью инструмента 
Pick (Выбор) или кнопки отмены последнего действия, расположенной на стандартной панели 
инструментов. Поскольку при выравнивании по краю или середине страницы порядок 
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выделения объектов не важен, выделите все рисунки, растянув вокруг них рамку выделения, 
раскройте диалоговое окно выравнивания, настройте параметры выравнивания, как показано на 
рис. 170, и щелкните на кнопке Apply (Применить). 

 

Рисунок 170 – Выравнивание верхних краев объектов по верхнему обрезу страницы 
 
6. В заключение выровняем середины рисунков по вертикальной средней линии 

страницы. Отмените предыдущее выравнивание, чтобы объекты заняли исходное положение 
(по диагонали страницы), выберите в верхнем списке окна выравнивания режим Center of Page 
(Середина страницы) и не забудьте сбросить находящийся слева флажок Center (По центру), в 
противном случае все звери соберутся в кучу в середине страницы. Результат представлен на 
рис. 171. Далее поработайте самостоятельно, задавая различные сочетания параметров 
выравнивания в диалоговом окне Align and Distribute (Выровнять и распределить) и наблюдая 
за результатами. 

 

Рисунок 171 – Выравнивание объектов по середине страницы 
с сохранением их положения по вертикали 

 
В заключение следует сказать несколько слов о случае, когда в число выравниваемых 

объектов входят объекты текстовые: фигурный текст или простой текст. В этом случае в 
действие вступает нижний раскрывающийся список вкладки выравнивания диалогового окна 
Align and Distribute (Выровнять и распределить). В нем имеются следующие альтернативы: 

- First line base line (Базовая линия первой строки) – выравнивание текстового объекта 
выполняется относительно базовой линии первой строки текста (воображаемой линии, 
соединяющей нижние края символов строки без учета элементов, выходящих вниз за полосу 
строки, как нижний хвостик у буквы «ц»); этот режим включен по умолчанию; 

- Last line baseline (Базовая линия последней строки) – выравнивание текстового объекта 
выполняется относительно базовой линии последней строки текста; 

- Bounding box (Габаритный прямоугольник) – текстовый объект выравнивается как 
графический, с ориентацией на рамку выделения объекта. 
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9.5. Распределение объектов 
Распределением объектов в CorelDRAW называется такое размещение объектов, при 

котором соблюдается равенство расстояний между маркерами их рамок выделения. Добиться 
этого перетаскиванием объектов вручную практически невозможно. Координатная сетка может 
помочь, но ее саму надо достаточно кропотливо настраивать – во многих случаях без 
калькулятора не обойтись. Значительно удобнее решать такую задачу с помощью вкладки 
Distribute (Распределить) диалогового окна Align and Distribute (Выровнять и распределить). 

Равномерность при распределении объектов может достигаться двумя принципиально 
различными способами: равными могут быть расстояния между одноименными маркерами 
рамок выделения (например, между левыми краями или центрами), или интервалы, 
разделяющие объекты (просветы между ними, измеряющиеся, например, от правого края 
левого крайнего объекта до левого края следующего за ним объекта). При размещении объектов 
с различными габаритными размерами результаты размещения этими двумя способами могут 
сильно различаться (рис. 172). 

 

Рисунок 172 – Распределение с равными интервалами между объектами (сверху), 
между центральными маркерами рамок выделения (снизу) 

 
Размеры области, в которой будет выполняться распределение объектов, могут 

задаваться одним из двух способов. При первом способе размеры области совпадают с 
размерами рамки выделения, которые она принимает после совместного выделения всех 
распределяемых объектов. При втором способе размеры области распределения совпадают с 
размерами печатной страницы. 

В большинстве случаев перед операцией распределения объектов требуется выполнить 
их выравнивание. Обойтись без предварительного выравнивания можно в отдельных случаях 
распределения объектов по ширине или высоте печатной страницы или при распределении 
совмещенных в одной точке копий объекта. 

Элементы управления операцией автоматического распределения объектов 
располагаются на вкладке Distribute (Распределить) диалогового окна Align and Distribute 
(Выровнять и распределить), представленной на рис. 173. 

 

Рисунок 173 – Вкладка Distribute диалогового окна Align and Distribute 
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Горизонтальная группа флажков, расположенная в верхней части вкладки, управляет 

режимом распределения выделенных объектов по горизонтали. Значки, которыми снабжены 
эти флажки, дают очень ясное представление о том, какие именно расстояния при 
распределении будут сделаны равными. 

Вертикальная группа флажков, расположенная в левой части вкладки, управляет 
режимом распределения выделенных объектов по вертикали. 

Группа переключателей Distribute to (Распределить) предлагает две альтернативы: Extent 
of selection (В пределах выделения) и Extent of page (В пределах страницы). Эти переключатели 
управляет выбором размеров области распределения выделенных объектов 

 
Упражнение 2. Распределение объектов 

 
В результате выполнения упражнения должен получиться занимающий всю печатную 

страницу рисунок (рис 174).  

 

Рисунок 174 – Результат выполнения упражнения 
 

1. Начнем с построения клеток, роль которых будет играть сетка с прямоугольными 
ячейками. При практической работе было бы быстрее построить ее с помощью специального 
инструмента, но для изучения приемов распределения нам потребуются прямые линии. 
Постройте на чистой странице документа вертикальную прямую, совпадающую с левым краем 
страницы, используя инструмент Freehand (Произвольная кривая) или Bezier (Кривая Безье) и 
клавишу-модификатор Ctrl. Назначьте ей обводку контурной линией толщиной 6 пунктов. 
Нажатиями клавиш Ctrl+D постройте пять копий линии и выделите их совместно с оригиналом. 

2. Щелкнув на кнопке Align (Выравнивание), откройте диалоговое окно Align and 
Distribute (Выровнять и распределить) и перейдите на вкладку Distribute (Распределить). 
Установите переключатель Extent of page (В пределах страницы) и флажок Center (По центру) в 
горизонтальном ряду флажков. После щелчка на кнопке Apply (Применить) страница окажется 
разделенной на пять одинаковых по ширине вертикальных полос. Постройте горизонтальную 
линию вдоль верхнего края страницы, создайте три ее копии и распределите их по вертикали – 
при этом флажок Center (По центру) устанавливается в вертикальном ряду флажков.  

До появления в CorelDRAW инструмента Graph Paper (Диаграммная сетка) описанный 
прием был обычным приемом построения прямоугольных сеток. 

3. Если в рабочем пространстве отсутствует пристыковываемое окно Insert Character 
(Вставка символа), откройте его командой Text > Insert Character (Текст > Вставить символ). 
Найдите изображение гориллы в разделе Animals (Животные) и перетащите его в левый 
верхний угол страницы. Перетаскивая угловой маркер рамки выделения, отрегулируйте размер, 
чтобы горилле было не слишком тесно в клетке. 

4. Теперь переместим рисунок в центр прямоугольной ячейки. Для этого при нажатой 
клавише Shift выделите левую вертикальную линию, гориллу и вторую вертикальную линию. 
На этот раз на вкладке распределения установите переключатель Extent of selection (В пределах 
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выделения) и флажок Center (По центру) в горизонтальном ряду. После щелчка на кнопке Apply 
(Применить) горилла окажется точно посредине между вертикальными линиями. 

Обратите внимание, что при распределении в пределах рамки выделения перемещаются 
не все выделенные объекты, а на два меньше (в нашем случае – один объект). 

Этот частный случай стоит запомнить – при практической работе довольно часто 
приходится размещать объект точно посредине между двумя другими. 

5. Повторите предыдущий шаг, выделив на этот раз вместе с изображением гориллы 
горизонтальные линии, расположенные сверху и снизу от нее, и установив флажок Center (По 
центру) в вертикальном ряду. После щелчка на кнопке Apply (Применить) горилла окажется 
точно в середине своей клетки. 

6. Постройте копию гориллы и перетащите ее в правую крайнюю клетку верхнего ряда. 
Выровняйте ее только что освоенным приемом по середине клетки. Постройте еще три копии и 
совместно выделите всех имеющихся в наличии горилл. Распределите их по клеткам 
горизонтального ряда с теми же параметрами распределения, что и на шаге 4. На этот раз 
переместятся 5-2=3 гориллы, и верхний этаж «обезьянника» будет заселен. 

7. Заселение правого ряда проводится аналогичными приемами: создайте копию 
рисунка, переместите ее в правую нижнюю клетку, выровняйте по середине, постройте еще 
одну копию и распределите три объекта в пределах выделения по вертикали. 

8. Чтобы закрепить освоенные приемы распределения объектов, повторите упражнение 
на новом листе, только на этот раз заселите обезьянник приматами разных пород. После 
перетаскивания и масштабирования изображений обезьян выровняйте их по вертикали и 
горизонтали одновременно для совмещения середин рамок выделения, а все остальные 
действия можно выполнить способами, описанными выше. 

9.6. Стопка и слои объектов 
Стопка объектов – это метафора, позволяющая более наглядно представить себе 

порядок, в котором составляющие рисунок CorelDRAW объекты выводятся на экран или 
печать. Дело в том, что по принятому в CorelDRAW соглашению объекты с непрозрачной 
заливкой, расположенные в стопке выше, закрывают собой объекты, расположенные ниже. По 
умолчанию вновь созданный объект помещается на самый верх стопки. 

Объекты, составляющие рисунок, удобно представлять в виде фигур, вырезанных из 
эластичной пленки, одна из сторон которой покрыта клейким составом. При создании объекта 
на поверхность уже имеющегося изображения накладывается прозрачный тонкий, но жесткий 
лист, который обрезан по размерам страницы, и на этот лист приклеивается вновь созданный 
объект. Совокупность таких прозрачных листов, на каждый из которых наклеено по одному 
объекту, представляет собой неплохую физическую модель стопки объектов. 

В рамках этой метафоры любое преобразование объекта сводится к его переклеиванию в 
пределах одного прозрачного листа (возможно, с растяжением, сжатием или иными 
изменениями формы). 

CorelDRAW позволяет организовать в пределах страницы документа несколько слоев 
объектов. У каждого из слоев имеются свои атрибуты: имя, режимы доступности для 
редактирования и отображения на экране и при печати, положение по отношению к другим 
слоям. 

Слои позволяет более гибко структурировать объекты, составляющие изображение, и 
значительно упрощают работу с ними. Все объекты, составляющие изображение, можно 
распределить по нескольким слоям, соответствующим функционально однородным частям 
изображения. Например, если изображение представляет собой архитектурный план здания, то 
на одном слое можно изобразить ландшафт, в котором это здание будет построено, на другом – 
несущие стены, на третьем – перегородки, на четвертом – сантехническое оборудование и 
трубы, на пятом – мебель. Управляя порядком расположения слоев и режимами их видимости, 
можно получать различные, но полностью согласованные друг с другом изображения. 
Управление слоями в CorelDRAW осуществляется с помощью диспетчера объектов. При 
введении дополнительных слоев структура изображения становится иерархической: оно 
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состоит из нескольких слоев, каждый из которых, в свою очередь, состоит из нескольких 
объектов. В пределах каждого из слоев объекты составляют стопку объектов, в которой их 
можно переставлять. Слои, в свою очередь, также образуют стопку слоев, в которой их можно 
переставлять. Развивая предложенную выше метафору, можно говорить о том, что слой – это 
пакет из прозрачного пластика, в который помещены листы, несущие на себе объекты. Стопка 
слоев и стопки объектов задают определенный порядок следования всех объектов по вертикали, 
причем объект, расположенный выше, при выводе на экран или печать перекрывает собой все 
объекты, расположенные ниже него в стопке того же слоя, и все объекты всех расположенных 
ниже слоев. 

Независимо от того, сколько страниц создано в документе CorelDRAW, в нем всегда 
имеется так называемая главная страница (master page). Она объединяет в себе главные слои, 
которые по умолчанию создаются в каждом новом документе CorelDRAW: Grid (Координатная 
сетка), Guides (Направляющие) и Desktop (Рабочий стол). Главный слой отличается от прочих 
слоев тем, что расположенные на нем объекты появляются на всех страницах документа 
CorelDRAW. 

При добавлении нового слоя он появляется на всех страницах документа, но его 
наполнение объектами производится на каждой из страниц отдельно. Исключение составляют 
только слои, объявленные главными. 

- Слой Grid (Координатная сетка) содержит единственный объект – координатную сетку. 
Этот слой всегда является главным и недоступным ни для редактирования, ни для вывода на 
печать. По умолчанию он не отображается на экране, то есть координатная сетка не видна. 

- Слой Desktop (Рабочий стол) содержит все объекты, расположенные за пределами 
печатной страницы. Им удобно пользоваться в качестве временного хранилища объектов при 
компоновке изображений и при переносе их с одного слоя на другой, а также в качестве места 
для вспомогательных построений. Этот слой всегда является главным. По умолчанию он видим, 
доступен для редактирования и недоступен для вывода на печать.  

- Слой Guides (Направляющие) содержит направляющие – горизонтальные, 
вертикальные и наклонные прямые, которые уже упоминались в этом уроке. На него могут 
также помещаться любые объекты, которые после этого тоже становятся направляющими (см. 
выше). Этот слой всегда является главным. По умолчанию он видим, доступен для 
редактирования и недоступен для вывода на печать. 

По умолчанию в каждом новом документе создается еще один слой для хранения 
собственно объектов рисунка. По умолчанию этот слой получает имя Layer (Слой 1) – мы уже 
сталкивались с ним, рассматривая сообщения, появляющиеся в строке состояния. Этот слой (и 
все дополнительные, если они будут созданы) размещается между слоями Grid (Координатная 
сетка) и Desktop (Рабочий стол). 

Для работы над большинством иллюстраций вполне достаточно одного слоя, но в 
некоторых случаях применение дополнительных слоев позволяет существенно упростить 
работу над проектом. 

При создании каждый новый объект помещается на самый верх стопки объектов. Чтобы 
переместить объект в стопке на другую позицию, можно воспользоваться одной из команд 
подменю Order (Порядок) меню Arrange (Монтаж) или диспетчером объектов (см. далее). 

- Чтобы переместить выделенный объект на верх стопки объектов слоя, выберите 
команду Arrange > Order > То Front (Монтаж > Порядок > На передний план). 

- Чтобы переместить выделенный объект в самый низ стопки объектов слоя, выберите 
команду Arrange > Order > То Back (Монтаж > Порядок > На задний план). 

- Чтобы переместить выделенный объект на одну позицию вверх в стопке объектов слоя, 
выберите команду Arrange > Order > Forward One (Монтаж > Порядок > Вперед). 

- Чтобы переместить выделенный объект на одну позицию вниз в стопке объектов слоя, 
выберите команду Arrange > Order > Back One (Монтаж > Порядок > Назад). 

- Чтобы поместить выделенный объект непосредственно поверх какого-либо другого 
объекта в стопке объектов слоя, выберите команду Arrange > Order > In Front Of (Монтаж > 
Порядок > Перед объектом), а затем появившейся толстой горизонтальной стрелкой щелкните 
на соответствующем объекте (рис. 175). 
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Рисунок 175 – Последовательность перемещения объекта 
в сгонке с размещением поверх указанного объекта 

 
- Чтобы поместить выделенный объект непосредственно под каким-либо другим 

объектом в стопке объектов слоя, выберите команду Arrange > Order > Behind (Монтаж > 
Порядок > После объекта), а затем появившейся толстой горизонтальной стрелкой щелкните на 
соответствующем объекте. 

- Чтобы изменить порядок следования объектов на обратный, с помощью инструмента 
Pick (Выбор) и клавиши-модификатора Shift выделите два или более объектов, а затем 
выберите команду Arrange > Order > Reverse Order (Монтаж > Порядок > Обратить порядок). 

При выполнении команды обращения порядка в стопке изменяются положения только 
выделенных объектов – все остальные сохраняют свои исходные позиции. После выделения 
объекта на панели атрибутов становятся доступными кнопки То Front (На передний план) и То 
Back (На задний план), щелчок на которых эквивалентен действию одноименных команд 

9.7. Диспетчер объектов 
Диспетчером объектов (object manager) называется пристыковываемое окно Object 

Manager (Диспетчер объектов), содержащее иерархические списки объектов и слоев текущей 
страницы документа CorelDRAW. С помощью этого окна можно управлять слоями и 
объектами. Чтобы диспетчер объектов появился в рабочем пространстве, выберите команду 
Window > Dockers > Object Manager (Окно > Пристыковываемые окна > Диспетчер объектов). 
Внешний вид окна диспетчера объектов, при его размещении в середине окна документа, 
представлен на рис. 176. 

 

 
 

Рисунок 176 – Рисунок, состоящий из трех объектов, 
и соответствующее ему окно диспетчера объектов 

Создать главный слой Создать слой 

Показать свойства объектов Вид диспетчера слоев 
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В верхней части пристыковываемого окна располагается имя активного слоя (того слоя, 

на котором будут размещаться вновь создаваемые объекты). Кнопки инструментов диспетчера 
объектов располагаются и в верхней, и в нижней частях окна. 

- Кнопка New Layer (Создать слой) добавляет в документ еще один слой, которому 
назначается имя Layer n (где n на единицу больше номера последнего из ранее созданных 
слоев). Слой помещается выше всех ранее созданных слоев, но ниже главных слоев Desktop 
(Рабочий стол) и Guides (Направляющие). 

Пользователю предоставляется возможность сразу же переименовать вновь созданный 
слой, дав ему более содержательное название – текстовый курсор устанавливается на его имя. 
Рекомендуется не пренебрегать этой возможностью. По завершении правки имени нажмите 
клавишу Enter. 

- Кнопка Show Object Properties (Показать свойства объектов) включает или выключает 
режим отображения свойств объекта в окне диспетчера объектов. На рис. 176 этот режим 
включен, поэтому справа от имен объектов приведены сведения об их заливке и контурной 
линии. Обратите внимание, что цвета заливки и контура воспроизводятся на значке объекта, 
расположенном слева от его имени, вне зависимости от состояния этой кнопки. 

- Кнопка Edit Across Layers (Доступны все слои) включает или выключает режим, 
позволяющий выделять объекты любого слоя, доступного для редактирования (см. далее). Если 
этот включенный по умолчанию режим выключить, то выделить можно будет только объекты, 
принадлежащие активному слою и слоям, выделенным совместно с ним в окне диспетчера 
объектов. 

- Кнопка Layer Manager View (Вид диспетчера слоев) позволяет убрать из окна 
диспетчера объектов сведения о страницах и объектах, оставив в нем только записи, 
соответствующие слоям. 

Эффективно управлять количеством строк, отображаемых в окне диспетчера объектов, 
можно также с помощью элементов управления иерархического списка (значков в виде 
квадратиков со знаками «плюс» и «минус»). Щелчок на квадратике со знаком «минус» удаляет 
из окна сведения обо всех лежащих ниже него объектах иерархии страницы (слоях и объектах). 
При этом знак в квадратике сменяется на «плюс», и повторный щелчок возвратит все ранее 
скрытые строки в окно диспетчера 

9.8. Работа со слоями 
Чтобы выбрать активный слой, достаточно щелкнуть на соответствующей ему строке в 

иерархическом списке окна диспетчера объектов. 
Поскольку при добавлении слоя его имя появляется на ветвях дерева, соответствующего 

всем страницам документа, щелчок можно выполнить на строке, соответствующей любой 
странице. 

Чтобы включить или выключить отображение слоя на экране, достаточно щелкнуть 
мышью на соответствующем слою значке в виде глаза в окне диспетчера объектов. 

Для обычных (не главных) слоев этот режим можно устанавливать индивидуально для 
каждой страницы документа. Если необходимо отключить или, наоборот, включить режим 
отображения сразу на всех страницах, щелчок следует выполнить на значке в виде глаза в 
строке, соответствующей слою на главной странице (ветвь Master Page в нижней части окна 
диспетчера объектов). 

Чтобы включить или выключить вывод слоя на печать, достаточно щелкнуть мышью на 
соответствующем слою значке в виде принтера в окне диспетчера объектов. 

Слой координатной сетки невозможно вывести на печать, а слой Desktop (Рабочий стол 
имеет смысл выводить на печать только в том случае, если размеры печатной страницы меньше 
размеров листа бумаги, используемого при выводе на печать. 

Чтобы запретить или разрешить редактирование объектов, расположенных на слое, 
достаточно щелкнуть мышью на соответствующем слою значке в виде карандаша в окне 
диспетчера объектов. Слои, у которых значок карандаша выведен в тусклом варианте, 
заблокированы. На таком слое нельзя выделять и, следовательно, изменять какие-либо объекты. 
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Чтобы переименовать слой, достаточно дважды щелкнуть на его имени и 
отредактировать его. Чтобы удалить слой, можно выделить его щелчком на имени и нажать 
клавишу Del. 

Слои, назначенные главными по умолчанию – Grid (Координатная сетка), Guides 
(Haправляющие) и Desktop (Рабочий стол), – переименовать и удалить нельзя. 

Чтобы переместить слой на новое место в стопке слоев, достаточно перетащить его 
мышью вверх или вниз по отношению к исходному положению. Внутри окна диспетчера 
объектов появится горизонтальная черта, обозначающая новую позицию, которую займет слой, 
– эта черта перемещается синхронно с перемещением мыши. После отпускания кнопки мыши 
слой займет новое положение. 

Чтобы сделать слой активным, достаточно щелкнуть мышью на соответствующей ему 
строке. 

Операции со слоями удобнее выполнять, предварительно переключив окно диспетчера 
объектов в режим вида диспетчера слоев. Для этого нужно щелкнуть на кнопке Layer Manager 
View (Вид диспетчера слоев). 

Если щелкнуть правой кнопкой мыши на строке окна диспетчера объектов, 
соответствующей слою, раскроется контекстное меню, представленное на рис. 177. 

 

 
 

Рисунок 177 – Контекстное меню слоя в окне диспетчера объектов 
 
В верхней части меню расположены команды, переключающие состояние режимов слоя, 

ниже – команды удаления слоя и его переименования. Последняя команда меню раскрывает 
диалоговое окно, элементы управления которого позволяют более точно настраивать свойства 
слоя 

 
Упражнение 3. Работа со слоями 

В этом упражнении нам необходимо подготовить макет четырехстраничного листка-
складня для раздачи на массовом мероприятии. При этом материал листка должен быть 
скомпонован на страницах, в нижней части которых указан телефон для связи. Кроме того, в 
середине четных страниц должен размещаться логотип заказчика. 

1. Создайте новый документ. Поскольку должен разрабатываться листок-складень, 
размеры страницы будут нестандартными (скажем, шириной в половину листа, а высотой – в 
полный лист формата А4 альбомной ориентации). Щелкните на кнопке New (Новый документ) 
стандартной панели инструментов, а когда в окне документа появится изображение первой 
страницы, установите в полях размеров печатной страницы панели атрибутов значения ширины 
148,5 мм и высоты 210 мм. Добавьте в документ еще три страницы, трижды щелкнув на значке 
«плюс» в группе кнопок листания страниц, расположенных в левом нижнем углу окна 
документа. 

На самом деле такой размер страницы не является нестандартным – это формат А5. Но 
прием указания нестандартного размера страницы срабатывает и в этом случае. 

2. Воспользовавшись кнопкой добавления нового слоя в пристыковываемом окне 
диспетчера объектов, создайте новый слой и сразу переименуйте его, назвав Колонтитул. 
Создайте еще один слой и назовите его Логотип. Поскольку основная композиция макета 
должна размещаться поверх логотипа, перетащите мышью строку, соответствующую слою 

Видимый 

Редактируемый 

Удалить 

Свойства 

Печатаемый 

Главный 

Переименовать 
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логотипа, под строку слоя Layer 1 (на котором будут размещаться объекты, составляющие 
макет). 

3. Щелчком мыши на имени Колонтитул сделайте этот слой активным. Создайте в 
нижней части страницы блок фигурного текста и введите в него текст колонтитула, например: 

Наш телефон – 111-22-33 
Выровняйте текст по середине страницы с помощью диалогового окна Align and 

Distribute (Выровнять и распределить). 
4. К настоящему моменту из всех четырех страниц документа текст располагается только 

на слое Колонтитул четвертой страницы (убедитесь в этом, перейдя на третью страницу, а затем 
возвратитесь на четвертую). Чтобы этот текст появился на всех страницах, слой Колонтитул 
следует сделать главным. Для этого выберите команду Master (Главный) в контекстном меню 
слоя. Можно также просто перетащить мышью строку слоя Колонтитул из четвертой страницы 
на главную страницу (Master Page). В результате любого из этих действий строка слоя 
Колонтитул пропадет из секций всех четырех страниц документа, а в секции главной страницы 
появится строка слоя Master Колонтитул. Просмотрите документ и убедитесь, что текст 
нижнего колонтитула появился на всех его страницах. 

5. Теперь займемся логотипом. Начнем с задания атрибута видимости слоя Логотип для 
различных страниц. По умолчанию он установлен на всех страницах, так что остается щелкнуть 
мышью на значках с изображением глаза в строчках, соответствующих данному слою в секциях 
первой и третьей страниц. Перейдите на четвертую страницу, на которой слой Логотип 
отображается на экране, и импортируйте из библиотеки клипарта изображение, которое будет 
заменять нам логотип (в настоящем примере роль логотипа играет изображение /Awards/ 
Plaques/SymbO68.cdr). Увеличьте его до желаемого размера, выровняйте по середине листа, 
отмените обводку контурных линий и задайте заливку 10 % черного цвета. 

Все фоновые изображения рекомендуется делать неяркими – в противном случае они 
будут затруднять восприятие основных элементов макета. 

6. Осталось только сделать слой Логотип главным. Для этого щелкните правой кнопкой 
мыши на строке слоя в секции четвертой страницы и выберите в контекстном меню команду 
Master (Главный). Поставленная задача решена – на всех страницах воспроизводится нижний 
колонтитул, а на четных – логотип (рис. 178). 

Очень важно, чтобы команда превращения слоя в главный была выполнена именно для 
строки секции четвертой страницы, на которую импортировался рисунок. В противном случае 
главный слой оказался бы пустым. После превращения слоя в главный для каждой из страниц 
сохраняются атрибуты видимости, заданные, когда слой был еще обычным. 
 

 

Рисунок 178 – Результат выполнения упражнения: 
первые две страницы многостраничного документа и окно диспетчера объектов 
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7. В завершение упражнения поместите какую-нибудь надпись в середину щита на слое 

Логотип, убедитесь, что сделанное изменение воспроизводится на всех четных страницах, и 
щелкните на значке с изображением карандаша, чтобы заблокировать слой Логотип. Теперь 
можно приступать к разработке самого макета – колонтитулы готовы. 

9.9. Работа с объектами 
Если на какой-либо из слоев помещается объект, строка этого слоя в окне диспетчера 

объектов превращается в заголовок секции – в ее начале появляется квадратик со знаком 
«плюс» или «минус», а под ней размещаются строки, соответствующие объектам, 
расположенным на этом слое (см. рис. 176). Манипулируя этими строками, можно выполнить 
достаточно много операций с объектами, наиболее употребительные из которых описываются 
ниже. 

Чтобы выделить объект, достаточно щелкнуть на соответствующей ему строке в окне 
диспетчера объектов. Совместное выделение при нажатой клавише Shift также возможно. 
Допускается выделение объекта, входящего в состав группы. 

Особенно ценной такая возможность становится при малых размерах объекта или в 
случаях, когда объект целиком перекрывается другими объектами, расположенными выше него 
в стопке объектов. 

Перемещение объекта в стопке объектов со слоя на слой и со страницы на страницу 
выполняется перетаскиванием его строки на соответствующую позицию в окне диспетчера 
объектов, что намного проще традиционных приемов. 

После двойного щелчка на строке объекта имеется возможность задать ему новое, более 
осмысленное имя. Последовательное применение семантически нагруженных имен объектов 
позволяет легче ориентироваться в иерархической структуре рисунка. 

Щелчок правой кнопкой мыши на строке объекта раскрывает контекстное меню, 
позволяющее быстро получить доступ к диалоговому окну свойств объекта и командам, 
которые могут быть выполнены над выделенным объектом. 

 

9.10. Контрольные вопросы 
1. Что такое линейки и для чего они используются? 
2. Для чего нужны координатные сетки? 
3. Что такое направляющие и для чего они используются? 
4. Назовите основные элементы управления панели атрибутов направляющих. 
5. Как использовать раннее созданные объекты в качестве направляющих? 
6. Как происходит выравнивание объектов? 
7. Назовите основные элементы инструмента Align and Distribute (Выровнять и распределить). 
8. Как происходит распределение объектов? 
9. Для чего нужны слои в документе CorelDRAW? 
10. Для чего используется диспетчер объектов? 
11. Как происходит работа со слоями? 
12. Как происходит работа с объектами в диспетчере объектов? 
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ЛАБОРАТОРНАЯ РАБОТА №10 

ОПЕРАЦИИ С НЕСКОЛЬКИМИ ОБЪЕКТАМИ 
Цель лабораторной работы: ознакомиться с операциями группирования, соединения и 
маскирования. Научиться строить контуры требуемых объектов методом объединения 
примитивов. 

10.1. Группирование и разгруппирование 
Операции группирования и соединения обратимы, и полученные в их результате 

образования можно снова превратить в отдельные объекты. Кроме них в CorelDRAW есть 
группа необратимых операций, которые связывают исходные объекты «намертво», формируя 
единый объект: объединение, пересечение, исключение. Полученные в результате этих 
операций объекты уже нельзя преобразовать в исходные. 

Еще две операции предназначены для упрощения структуры сложных объектов, и в 
большинстве случаев в результате их применения к одному объекту получается несколько 
объектов. Это – операции преобразования объекта в кривые и отделения. Преобразование 
объекта (например, блока фигурного текста) в кривые, как правило, приводит к возникновению 
соединенной кривой, разъединение которой образует совокупность объектов. Операция 
отделения преобразует составной объект, например линию, построенную инструментом Artistic 
Media (Суперлиния), в управляющий объект и группу подчиненных объектов, которая может 
быть разгруппирована. 

Группированием называется операция, соединяющая совокупность отдельных объектов 
и/или ранее созданных групп в группу. Связывание объектов в группу позволяет обращаться с 
ними как с единым целым, выполняя преобразования группы как преобразование единого 
объекта. 

При работе над рисунком группы применяются очень часто. Основное их назначение – 
предотвращать случайное смещение отдельных объектов, образующих фрагмент изображения, 
относительно друг друга. Создание групп позволяет упростить операции копирования и 
размещения фрагментов изображения. 

Диспетчер объектов, работа с которым рассматривалась в предыдущем уроке, позволяет 
давать главным и вложенным в них дочерним группам объектов осмысленные имена, что 
значительно упрощает поиск объектов, соответствующих той или иной части изображения 
(рис. 179). 

 

 
 

Рисунок 179 – Главная группа, содержащая в себе объект и дочернюю группу объектов 
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На рисунке представлено изображение автомобиля, состоящее из четырех объектов. 

Замкнутая кривая с заливкой, изображающая кузов, не входит в состав групп. Три объекта, 
соответствующие стеклам, составляют главную группу, включающую в себя дочернюю группу 
стекол дверей и дочерний объект – кривую, изображающую лобовое стекло. Группы объектов 
получили соответствующие имена. Щелчком на расположенном слева от имени группы 
квадратике со знаком «минус» можно отключить отображение в окне диспетчера объектов всех 
дочерних групп и объектов, составляющих группу. При последовательном подходе к 
построению рисунка в окне диспетчера объектов всегда будет отображаться его обозримая и 
удобная схема. 

Чтобы сгруппировать объекты, следует выделить их и щелкнуть на кнопке Group 
(Сгруппировать) панели атрибутов или нажать клавиши Ctrl+G. При группировании нескольких 
объектов в общем случае происходит их перемещение стопке объектов. Самый верхний из 
объектов, вошедших в группу, остается в стопке на той же позиции, а остальные, сохраняя свое 
расположение в стопке относительно друг друга, размещаются непосредственно под ним 
компактной группой. Например, если в стопке сверху вниз располагались круг, квадрат, эллипс 
и пятиугольник, то после группирования круга и пятиугольника порядок объектов будет 
следующим: круг, пятиугольник (в одной группе с кругом), квадрат, эллипс. Если 
перечисленные объекты перекрывали друг друга и имели заливку, операция группирования 
может изменить изображение достаточно существенно. 

Чтобы разгруппировать ранее созданную группу, преобразовав ее в совокупность 
выделенных объектов и дочерних групп (если таковые входили в состав этой группы), 
достаточно выделить группу и щелкнуть на кнопке Ungroup (Разгруппировать) панели 
атрибутов. 

После разгруппирования объекты, входившие в состав группы, остаются в стопке 
объектов на тех же позициях, которые они занимали, состоя в группе, не возвращаясь на 
позиции, которые занимали до группирования. Поэтому операция разгруппирования не 
оказывает влияния на изображение. 

Пристыковываемое окно диспетчера объектов позволяет добавлять объекты в состав 
ранее созданных групп, просто перетаскивая в секцию группы строку, соответствующую 
добавляемому объекту. Объект или дочернюю группу можно также вывести из состава группы, 
перетаскивая его строку в окне диспетчера. 

Чтобы разделить на отдельные объекты не только главную группу, но и все входящие в 
ее состав дочерние группы, щелкните на кнопке Ungroup all (Разгруппировать все). 

Если возникает необходимость редактирования объекта, входящего в состав группы, в 
большинстве случаев нет необходимости его разгруппировывать. Достаточно выделить этот 
объект внутри группы, щелкнув на нем инструментом Pick (Выбор) при нажатой клавише Ctrl 
или выделив соответствующую ему строку в окне диспетчера объектов. Объект будет выделен 
со статусом дочернего (перед именем объекта в строке состояния появится слово Child), после 
чего с ним можно работать как с обычным объектом, в частности, менять заливку, параметры 
линии контура, форму. 

10.2. Соединение и разъединение 
В CorelDRAW предусмотрена и специальная команда для соединения выделенных 

объектов в единую кривую, реализуемая кнопкой Combine (Соединить) на панели атрибутов, 
которая становится доступной после выделения не менее чем двух отдельных объектов. 
Побочным эффектом действия команды соединения является преобразование всех выделенных 
объектов в совокупности кривых (которые становятся ветвями соединенной линии). 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 155

Для разъединения соединенной кривой на составляющие ее ветви используется кнопка 
Break Apart (Разъединить) на панели атрибутов или команда Break Object Apart (Разъединить 
объект) в меню Arrange (Монтаж), причем вместо слово «object» в названии команды 
автоматически появляется название класса объекта, который предполагается разъединить, 
например Break Curve Apart (Разъединить ветви). После разъединения каждая ветвь 
приобретает статус отдельного объекта. 

При соединении объектов с различной заливкой соединенная кривая (все ее замкнутые 
ветви) получает заливку и атрибуты линии контура объекта, который был выделен последним. 
При разъединении все объекты сохраняют заливку и атрибуты линии контура составного 
объекта. Обратите внимание, что атрибуты заливки сохраняются даже для незамкнутых ветвей. 
Если впоследствии такая незамкнутая кривая будет замкнута, CorelDRAW «вспомнит», что 
заливка для этого объекта уже назначена, и воспроизведет ее. Впрочем, как уже отмечалось 
ранее, можно включить режим отображения заливки и для незамкнутых кривых. 

При работе над рисунками соединенные линии чаще всего используются, когда 
необходимо обеспечить одинаковые атрибуты заливки и контура для нескольких объектов – 
например, волос и усов, галстука и платочка в нагрудном кармане на портрете, хвоста и гривы 
лошади. 

Очень интересный эффект возникает при соединении частично или полностью 
перекрывающихся объектов с заливкой – в местах перекрытия в соединенном объекте 
возникает прозрачная область – отверстие. 

 
Упражнение 1. Соединение объектов 

1. Создайте новый документ CorelDRAW. Постройте посредине страницы большой 
прямоугольник и перетащите на него желтый образец цвета с экранной палитры. Поверх 
желтого прямоугольника постройте синий, а затем – красный прямоугольники, расположив их 
таким образом, чтобы они не выходили за края желтого прямоугольника, но частично 
перекрывались друг с другом. 

2. Выделите совместно синий и красный прямоугольники и щелкните на кнопке Combine 
(Соединить) панели атрибутов. Обратите внимание на сообщение в строке состояния – там 
говорится, что выделен один объект класса «кривая». Цвет соединенного объекта будет 
зависеть от того, какой из прямоугольников был выделен последним, но в той его части, где 
соединяемые объекты пересеклись, появится желтый цвет. Чтобы убедиться, что это – 
действительно отверстие, выделите желтый прямоугольник и назначьте ему заливку другого 
цвета. 

3. Снова выделите соединенный объект и щелкните на кнопке Break Apart (Разъединить) 
панели атрибутов – на ней изображены как раз два перекрывающихся квадратика и стрелки, как 
бы растягивающие их в разные стороны. Обратите внимание на цвет получившихся объектов и 
на их расположение в стопке – сверху расположен тот из квадратов, который перед 
соединением был выделен последним и передал свой цвет соединенному объекту. 

4. Вставьте в документ новую страницу, щелкнув на знаке «плюс» в зоне прокрутки 
страниц документа, и постройте с помощью инструмента Polygon (Многоугольник) в 
центральной части страницы вытянутый по вертикали восьмиугольник размерами примерно 40 
на 90 мм. 

5. Раскройте пристыковываемое окно Transformation (Преобразование) командой 
Window > Dockers > Transformation (Окно > Пристыковываемые панели > Преобразование) и в 
открывшемся окне щелкните на кнопке Rotate (Поворот). В группе флажков выбора положения 
центра поворота щелкните на нижнем среднем флажке, чтобы центр поворота совместился с 
нижним углом восьмиугольника. В счетчик Angle (Угол) введите значение 15° и щелчками на 
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кнопке Apply To Duplicate (Применить к копии) превратите восьмиугольник в изящную розетку 
(рис. 180, а). 

Ниже будет показано, что многократно щелкать на кнопке Apply To Duplicate 
(Применить к копии) в этом и аналогичных случаях не обязательно – задачу «размножения» 
объектов вполне может взять на себя операция построения пошагового перехода. 

 

 

Рисунок 180 – Этапы построения розетки соединением объектов 

6. Растянув рамку выделения, совместно выделите все объекты и задайте толщину контурной линии 4 
пункта. Цвет обводки и заливки объектов выберите по своему усмотрению. После назначения 
заливки сразу становится видно расположение объектов в стопке (рис. 180, б). 

7. Осталось только соединить все восьмиугольники, щелкнув на кнопке Combine 
(Соединить) панели атрибутов. Результат представлен на рис. 180, в. 

8. В заключение попробуйте построить ту же розетку еще раз, но на шаге 5 
воспользуйтесь элементами управления пристыковываемого окна Transformation 
(Преобразование) для смещения центра поворота ниже среднего нижнего маркера рамки 
выделения. Установите флажок Relative Center (Относительно центра) и введите в счетчик V 
значение -90. После выполнения остальных шагов получится розетка, в середине которой 
вместо нагромождения линий контуров будет отверстие. 

10.3. Маски и маскирование 
Возможность создать с помощью команды соединения объект с прозрачными 

отверстиями очень часто используется для подготовки масок. Маской принято называть 
вспомогательный объект, предназначенный для того, чтобы скрывать (полностью или 
частично) расположенные ниже него объекты. Маски представляют собой основу технологии 
работы с пиксельными изображениями в программах пиксельной графики, но и в программе 
векторной графики CorelDRAW они используются достаточно часто – и непосредственно, и как 
«технологическая оснастка» для других декоративных приемов. 

На рис. 181 представлено несколько объектов. Сверху – прямоугольник с заливкой 
серым, на котором произвольным образом размещены снежинки. Заливка для снежинок 
выбрана белая, а обводка контурных линий отменена. Ниже расположен блок фигурного текста. 

 

Рисунок 181 – Маскируемый объект и заготовка для маски – блок фигурного текста 

а б в 
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На рис. 182 поверх снежинок построен прямоугольник с заливкой черным, блок текста 

размещен поверх него и соединен с ним. В результате прямоугольник превратился в маску с 
отверстиями, сквозь которые видны и серый зимний день, и пролетающие снежинки. 

 

Рисунок 182 – Готовая маска закрывает часть изображения 

Если маске назначить цвет заливки, совпадающий с цветом страницы, возникает 
впечатление, что из замаскированного изображения вырезаны и наклеены на страницу 
отдельные участки по форме отверстий в маске. 

К сожалению, при этом маска сохраняет габариты прямоугольного объекта, и то, что он 
совпадает по цвету со страницей, не означает, что «не работающие» края маски не будут 
закрывать объекты, лежащие ниже них в стопке. Если это становится проблемой, форму маски 
можно откорректировать инструментом Eraser (Ластик). В более сложных случаях для 
маскирования можно воспользоваться фигурной обрезкой, задав в качестве контейнера обрезки 
текст. 

Поскольку маска – такой же объект, как и все остальные объекты рисунка, с ней можно 
выполнять любые преобразования. Например, с помощью маски можно подчеркнуть части 
изображения, к которым желательно привлечь внимание зрителя, не удаляя, как в предыдущем 
примере, все остальное. Так, на рис. 183, а показано исходное изображение, на рис. 183, б –
маска, а на рис. 183, в – наложение маски с применением к ней преобразования линзы 
прозрачности. 

 

 

Рисунок 183 – Акцентирование маской отдельных фрагментов изображения 

В этом примере желаемый эффект достигнут за счет применения к маске с белой 
заливкой одного из эффектов преобразования линзы – полупрозрачной линзы. 

10.4. Объединение 
Операция объединения, так же как две описанные далее операции исключения и 

пересечения, представляет собой важнейший инструмент построения объектов сложных форм 
из более простых. Как уже отмечалось выше, эта операция необратима, то есть полученный в 
результате объект нельзя автоматически разделить обратно на исходные составляющие. 

Операция объединения представляет собой удаление пересекающихся частей 
объединяемых объектов и составление из фрагментов их границ новой границы по линии 
общего абриса. Если операция выполняется над непересекающимися объектами, она приводит к 

а б в 
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тому же результату, что и операция соединения – формированию соединенной кривой, 
состоящей из нескольких ветвей. Участвовать в операции могут два одиночных объекта, 
одиночный объект и совокупность объектов или две совокупности объектов. 

Участвующие в операции кривые могут быть как замкнутыми, так и незамкнутыми. В 
операции объединения не могут участвовать рамки простого текста, размерные линии и другие 
элементы размерных схем, а также импортированные точечные изображения. 

Две совокупности объектов, участвующих в операции объединения, принято называть 
выделенными и указанными объектами. Получившийся в результате операции объект 
наследует атрибуты заливки и обводки указанного объекта. Если совокупность указанных 
объектов включает несколько объектов, то значения атрибутов результата наследуются у 
указанного объекта, выбранного последним. 

Основными инструментами, с помощью которых задаются режимы выполнения 
операции объединения и запускается сама операция, являются элементы управления 
пристыковываемого окна Shaping (Формообразование), доступ к которым открывается после 
выбора пункта Weld (Объединение) в раскрывающемся списке, и кнопка Quick Weld 
(Объединение) на панели атрибутов. Элементы управления объединением пристыковываемого 
окна Shaping (Формообразование) представлены на рис. 184. 

В отличие от подавляющего большинства операций в CorelDRAW, операция 
объединения выполняется по-разному при запуске из пристыковываемого окна и при 
использовании кнопки панели атрибутов. 

Чтобы выполнить операцию объединения с помощью пристыковываемого окна Shaping 
(Формообразование), проделайте следующую процедуру. 

1. Выделите один или несколько объектов для объединения с помощью инструмента Pick 
(Выбор). Эти объекты составят совокупность выделенных. 

2. Чтобы открыть пристыковываемое окно, выберите команду Arrange > Shaping 
(Монтаж > Формообразование). Чтобы получить доступ к элементам управления объединением 
в верхнем раскрывающемся списке пристыковываемого окна Shaping (Формообразование), 
выберите пункт Weld (Объединение). 

- Если требуется, чтобы объединение выполнялось не над самими выделенными 
объектами, а над их копиями, установите флажок Source Object(s) (Сохранить выделенные 
объекты). 

- Если требуется, чтобы объединение выполнялось не над самими указанными 
объектами, а над их копиями, установите флажок Target Object(s) (Сохранить указанные 
объекты). 

3. Щелкните на кнопке Weld To (Объединить с). 
4. При нажатой клавише Shift щелкните мышью на всех объектах, которые должны 

войти в совокупность указанных. Объединение объектов выполняется в момент освобождения 
клавиши Shift. 

 
 

Рисунок 184 – Элементы управления объединением в пристыковываемом окне Shaping 

Выбрать вкладку 
объединения 

Схема операции 

Объединить с 

Сохранить выделенные объекты 

Сохранить указанные объекты 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 159

 
Совокупность указанных объектов можно создать, растягивая вокруг них рамку 

выделения. Если эта совокупность состоит из единственного объекта, нажимать клавишу Shift 
не обязательно. 

Чтобы выполнить операцию объединения с помощью кнопки Quick Weld (Объединение) 
панели атрибутов, надо сначала выделить объединяемые объекты. В этом варианте выполнения 
операции совокупность указанных объектов не создается – подразумевается, что ее роль играет 
последний из объектов, выделенных перед щелчком на кнопке Quick Weld (Объединение). 

При выделении совокупности объединяемых объектов растягиванием рамки выделения 
достаточно сложно определить, который из объектов выделяется последним. CorelDRAW 
считает, что это – объект, расположенный ниже остальных в стопке объектов. Чтобы 
гарантировать себя от неприятностей, после выделения объектов растягиванием рамки нажмите 
клавишу Shift и щелкните мышью на объекте, который должен быть выделенным последним. 
Это выведет его из состава выделения. А затем, не отпуская клавишу Shift, щелкните на нем 
еще раз 

 
Упражнение 2. Построение объекта сложной формы путем объединения. 
В этом упражнении мы познакомимся с выполнением операции объединения нескольких 

объектов и повторим приемы выравнивания и построения градиентной заливки. В качестве 
объекта для экспериментов выберем пивную бутылку. 

1. Начните с построения прямоугольника, вытянутого по горизонтали, размером 
примерно 100 на 70 мм. С помощью полей панели атрибутов уточните размеры и закруглите 
два из четырех углов прямоугольника. 

2. Постройте правильную окружность диаметром 70 мм. Чтобы точно совместить ее 
вертикальный диаметр с правым краем прямоугольника, включите режим привязки к объектам 
командой View > Snap To Objects (Вид > Привязать к объектам) и переместите окружность на 
место инструментом Pick (Выбор). 

3. Выключите режим привязки к объектам той же командой – дальше он будет только 
мешать, поскольку остальные фигуры не требуют совмещения с объектами. 

4. Постройте два эллипса и прямоугольник, совместно выделите их и выровняйте по 
правому краю выделения. Удерживая клавишу Shift нажатой, добавьте в выделение круг или 
прямоугольник и выровняйте все фигуры по середине выделения, совместив их середины на 
одной горизонтальной линии – геометрической оси бутылки (рис. 185, сверху). 

 

Рисунок 185 – Построение контура бутылки методом объединения примитивов 
и готовая бутылка 
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5. Выделите индивидуально прямоугольник с двумя закругленными углами и назначьте 

ему заливку 10-процентным черным цветом. Растяните прямоугольник выделения вокруг всех 
объектов и щелкните на кнопке Quick Weld (Объединение) панели атрибутов. Поскольку мы 
построили прямоугольник раньше других объектов, он оказывается нижним в стопке, и, 
следовательно, объединенный объект наследует именно его заливку. 

6. В заключение постройте несколько бликов на поверхности бутылки. Каждый из них 
представляет собой окружность без обводки с радиальной градиентной заливкой с переходом 
цвета от белого в середине к 10-процентному черному цвету на периферии. Достаточно 
построить только одну окружность – остальные блики создаются копированием и изменением 
размеров копий с размещением в нужных местах изображения (рис. 185, снизу). 

Если ваш рисунок требует, чтобы блики и тени на геометрических телах были построены 
максимально реалистично, следует рассмотреть возможность построения моделей этих тел в 
программе трехмерного моделирования (например, 3D Studio MAX). В таких программах 
имеется механизм точного построения теней, бликов и отражений для заданного расположения 
тел и источников света. В CorelDRAW решение такой задачи возможно лишь в первом 
приближении. К счастью, для большинства иллюстраций и рисунков возможностей 
CorelDRAW обычно вполне достаточно. 

Очень часто при работе над рисунком возникает необходимость обвести какой-либо 
фрагмент изображения достаточно толстой линией, чтобы сделать его более выпуклым, 
выделить из общего фона. Проще всего такая задача решается с помощью операции 
объединения. 

На рис. 186 все объекты, составляющие изображение правого лазерного принтера, были 
объединены в один объект (кривую) с помощью элементов управления объединением 
пристыковываемого окна Shaping (Формообразование) при установленном флажке Source 
Object(s) (Сохранить выделенные объекты). Затем полученная кривая с помощью поля 
масштабирования панели атрибутов была увеличена на 5 % относительно центра и ей была 
назначена заливка белым цветом. Наконец, полученная таким образом «подложка» была 
перемещена в стопке поверх фонового прямоугольника. 

 

Рисунок 186 – Имитация обводки группы объектов 
 

При применении этого приема к клипарту из библиотеки CorelDRAW целесообразно 
вначале разгруппировать клипарт до уровня отдельных объектов, а затем снова объединить в 
одну группу. В противном случае наличие дочерних групп может привести к возникновению 
нежелательных отверстий в «подложке». 

10.5. Пересечение 
Операция пересечения создает новый объект из области пересечения двух или более 

объектов, участвующих в операции. Так же как объединение, пересечение в общем случае 
выполняется над двумя совокупностями объектов – выделенной и указанной. Однако в отличие 



Кафедра «Торговое и рекламное оборудование»   БНТУ 2008 

 161

от объединения при пересечении может получиться и несколько объектов, поскольку новые 
объекты возникают из всех попарных пересечений выделенных и указанных объектов. 

Новый объект наследует атрибуты заливки и обводки «родительского» объекта, 
входившего в совокупность указанных. На рис. 187, слева представлены объекты до и после 
выполнения операции пересечения. Совокупность выделенных объектов включала лишь один 
круг с белой заливкой, а четыре прямоугольника с различными заливками составили 
совокупность указанных объектов. Справа на рисунке представлены элементы управления 
пристыковываемого окна Shaping (Формообразование) после выбора в раскрывающемся списке 
пункта Intersect (Пересечение). 

 

 
 

Рисунок 187 – Операция пересечения и элементы управления пересечением в 
пристыковываемом окне Shaping 

 
Если пересекаемые объекты образуют несколько областей пересечения (например, при 

пересечении двух колец может образоваться две области пересечения, не имеющие общих 
точек), то в результате все ветви этой области войдут в состав единственного соединенного 
объекта. 

Чтобы выполнить операцию пересечения при помощи элементов управления 
пристыковываемого окна Shaping (Формообразование), выделите объекты, установите 
требуемые флажки сохранения выделенных и указанных объектов, щелкните на кнопке Intersect 
With (Пересечь с) и при нажатой клавише Shift щелчками выделите требуемые объекты. 

Пересечение объектов в практической работе используется значительно реже, чем 
объединение и исключение, но существует одна типовая задача, которую без этой операции 
было бы довольно сложно решить. Речь идет о «переплетающихся» объектах – композиции, в 
которой одна часть объекта А должна перекрываться объектом Б, а другая часть того же 
объекта А должна сама перекрывать объект Б. 

 
Упражнение 3. Пересечение объектов 

Требуется изобразить фрагмент витой пары – это два отрезка провода разного цвета, 
скрученные друг с другом.  

1. Для начала изобразим один из проводов. С помощью инструмента Bezier (Кривая 
Безье) постройте короткий вертикальный отрезок прямой. Включите режим привязки к 
объектам и перетащите построенный отрезок инструментом Pick (Выбор) строго вниз до 
совмещения начального узла нового положения с конечным узлом прежнего положения – 
режим привязки к объектам поможет сделать это с идеальной точностью. Перед тем как 
отпустить левую кнопку мыши, щелкните ее правой кнопкой. Повторите смещение вниз с 
копированием еще два раза. В результате получатся четыре вертикальных отрезка, причем у 

Пересечь с 

Сохранить выделенные объекты 

Сохранить указанные объекты 
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второго, третьего и четвертого начальные узлы будут совпадать с конечными узлами 
предыдущих отрезков. 

2. Теперь превратим эти четыре отрезка в кривую, состоящую из четырех сегментов. Для 
этого их следует совместно выделить и соединить, щелкнув на кнопке Combine (Соединить) 
панели атрибутов. Теперь в нашем распоряжении имеется кривая, состоящая из четырех ветвей. 
Чтобы превратить соединенную кривую в обычную, нужно выбрать инструмент Shape (Форма) 
и поочередно выделить им пары узлов в местах соединения отрезков (лучше всего – растягивая 
рамку выделения вокруг сдвоенных узлов), щелкая после выделения на кнопке Join Two Nodes 
(Соединить узлы) панели атрибутов. В результате получится кривая, содержащая в одной ветви 
пять узлов, расположенных на краях четырех линейных сегментов (рис. 188, а). 

 

Рисунок 188 – Этапы выполнения упражнения 
 

3. Поскольку провод должен изгибаться, сегменты, составляющие кривую, следует 
преобразовать в криволинейные. Выделите все узлы кривой, растянув вокруг нее рамку 
выделения инструментом Shape (Форма), и щелкните на кнопке Convert To Curves 
(Преобразовать в кривые) панели атрибутов. Выделите узлы кривой через один инструментом 
Shape (Форма) при нажатой клавише Shift и сместите их по горизонтали на некоторое 
расстояние (это удобнее всего делать клавишами управления курсором). Должна получиться 
волнистая кривая (рис. 188, б). 

4. Далее необходимо превратить кривую в объект с заливкой. Как обычно, CorelDRAW 
предоставляет для решения этой задачи несколько инструментов (например, с помощью 
суперлиний). Мы воспользуемся командой преобразования контурной линии в 
самостоятельный объект. Выделите кривую инструментом Pick (Выбор) и задайте толщину 
контурной линии. Поскольку эта толщина определяет диаметр провода, возможно, для 
практических целей ее пришлось бы задавать с помощью диалогового окна Outline Pen (Перо 
для контуров), но здесь мы ограничимся стандартной толщиной 16 пунктов. Назначьте цвет 
контурной линии (например, желтый), щелкнув правой кнопкой мыши на соответствующем 
образце экранной палитры (рис. 188, в). Выберите команду Arrange > Convert Outline To Object 
(Монтаж > Преобразовать контур в объект) и откройте пристыковываемое окно диспетчера 
объектов. Таким образом остались два объекта: замкнутая кривая с желтой заливкой, 
получившаяся в результате преобразования, и незамкнутая кривая без заливки и обводки – это 
то, что осталось от исходной кривой. Вторую кривую следует удалить, поскольку она больше 
не понадобится. 

5. Теперь построим второй провод как зеркальное отражение первого. Выделите желтый 
провод инструментом Pick (Выбор), нажмите клавишу Ctrl и перетащите правый средний 
маркер рамки выделения влево до появления слева от провода его «фантомной» копии синего 
цвета. Перед тем как отпустить левую кнопку мыши, щелкните ее правой кнопкой. Назначьте 
построенной зеркальной копии заливку (например, красную). Теперь у нас есть оба провода 
(рис. 188, г). 
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6. Провода необходимо совместить. В силу причин, описанных выше, после этого они 
расположатся один над другим. Итак, выделите оба объекта и воспользуйтесь диалоговым 
окном Align and Distribute (Выровнять и распределить), чтобы совместить их вертикальные оси 
(рис. 188, д). В окне диспетчера объектов видно, что сейчас рисунок состоит из двух объектов 
класса кривых, причем объект с желтой заливкой расположен в стопке выше объекта с красной 
заливкой. Если это не так, с помощью окна диспетчера объектов расположите провода в стопке 
именно таким образом. 

7. Выделите желтый провод, щелкнув на нем инструментом Pick (Выбор), и щелкните на 
кнопке Intersection (Пересечение) в пристыковываемом окне Shaping (Формообразование). 
Установите оба имеющихся в окне флажка, а затем щелкните на кнопке Intersect With (Пересечь 
с). Поскольку в нашем случае совокупность указанных объектов состоит только из одного 
объекта, щелкните на красном проводе, не нажимая клавиши Shift. Результат выглядит весьма 
обманчиво (рис. 188, е) – кажется, что провода поменялись местами в стопке объектов и 
красный теперь лежит выше! Окно диспетчера объектов помогает развеять иллюзию: на самом 
деле в местах пересечения проводов образовался новый соедненный объект, состоящий из 
четырех ветвей, форма которых близка к ромбу, и унаследовавший красный цвет от указанного 
объекта – красного провода. 

8. Остается только доработать возникшую иллюзию, удалив ромбовидные объекты через 
один. Для этого выделите соединенный объект, щелкнув инструментом Pick (Выбор) на любом 
из ромбов, и разбейте его на отдельные ветви командой Arrange > Break Curve Apart (Монтаж > 
Разъединить ветви). Отмените выделение, нажав клавишу Esc, выделите при нажатой клавише 
Shift два ромбовидных объекта и удалите их, нажав клавишу Del. Иллюзия построена, и там, 
где красный провод должен был бы перекрывать желтый, это делают точно подогнанные по 
форме красные «заплатки» (рис. 188, ж). 

10.6. Исключение 
Исключением объектов называется операция, при которой у указанного объекта 

удаляются части, перекрываемые выделенным объектом. При выполнении операции 
исключения в роли «формы для высечки», отсекающей ненужные части указанных объектов, 
может выступать любой объект и даже совокупность объектов CorelDRAW. 

Как обычно, в совокупностях и выделенных, и указанных объектов может быть 
несколько объектов. Если перед выполнением исключения выделено несколько объектов, то 
«форма для высечки» составляется как результат объединения этих объектов. 

В состав совокупности указанных объектов могут входить не только отдельные объекты, 
но и их группы. Это очень удобно, если нужно удалить отдельные части стандартных 
изображений из библиотеки клипарта. 

При выполнении исключения с помощью пристыковываемого окна Shaping 
(Формообразование) все делается так же, как при выполнении объединения и пересечения: 
открываются элементы управления исключением, выделяются объекты, устанавливаются 
флажки режимов сохранения, выполняется щелчок на кнопке Trim (Исключение) и при нажатой 
клавише Shift выделяются объекты из совокупности указанных. При щелчке на кнопке Quick 
Trim (Исключение) панели атрибутов совокупность выделенных объектов составляется из всех 
выделенных объектов рисунка, кроме последнего, который играет роль указанного объекта. Все 
исходные объекты сохраняются. 

Ниже представлены результаты пересечения двух объектов: треугольника и круга (рис. 
189, а). В первом варианте треугольник играет роль выделенного объекта, а круг – указанного 
(рис. 189, б), во втором – выделен круг, а указан треугольник (рис. 189, в). 

Получившийся в результате пересечения объект наследует атрибуты заливки и обводки 
указанного объекта. Если указанных объектов несколько, то и в результате пересечения в 
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общем случае получится несколько объектов, каждый из которых унаследует атрибуты своего 
родительского объекта из совокупности указанных 

 

Рисунок 189 – Результаты пересечения двух объектов 
 

Упражнение 4. Исключение объектов 
В ходе выполнения этого упражнения мы познакомимся с операцией исключения и 

построим изображение одной из половинок доски для игры в нарды. 
1. Начните с построения небольшой правильной окружности. С помощью клавиш Ctrl+D 

постройте поверх ее пять копий. Перетащив верхнюю в стопке объектов копию вправо на 
достаточное расстояние, выделите все объекты и равномерно разместите их на горизонтальной 
прямой с помощью диалогового окна Align and Distribute (Выровнять и распределить). 

2. Постройте прямоугольник, перекрывающий нижние части окружностей, и с помощью 
того же диалогового окна выровняйте его по горизонтали симметрично окружностям (рис. 190, 
справа вверху). 

3. Выделите совместно все шесть окружностей – они будут играть роль совокупности 
выделенных объектов. Раскройте пристыковываемое окно Shaping (Формообразование) и в 
верхнем раскрывающемся списке выберите пункт Trim (Исключение). Элементы управления 
исключением полностью аналогичны элементам управления объединением и пересечением. 
Установите флажок Source object(s) (Сохранить выделенные объекты) – кружки еще 
понадобятся нам для изображения шашек – и щелкните на кнопке Trim (Исключение). 
Перетащите получившийся в результате объект (рис. 190, справа внизу) немного ниже. 

 

Рисунок 190 – Построение рисунка доски для игры в нарды 
 

4. Остальное – дело техники. Включив режим привязки к объектам, постройте 
прямоугольник, ограничивающий игровое поле, начав с левого нижнего угла только что 
построенной «гребенки». Постройте копию «гребенки», перетащите ее к верхнему краю 
игрового поля и поверните на 180°, удерживая нажатой клавишу Ctrl. Отключите режим 
привязки к объектам. Выделите прямоугольник игрового поля и, удерживая нажатой клавишу 
Shift, перетащите вверх и вправо правый верхний маркер рамки выделения. Перед тем как 
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отпустить левую кнопку мыши, щелкните ее правой кнопкой. Геометрические формы половины 
игровой доски готовы. 

5. Чтобы изобразить шашку, перетащите угол рамки выделения окружности внутрь, 
удерживая нажатой клавишу Shift, и перед отпусканием левой кнопки мыши щелкните правой 
кнопкой. Сгруппируйте две окружности и постройте копию группы, а затем сместите ее вправо. 
Для одной из шашек сделайте контурные линии белыми, а заливку черной, для другой – 
наоборот. Дополнительные шашки получаются копированием. Размещать шашки в лунках 
доски лучше при включенном режиме привязки к объектам. 

6. Назначьте для игрового поля и бортов доски текстурную заливку. По характеру 
изображаемого объекта неплохо подойдет заливка из библиотеки Samples8 под названием Wood 
Grain (Волокна древесины). Заключительный аккорд – размещение в центре игрового поля 
изображения игральных костей. Его можно найти в библиотеке клипарта. Чтобы вставить 
изображение в рисунок, выберите команду File > Import (Файл > Импорт), найдите нужный 
файл в диалоговом окне открытия файла, а когда после щелчка на кнопке ОК на экране 
появится указатель с именем файла, наведите его на свободное место страницы и щелкните 
мышью. 

Как правило, изображения из библиотеки клипарта требуют некоторой доработки. В 
нашем случае такая доработка свелась к разгруппированию, удалению прямоугольника с фоном 
и кривых, изображающих тени от костей. Оставшиеся объекты были снова сгруппированы, 
приведены к желаемому размеру, размещены и выровнены по центру игрового поля 

 
Упражнение 5. Разрезы и надрезы на объектах 

В ходе выполнения этого упражнения мы исследуем операцию исключения в том ее 
варианте, когда в качестве выделенного объекта выступает незамкнутая кривая. Рассмотрим две 
альтернативы: кривая пересекает объект, и ее конечные узлы расположены вне его; кривая 
пересекает границу объекта, и один из ее конечных узлов находится внутри объекта. 
Упражнение носит исследовательский характер, но тем не менее определим, что мы хотим 
изобразить: разорванный пополам трафарет для нанесения надписи краской (лист пластика с 
вырезанными в нем буквами) и лопающееся, но еще не лопнувшее до конца яйцо. 

1. Начнем с подготовки «оснастки» для эксперимента. Постройте прямоугольник, 
вытянутый в горизонтальном направлении, и задайте для него заливку. Постройте блок 
фигурного текста, отформатируйте его подходящей гарнитурой и кеглем и разместите 
посредине прямоугольника. Инструментом Freehand (Произвольная кривая) постройте поперек 
прямоугольника и надписи достаточно извилистую кривую (рис. 191, сверху). 

2. Теперь «разорвем» фоновый прямоугольник. Выделите кривую, расположенную над 
ним, и щелкните на кнопке Trim (Исключение) в пристыковываемом окне Shaping 
(Формообразование), а затем – на самом прямоугольнике. Через прямоугольник проходит 
трещина, разбивающая его по горизонтали на две части. 

Отметим, что построенный в результате исключения объект попал на самый верх стопки 
объектов, из-за чего надпись оказалась полностью перекрытой. 

3. С Помощью окна диспетчера объектов или команды Arrange > Order > То Back 
(Монтаж > Порядок > На задний план) переместите результат исключения в самый низ стопки 
объектов. Сообщение в строке состояния говорит о том, что выделен всего один объект класса 
кривых. Командой Arrange > Break Apart (Монтаж > Разъединить) разъедините две ветви 
кривой – теперь в нашем распоряжении две кривые, без зазоров смыкающиеся по извилистой 
границе, и надпись. 

4. Теперь превратим буквы надписи в отверстия в трафарете. Для этого выделите 
надпись инструментом Pick (Выбор), сбросьте оба флажка в пристыковываемом окне Shaping 
(Формообразование), щелкните на кнопке Trim (Исключение), а затем, при нажатой клавише 
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Shift, – на верхней и нижней частях бывшего фонового прямоугольника. Трафарет готов, 
остается только зрительно подчеркнуть, что он разорван. 

 

 
 

Рисунок 191 – Этапы разрезания объекта на две части 
 
Сначала «пробивать» отверстия в трафарете, а потом разрывать его не рекомендуется, 

поскольку при этом образуется соединенная кривая из нескольких ветвей, которые после 
разъединения дают множество индивидуальных объектов, что существенно осложняет работу. 

5. Для этого мы слегка повернем верхнюю часть трафарета, расширив трещину в ее 
правой части. Выделите верхнюю часть инструментом Pick (Выбор), затем щелкните мышью 
еще раз, чтобы в рамке выделения появились стрелки поворота, и перетащите маркер центра 
поворота (кружок с точкой посредине) в точку, где трещина пересекает левый край трафарета. 
Увеличьте масштаб отображения и уточните положение центра поворота. Затем с помощью 
соответствующего поля на панели атрибутов поверните верхнюю часть трафарета ровно на 
один градус (рис. 191, внизу). 

6. Теперь займемся треснувшим яйцом. Для начала изобразим яйцо целое. Для этого 
постройте белый эллипс, преобразуйте его в кривую, выделите инструментом Shape (Форма) 
расположенный справа узел и немного перетащите его влево при нажатой клавише Ctrl (чтобы 
не нарушить симметрию). Это будет белок – считаем, что яйцо уже сварено. Затем наденьте на 
белок скорлупу. Для этого с помощью клавиш Ctrl+D постройте дубликат объекта и задайте для 
него заливку бежевого цвета. Несколькими последовательными щелчками инструментом Bezier 
(Кривая Безье) постройте ломаную линию, пересекающую границу яйца. Материал для 
эксперимента подготовлен (рис. 192, слева). 

 

 
 

Рисунок 192 – Пересечение объекта незамкнутой кривой 
 

7. Теперь расколем только что изображенное яйцо. Для этого выделите инструментом 
Pick (Выбор) ломаную линию, сбросьте оба флажка в пристыковываемом окне Shaping 
(Формообразование), щелкните на кнопке Trim (Исключение), а затем – на бежевом объекте. 
Ломаная линия исчезает, а в скорлупе яйца появляется трещина. Выберите инструмент Shape 
(Форма) и убедитесь, что получившийся объект – не составная, как в примере с трафаретом, а 
обычная кривая, состоящая всего из одной ветви. 

8. Немного расширим трещину, чтобы через нее был виден белок. Для этого 
инструментом Shape (Форма) выделите при нажатой клавише Shift все узлы трещины. Делать 
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это растягиванием рамки выделения нельзя, поскольку узлы двойные, а нам нужны только 
верхние узлы в каждой паре. Щелкните на кнопке поворота узлов на панели атрибутов, 
перетащите маркер центра поворота в вершину трещины и перетащите правый нижний маркер 
рамки выделения в виде стрелки немного вниз. Трещина в бежевом объекте расширится, и 
сквозь нее покажется белок (рис. 192, справа) 

10.7. Упрощенное исключение для перекрывающихся объектов 
В арсенале CorelDRAW имеются средства, позволяющие в один прием выполнять 

операцию исключения для совокупности выделенных объектов, частично перекрывающих друг 
друга. Это инструменты Simplify (Упростить), Front Minus Back (Передний минус задние) и 
Back Minus Front (Задний минус передние). Одноименные пункты включены также в 
раскрывающийся список выбора типа преобразования в пристыковываемом окне Shaping 
(Формообразование). 

Упрощение работы пользователя достигается за счет отказа от раздельного выбора 
совокупностей указанных и выделенных объектов – указанные объекты определяются 
автоматически по типу операции. Перед ее началом должно быть выделено как минимум два 
объекта. 

Инструмент Simplify (Упростить) выполняет достаточно сложную операцию: для 
каждого выделенного объекта, начиная с самого нижнего в стопке, выполняется исключение 
всех остальных выделенных объектов, расположенных в стопке выше него. Пример 
выполнения операции приведен на рис. 193. Слева на рисунке представлена стопка выбранных 
объектов. Она состоит из фигурного текста (символ амперсанда) внизу стопки, круга и 
многоугольника вверху стопки. Внешний вид совокупности выделенных объектов после 
операции упрощения не меняется. Чтобы увидеть результат, пришлось нижние объекты 
сместить вправо на разные расстояния по горизонтали. 

От амперсанда, автоматически преобразованного в кривую, осталось совсем немного – 
из него последовательно исключались круг и многоугольник. Многоугольник изменений не 
претерпел (из него ничего не исключалось). Круг превратился в соединенную кривую из пяти 
замкнутых ветвей, оставшихся после исключения многоугольника. 

Функции инструментов Front Minus Back (Передний минус задние) и Back Minus Front 
(Задний минус передние) полностью описывается их названиями. Первый выполняет 
исключение, при котором в качестве указанного объекта выступает верхний из всех 
выделенных объектов, а все остальные объекты из него исключаются (и на этом заканчивают 
свое существование). Второй инструмент делает в точности то же самое, но в роли указанного 
выступает объект, расположенный в самом низу стопки. 

 

Рисунок 193 – Исходные объекты (слева) и результаты работы инструментом Simplify 

Ниже приведен пример выполнения этих двух операций. На рис. 194, а показана 
исходная стопка объектов, на рис. 194, б – результат выполнения операции Front Minus Back 
(Передний минус задние), на рис. 194, в – результат выполнения операции Back Minus Front 
(Задний минус передние). 
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Рисунок 194 – Стопка объектов и результаты операций Front Minus Back и Back Minus Front 
 

10.8. Преобразование объекта в кривые 
Чтобы преобразовать выделенные объекты в кривые, достаточно выбрать команду 

Arrange > Convert To Curves (Монтаж > Преобразовать в кривые) или щелкнуть на 
соответствующей ей кнопке панели атрибутов (на ней изображен кружок с четырьмя узлами). 
При преобразовании текстов в кривые обычно получаются очень сложные объекты с большим 
количеством узлов, и при выполнении операций с такими объектами скорость работы заметно 
снижается. Поэтому рекомендуется перед преобразованием в кривые разбить тексты на 
сравнительно небольшие блоки. 

При преобразовании сложного объекта в кривые рекомендуется предварительно создать 
копию такого объекта и перетащить ее за пределы печатной страницы. Это позволит в случае 
необходимости быстро восстановить объект (например, при неудачном преобразовании 
получившихся кривых) 

10.9. Отделение объектов 
При работе с составным объектом невозможно непосредственно редактировать 

подчиненные объекты (их нельзя даже выделить). Если для воплощения художественного 
замысла такое редактирование все-таки необходимо, составной объект вначале преобразуют в 
совокупность отдельных объектов. Операция такого преобразования называется отделением. 
Операция отделения необратима – после отделения промежуточных объектов, например, 
пошагового перехода, автоматически восстановить этот пошаговый переход из отдельных 
составных частей уже не удастся. Выполняется операция отделения составных объектов 
командой Arrange > Separate (Монтаж > Отделить). В результате выполнения этой операции 
составной объект распадается на отдельные управляющие объекты и группу подчиненных 
объектов. Для редактирования отдельных промежуточных объектов может потребоваться 
разгруппирование этой группы 

10.10. Контрольные вопросы 
1. Что такое группирование и для чего его используют? 
2. Для чего и как используют соединение объектов? 
3. Что такое маска и как используют маскирование? 
4. В чем состоит операция объединения? 
5. В чем состоит операция пересечения и какие элементы управления пересечением в 

пристыковываемом окне Shaping используют для него? 
6. В чем состоит операция исключения? 
7. Как происходит работа с инструментами Front Minus Back (Передний минус задние) и Back 

Minus Front (Задний минус передние)? 
8. Как происходит преобразование объектов в кривые? 
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ЛАБОРАТОРНАЯ РАБОТА №11 

ВЫВОД ГОТОВЫХ ИЛЛЮСТРАЦИЙ 
Цель лабораторной работы: ознакомиться с возможностями программы по выводу 

иллюстраций, растрированию и экспорту. Ознакомиться с особенностями подготвки 
иллюстраций для печати на стационарных принтерах, а также в формате PDF и PostScript. 

 
В настоящее время пакет CorelDRAW позволяет осуществлять вывод иллюстрации в 

одном из трех вариантов: 
• в виде отпечатков, выполненных на стационарных (домашних или офисных) 

принтерах; 
• в виде файлов с изображениями в различных форматах, предназначенных для 

включения их в состав веб-страниц или публикации другими электронными 
средствами; 

• в виде файлов с векторными и пиксельными изображениями в формате PostScript, 
предназначенных для передачи в бюро полиграфического обслуживания. 

Последний из трех вариантов предполагает использование довольно сложного 
технологического процесса - подготовка оригинал-макета для последующей печати в 
типографии. Подготовка исходных данных для такого процесса по готовому изображению 
требует выполнения огромного числа настроек, зависящих от деталей полиграфического 
процесса и особенностей оборудования, которым располагает бюро полиграфического 
обслуживания. 

 

11.1. Экспорт изображения в файл 
По умолчанию при сохранении изображения с помощью команды File → Save As (Файл 

→ Сохранить как) создается файл в векторном формате CDR - собственном формате 
программы CorelDRAW. Экспорт рисунка в другой векторный формат можно выполнить с 
помощью стандартного диалогового окна Save As (Сохранить как), выбрав соответствующий 
элемент в списке Files of type (Тип файла). Однако более универсальным средством экспорта 
оказывается команда File → Export (Файл → Экспорт), позволяющая сохранить проект как в 
векторных, так и в пиксельных форматах. После выбора этой команды открывается 
одноименное диалоговое окно. Щелчок на кнопке Options (Опции) сделает доступными группу 
дополнительных параметров (рис. 195). 

Управляющие параметры экспорта задаются с помощью следующих элементов 
управления этого диалогового окна. 

• Раскрывающийся список Save of type (Тип файла) позволяет выбрать формат векторного 
или пиксельного изображения, в который будет преобразован рисунок (или только 
выделенные объекты). Перечень доступных элементов определятся тем, какие фильтры 
экспорта были выбраны в процессе установки. Некоторые из наиболее часто 
применяющихся на практике форматов рассматриваются ниже. 
• Установив флажок Do not show filter dialog (Без задания параметров фильтра) можно 
отказаться от настройки фильтра экспорта. Фильтрами экспорта называют отдельно 
устанавливаемые компоненты CorelDRAW, с помощью которых выполняется 
преобразование формата. Большинство фильтров требуют уточнения управляющих 
параметров перед преобразованием формата, поэтом; выводят на экран собственные 
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диалоговые окна. В случае установки этого флажка преобразование будет выполнено со 
значениями управляющих параметров, принятыми по умолчанию. 

 

 
 

Рисунок 195 – Диалоговое окно экспорта 
 

11.2. Экспорт в формат EPS 
Формат EPS (Encapsulated PostScript) позволяет сохранить в векторной форме почти все 

объекты CorelDRAW. Его основные достоинства - совместимость практически со всеми 
программами для работы с векторной графикой как на платформе IBM PC, так и на платформе 
Macintosh и возможность аппаратной интерпретации при выводе на печать с помощью 
специальных лазерных принтеров PostScript. 

Этот формат применяют для передачи векторных изображений пользователям, 
работающим не с программой CorelDRAW, а с другими программами, например для передачи в 
издательство для верстки средствами программы PageMaker. 

Диалоговое окно фильтра экспорта в формат EPS (рис. 196) имеет две вкладки. 
В состав векторного EPS-файла может включаться так называемый прообраз – 

пиксельный аналог изображения, сохраненный с невысоким разрешением и пред назначенный 
только для предварительного просмотра упрощенного варианта. Поскольку во многих 
программах содержимое EPS-файла не может непосредственно отображаться на экране 
монитора, целесообразно включать его в файл, установив флажок Include Header (Включить 
прообраз). Имеется также возможность задать глубину цвета и разрешение для прообраза, но в 
большинстве случаев в этом нет необходимости. 

При экспорте текст можно преобразовать в кривые, установив переключатель Curves 
(Кривые) в группе Export text as (Экспортировать текст как), но это целесообразно делать 
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только тогда, когда в рисунке имеется много небольших блоков фигурного текста, 
отформатированных с использованием различных гарнитур. 

 

 
 

Рисунок 196 – Диалоговое окно фильтра экспорта в формат EPS 
 

Флажок Include fonts (Включить гарнитуры) позволяет сохранить в составе файла 
использованные в рисунке гарнитуры, что обеспечит точность воспроизведения текстовых 
объектов независимо от набора гарнитур, имеющихся в распоряжении у получателя файла. 

При экспорте рисунка в формат EPS можно выполнить преобразование 
импортированных пиксельных изображений в единую цветовую модель, включить или 
отключить режим цветовой коррекции при помощи цветового профиля принтера, а также 
ограничить число цветовых градаций, использующихся при формировании градиентных 
заливок. На вкладке Advanced (Дополнительные) размещены элементы управления, 
необходимые для выполнения более тонких настроек процесса преобразования. Они 
используются главным образом при подготовке специальных типов файлов в процессе выпуска 
оригинал-макетов. 

Наконец список Compatibility (Совместимость) позволяет сохранять файлы, преобразуя 
их таким образом, чтобы они были совместимы с конкретной моделью принтера или 
программы, поддерживающей PostScript. 

11.3. Экспорт в формат PDF 
Формат PDF (Portable Document Format — формат переносимых документов) был 

разработан в компании Adobe специально для электронных публикаций. Он позволяет 
сохранять неизменными форматирование текстов, графические изображения и другие элементы 
документа независимо от того, на какой платформе этот документ воспроизводится. С 
помощью программ Acrobat Reader и Acrobat Exchange файл в формате PDF можно 
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просматривать и печатать на платформах Windows, Unix и Macintosh. В последнее время этот 
формат получает все более широкое распространение при публикации документов во 
внутренних сетях и в Web. 

В отличие от остальных векторных форматов, в CorelDRAW экспорт в этот формат 
производится с помощью специальной команды File → Publish To PDF: (Файл → Опубликовать 
в PDF). После выбора этой команды открывается диалоговое окно, совпадающее с диалоговым 
окном сохранения файла, но в него добавлена еще одна кнопка - Settings (Установки). При 
щелчке на этой кнопке открывается диалоговое окно фильтра экспорта в формат PDF (рис. 197). 

В этом диалоговом окне следует задать спецификацию файла, в котором буду: 
сохранены результаты экспорта, а для многостраничных документов — и диапазон 
экспортируемых страниц. Раскрывающийся список PDF Style (Стиль PDF) позволяет выбрать 
стиль, который будет использован при преобразовании, — это может быть документ для 
электронной публикации, для последующего редактирования, для размещения в Web и т. д. 
Управляющие элементы других вкладок позволяют детализировать процесс публикации, но во 
многих случаях их состояние можно оставить без изменений. 

 

 
 

Рисунок 197 – Диалоговое окно фильтра экспорта в формат PDF 
 

11.4. Экспорт в форматы пиксельной графики 
Чаще всего результаты работы приходится сохранять в пиксельном формате для 

дальнейшего использования в составе веб-страниц. В некоторых случаях рисунок преобразуют 
в пиксельный формат для того, чтобы справиться с проблемами, возникающими при печати из-
за сложности составляющих изображение объектов (в них могут быть использованы различные 
эффекты). 

При выборе в диалоговом окне Export (Экспорт) в качестве типа файла одного из 
пиксельных форматов после стандартного окна, в котором осуществляется выбор имени файла 
и его расположения, раскрывается окно Convert to Bitmap (Преобразовать в пиксельное 
изображение). С помощью элементов управления этого диалогового окна устанавливаются 
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значения основных параметров преобразования (рис. 198), а управляющие параметры для 
каждого конкретного формата запрашиваются с помощью дополнительных диалоговых окон. 

 

 
 

Рисунок 198 – Диалоговое окно Convert To Bitmap 
 

• Раскрывающийся список Color mode (Цветовая модель) позволяет выбрать цветовую 
модель будущего пиксельного изображения. 
• Флажок Anti-aliasing (Сглаживание) служит для включения режима сглаживания кромок. 
• Флажок Dithered (Имитация) выполняет те же функции, что и одноименный флажок в 

одноименном диалоговом окне, появляющимся при выборе команды Bitmaps → Convert to 
Bitmap (Пиксельное изображение → Преобразовать в пиксельное изображение). 
• Флажок Transparent Background (Прозрачный фон) позволяет при экспорте сделать цвет 

фона прозрачным, избавившись от необходимости впоследствии удалять нежелательный фон. 
• Флажок Apply ICC profile (Цветовой профиль) обеспечивает включение в состав файла с 

пиксельным изображением цветового профиля - специальной таблицы в стандартном формате 
ICC, использующейся для автоматического управления цветом. Это позволяет увеличить 
точность цветопередачи при переносе данных из приложения в приложение. 
• Счетчики Width (Ширина) и Height (Высота) позволяют задать размеры пиксельного 

изображения. 
• Счетчик Resolution (Разрешение) задать любое разрешение по горизонтали и вертикали 

раздельно. В подавляющем большинстве случаев работы, предназначенные для печати, 
экспортируются с разрешением 300 dpi, а для воспроизведения на экране - не более 95 dpi 
(обычно 72). 
• Флажок Maintain Layers (Сохранять слои) служит для включения режима, при котором 

экспорт в форматы пиксельных изображений, предусматривающие работу со слоями, 
выполняется в соответствии с распределением объектов векторного изображения по слоям 
документа CorelDRAW. При этом сохраняются имена слоев, заданные в пристыковываемом 
окне диспетчера объектов. 

Если работу предполагается выводить на печать, чаще всего требуется пиксельный 
формат TIFF. По умолчанию в этом формате используется модель цвета CMYK, наиболее точно 
отвечающая техническим возможностям современных цветных принтеров, с глубиной цвета 32 
бита. Для экспорта в этот формат не требуется указывать никаких дополнительных параметров. 
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Форматы пиксельной графики GIF (8 бит) и JPEG (24 бита), разработанные достаточно 
давно, на сегодня являются основными форматами представления графической информации в 
Интернете. Первый из них используется для представления изображений с большими 
областями одинакового цвета, второй — для сканированных фотографий. Формат GIF 
позволяет создавать изображения с прозрачным фоном. 

Формат JPEG был разработан специально для сокращения размеров файлов с 
графическими изображениями. Он предусматривает управляемое сжатие и сглаживание 
изображения за счет некоторого снижения его качества. 

При экспорте в тот или другой формат можно задать дополнительные параметры 
управляющие преобразованием. Для этого используются дополнительные диалоговые окна с 
областью предварительного просмотра, в которой влияние изменения управляющих параметров 
можно визуально оценить до выполнения экспорта. Такое окно для формата JPEG представлено 
на рис. 199. 

 

 
 

Рисунок 199 – Диалоговое окно фильтра экспорта в формат JPEG 
с областью предварительного просмотра 

 

11.5. Вывод изображения на печать 
Для вывода документа CorelDRAW или его части на печать выберите команду File → 

Print (Файл → Печать) или щелкните на кнопке с изображением принтера па стандартной 
панели инструментов. На экране раскроется представленное на рис. 200 диалоговое окно Print 
(Печать) с шестью или семью вкладками. 

Вкладка Separations (Полосы цветоделения) управляет процессом цветоделения — 
подготовки отдельных полос для типографского процесса, каждая из которых соответствует 
одной использованной краске.  

Вкладка Prepress (Допечатная обработка) позволяет задавать параметры режима 
подготовки изображения к выводу на листы макета с возможным зеркальным отображением и 
добавлением типографских отметок.  

Вкладка PostScript (появляется в диалоговой окне Print (Печать), если текущим является 
принтер с аппаратной интерпретацией языка PostScript) управляет процессом перевода 
векторного изображения в интерпретируемый язык PostScript, вкладка Misc (Разное) содержит 
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некоторые вспомогательные элементы управления, а на последней вкладке выводятся 
сообщения о возможных причинах осложнений, которые могут возникнуть в процессе печати. 
Если такие осложнения случатся, их количество перед словом Issue (Пункт) будет 
автоматически вынесено на ярлычок вкладки, вместо ее названия. 

 

 
 

Рисунок 200 – Диалоговое окно Print 
 
В простейшем варианте вывода на печать из всех вкладок этого окна используются две: 

General (Общие) и Layout (Макет). В отношении остальных вкладок и расположенных на них 
элементов управления рекомендуется не менять значения, установленные но умолчанию. 

 

11.6. Выбор принтера и его настройка 
Принтер выбирается с помощью раскрывающегося списка Name (Имя), расположенного 

на вкладке General (Общие) диалогового окна Print (Печать). По умолчанию выбранным 
является принтер, определенный для вывода средствами настройки системы Windows (команда 
Принтеры главного меню). Число элементов в списке определяется количеством принтеров, 
установленных в системе. 

Настройка принтера выполняется программными средствами драйвера выбранного 
принтера, диалоговое окно которого раскрывается щелчком на кнопке Properties (Свойства), 
расположенной справа от списка Name (Имя). 

В окне драйвера следует указать формат листов бумаги, на которой будет напечатана 
работа, и их ориентацию (книжная или альбомная). В некоторых принтерах предусмотрена 
возможность подачи бумаги из нескольких источников - для них следует указать лоток, в 
который будет загружена бумага. 

Практически все принтеры позволяют печатать с различным аппаратным разрешением. 
Чтобы качество отпечатка было высоким, разрешение принтера должно быть максимальным. 
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При этом, чем выше аппаратное разрешение печати, тем больше времени уходит па вывод и тем 
вероятнее переполнение памяти принтера при печати сложных изображений. 

В большинстве драйверов цветных принтеров окно свойств содержит элементы 
управляющие режимом коррекции цветов при печати. Настраивая режим вывода на печать, 
следует убедиться в том, что не включены одновременно система коррекции цвета в драйвере 
принтера (окно свойств) и система управления цветом CorelDRAW. Последняя включается и 
выключается с помощью флажка Use color profile (Использовать цветовой профиль) на вкладке 
Misc (Разное). Предпочтительнее использовать систему управления цветом CorelDRAW. 

 

11.7. Выбор части документа для печати 
Выбор части документа для вывода на печать выполняется с помощью группы элементов 

управления Print range (Диапазон печати), расположенных на вкладке General (Общие). 
Основой группы является следующая группа переключателей. 
• Current document (Текущий документ). Соответствует выводу на печать всех страниц 

текущего документа CorelDRAW. 
• Documents (Документы). При установке этого переключателя на месте остальных 

элементов группы появляется список всех открытых в сеансе работы с CorelDRAW документов 
с флажками, позволяющими для каждого документа определить, выводить его на печать или 
нет. Печатаются все страницы всех выбранных документов. 
• Current page (Текущая страница). Печатается только текущая страница текущего 

документа. 
• Pages (Страницы). При установке этого переключателя становится доступным поле 

указания диапазона страниц. Номера страниц, подлежащих выводу на печать, вводятся через 
запятую. Диапазоны смежных страниц задаются через дефис 
• Selection (Выделение). На печать выводятся только выделенные объекты. 

Непосредственно под полем для ввода номеров страниц располагается раскрывающийся 
список, позволяющий выбрать для вывода на печать из заданного диапазона только некоторую 
его часть: 
• Odd (Нечетные) — нечетные страницы диапазона; 
• Even (Четные) — четные страницы диапазона; 
• Even & Odd (Четные и нечетные) - все страницы диапазона. 

На той же вкладке имеются элементы управления, позволяющие задать количество 
копий при выводе на печать и вариант упорядочения копий страниц при выводе 
многостраничных документов. 

 

11.8. Размещение на листе бумаги 
Вкладка Layout (Макет) диалогового окна Print (Печать) позволяет управлять 

соотношением размеров изображения и листа бумаги, на котором выполняется печать. В случае 
если размеры изображения меньше размеров листа, можно выполнить масштабирование или 
переместить изображение в любое место листа. 

Внешний вид вкладки Layout (Макет) при печати четырехстраничного документа с 
размером страницы, не превышающим размера листа бумаги, заправленной в принтер, 
приведен на рис. 201. 
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Рисунок 201 – Внешний вид вкладки Layout 
 

Элементы управления группы Image position and size (Положение и размер изображения) 
позволяют управлять расположением страниц документа CorelDRAW на листах бумаги, 
используемых для печати. Основой группы являются три переключателя. По умолчанию 
установлен переключатель As in document (Как в документе). При этом изображение на 
отпечатке расположится на листе точно так же, как оно размешено на странице документа 
CorelDRAW. Если размер рисунка меньше размера листа бумаги, изображение будет выведено 
посередине листа. 

При установке переключателя Fit to page (Подогнать по листу) изображение при выводе 
на печать масштабируется таким образом, чтобы оно занимало нею высоту или всю ширину 
листа. 

Расположенные ниже переключателей пары счетчиков Position (Привязка), Size (Размер) 
и Scale factor (Коэффициент масштабирования) позволяют с большей точностью управлять 
расположением и масштабированием страницы документа CorelDRAW на листе бумаги. 
Кнопка с изображением замка включает режим пропорционального масштабирования по 
горизонтали и вертикали. Кнопка с треугольной стрелкой раскрывает список с номерами 
страниц многостраничного документа CorelDRAW, в котором можно выбрать номер страницы 
для уточнения ее положения и размеров на листе бумаги при печати. 

Если установить переключатель Reposition images to (Переместить изображение в), то с 
помощью расположенного справа раскрывающегося списка можно выбрать стандартную 
позицию для размещения изображения на листе - в середине, в любом из углов или в середине 
любой из сторон листа. 

Если размер изображения превышает габариты листа бумаги, а масштабирование с 
уменьшением изображения нежелательно, можно вывести его по частям (каждую часть - на 
отдельном листе бумаги), а затем склеить эти листы. 

В этом случае устанавливается флажок Print tiled pages (Печатать частями). Счетчик Tile 
overlap (Перекрытие частей) позволяет задать величину перекрытия частей в абсолютных 
единицах измерения, а связанный с ним счетчик, расположенный справа, задает ту же величину 
в процентах от ширины листа бумаги. 
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11.9. Предварительный просмотр 
Режим предварительного просмотра включается щелчком на кнопке Print Preview 

(Предварительный просмотр), расположенной в нижней части диалогового окна Print (Печать). 
При этом открывается рабочее пространство предварительного просмотра, состоящее, как и 
главное окно CorelDRAW, из набора инструментов, панели инструментов, панели атрибутов, 
ярлычков листов, строки состояния и окна документа (рис. 202). 

В окне документа отображаются печатные листы в том виде, в котором они выйдут из 
принтера. Если документ многостраничный или печатается по частям, то каждый из листов 
можно просмотреть отдельно, выбрав соответствующий ярлычок. Так же, как в основном 
рабочем пространстве, вы можете регулировать масштаб отображения документа с помощью 
раскрывающегося списка Zoom (Масштаб) па панели инструментов или с помощью 
инструмента Zoom (Масштаб). 

В окне предварительного просмотра продублированы все элементы управления 
параметрами печати, имеющиеся в диалоговой окне Print (Печать), но при необходимости это 
окно можно раскрыть, не выходя из режима предварительного просмотра Для этого нужно 
щелкнуть на кнопке Options (Режимы) стандартной панели инструментов в верхней части окна. 
Все изменения параметров, сделанные в этом окне, немедленно отобразятся в окне документа. 
 

 
 

Рисунок 202 – Окно Print Preview 
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Некоторые наиболее часто используемые параметры могут настраиваться с помощью 
специальных элементов управления. 
• Кнопка с изображением принтера в средней части строки состояния открывает список 

установленных в системе принтеров и позволяет настраивать параметры драйвера на вкладке 
Printer properties (Свойства принтера). Установки отображаются для текущего принтера, имя 
которого выводится рядом с кнопкой. Можно выбрать другой принтер в раскрывающемся 
списке. 
• Кнопка, расположенная в правой части строки состояния, включает и отключает режим 

печати по частям. 
Изменить размещение изображения на печатном листе можно также, выбрав 

соответствующий элемент в списке, расположенном на панели атрибутов при активном 
инструменте Pick (Выбор) 

В режиме предварительного просмотра можно произвольно масштабировать и 
перемещать изображение в пределах печатной страницы. Для этого изображение выделяется 
обычным способом с помощью инструмента Pick (Выбор), после чего его можно 
масштабировать и перемещать так же, как в основном режиме CorelDRAW. 

Отличие состоит только в том. что в режиме предварительного просмотра можно 
выделить иллюстрацию целиком, но не отдельные ее объекты. 

Настроив все параметры печати, щелкните на кнопке Print (Печать) панели 
инструментов, не выходя из режима предварительного просмотра. Документ будет напечатан с 
учетом всех настроек. Тот же результат можно получить, выйдя из режима предварительного 
просмотра щелчком на кнопке Close (Закрыть) панели инструментов и щелкнув на кнопке Print 
(Печать) в одноименном диалоговом окне. 

Если в режиме предварительного просмотра обнаруживается, что в иллюстрацию 
необходимо внести некоторые изменения, уже заданные параметры печати можно сохранить. 
Для этого следует выйти из режима предварительного просмотра, а затем в диалоговом окне 
Print (Печать) щелкнуть на кнопке Apply (Применить). Это позволит сохранить заданные 
параметры печати. После этого можно закрыть диалоговое окно печати щелчком на кнопке 
Cancel (Отменить) и перейти к редактированию иллюстрации. При повторном открытии 
диалогового окна Print (Печать) в течение того же сеанса работы все ранее сделанные 
настройки будут отражены в его элементах управления. По окончании сеанса они будут 
утрачены и в новом сеансе восстановлены со значениями управляющих параметров, принятыми 
по умолчанию. 

 

11.10. Контрольные вопросы 
1. Как происходит экспорт изображения в файл? 
2. Как происходит экспорт изображения в формат EPS? Для чего его используют (формат)? 
3. Для чего нужен формат PDF и как выполняют экспорт изображения в данный формат? 
4. Назовите основные элементы диалогового окна Convert to Bitmap (Преобразовать в 

пиксельное изображение). 
5. Какова последовательность действий вывода изображения на печать? 
6. Назовите основные элементы диалогового окна Print. 
7. Как происходит выбор части документа для печати? 
8. Для чего используют режим предварительного просмотра? 
9. Назовите основные элементы диалогового окна Print Preview. 
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